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ใครควรใช หน ังส ือเล มนี ้

1. น ักเร ียน น ิส ิต น ักศ ึกษา และบ ุคคลทั ่วไปที ่ม ีความสนใจในการน ําไมโครคอนโทรลเลอร ไปประย ุกต ใช ในการทดลอง
ทางว ิทยาศาสตร  หรื อสนใจในการเรี ยนรู และทดลองวิ ยาศาสตร ในแนวทางใหม ที่ ใช กิ จกรรมเป นสื่ อ โดยมี ไมโคร
คอนโทรลเลอร เป นส วนประกอบ

2. สถาบ ันการศ ึกษา โรงเร ียน ว ิทยาล ัย มหาว ิทยาล ัย ที ่ม ีการเป ดการเร ียนการสอนว ิชาอ ิเล ็กทรอน ิกส หร ือภาคว ิชา
ว ิศวกรรมอ ิเล ็กทรอน ิกส และคอมพ ิวเตอร 

3. คณาจารย ที ่ม ีความต องการศึ กษา และเตร ียมการเร ียนการสอนว ิชาไมโครคอนโทรลเลอร  รวมถึ งว ิทยาศาสตร 
ประยุ กต ที่ ต องการบู รณาการความรู ทางอิ เล็ กทรอนิ กส -ไมโครคอนโทรลเลอร -การเขี ยนโปรแกรมคอมพิ วเตอร -
การทดลองทางว ิทยาศาสตร  ในระด ับม ัธยมศ ึกษา อาช ีวศ ึกษา และปร ิญญาตร ี

รายละเอี ยดที่ ปรากฏในคู มื อเริ่ มต นใช งานกล องสมองกล IPST-MicroBOX (SE) กั บ Arduino IDE ผ านการ
ตรวจทานอย างละเอ ียดและถ วนถี ่ เพื ่อให ม ีความสมบ ูรณ และถ ูกต องมากที ่ส ุดภายใต เงื ่อนไขและเวลาที ่พ ึงม ีก อน
การจั ดพิ มพ เผยแพร  ความเสี ยหายอั นอาจเกิ ดจาก การนํ าข อมู ลในหนั งสื อเล มนี้ ไปใช  ทางบริ ษั ท อิ นโนเวตี ฟ
เอ ็กเพอร ิเมนต  จ ําก ัด ม ิได ม ีภาระในการร ับผ ิดชอบแต ประการใด ความผ ิดพลาดคลาดเคลื ่อนที ่อาจม ีและได ร ับ
การจ ัดพ ิมพ เผยแพร ออกไปนั ้น ทางบร ิษ ัทฯ จะพยายามชี ้แจงและแก ไขในการจ ัดพ ิมพ ครั ้งต อไป
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 IPST-MicroBOX (SE)

จากการเริ ่มต นพ ัฒนาช ุดกล องสมองกล IPST-MicroBOX โดยสาขาคอมพ ิวเตอร  สถาบ ันส งเสร ิมการสอน
ว ิทยาศาสตร และเทคโนโลย ีหร ือ สสวท. ที ่สามารถน ําไปบ ูรณาการก ับว ิชาอื ่นๆ ได  ได ร ับการตอบร ับและม ีการน ําไป
ใช ในการเร ียนการสอนด านว ิทยาศาสตร ประย ุกต  ด านการเข ียนและพ ัฒนาโปรแกรมภาษา C รวมถ ึงในว ิชาโครงงาน
เพื ่อให ผู เร ียนสามารถน ําองค ความรู นี ้ไปใช และต อยอดเพื ่อสร างโครงงานว ิทยาศาสตร สม ัยใหม 

IPST-MicroBOX เพื ่อเป นสื ่อทางเล ือกหนึ ่งส ําหร ับคร ูผู สอนในการจ ัดการเร ียนการสอนว ิชาการโปรแกรม ว ิชา
โครงงาน ในระด ับม ัธยมศ ึกษา ช ุดการเร ียนการสอนนี ้จะเน นการจ ัดก ิจกรรมการเร ียนรู แบบบ ูรณาการ น ักเร ียนได รู 
เกี ่ยวก ับอ ุปกรณ และอ ิเล ็กทรอน ิกส เบื ้องต น การเข ียนโปรแกรมเพื ่อควบค ุมไมโครคอนโทรลเลอร  การท ําโครงงานซึ ่ง
ต องบ ูรณาการก ับว ิชา ฟ ส ิกส  เคม ี ช ีวว ิทยา คณ ิตศาสตร  และคอมพ ิวเตอร เข าด วยก ัน ซึ ่งจะท ําให การเร ียนการสอน
ม ีความน าสนใจ และเป นอ ีกแนวทางหนึ ่งในการสอนเพื ่อให น ักเร ียนร ักการเข ียนโปรแกรม รู จ ักค ิดว ิเคราะห และแก 
ป ญหาทั ้งในว ิชาที ่เร ียนและในช ีว ิตประจ ําว ัน

จนกระทั ่งในป  พ.ศ. 2556 สสวท. ได ม ีการจ ัดตั ้งโครงการห องเร ียนว ิทยาศาสตร ในระด ับม ัธยมศ ึกษาตอน
ต นขึ ้น โดยม ีช ุดกล องสมองกล IPST-MicroBOX เป นสื ่อการเร ียนรู หนึ ่งที ่ควรม ีในห องเร ียนว ิทยาศาสตร  เนื ่องจาก
IPST-MicroBOX เด ิมออกแบบมาเพื ่อใช ในระด ับม ัธยมศ ึกษาตอนปลายเป นหล ัก ด ังนั ้นเมื ่อน ํามาใช ในห องเร ียนว ิทยา
ศาสตร ในระดั บมั ธยมศึ กษาตอนต น จึ งต องมี การปรั บปรุ งใหม  เพื่ อให เหมาะกั บนั กเรี ยนในระดั บนี้  กอปรกั บการ
เปลี่ ยนแปลงของเทคโนโลยี อุ ปกรณ อิ เล็ กทรอนิ กส  คอมพิ วเตอร สมั ยใหม ที่ มี ระบบปฏิ บั ติ การที่ หลากหลายทั้ ง
ว ินโดวส , ล ีน ุกซ  หร ือกระทั ่ง MAC OS พอร ตเชื ่อมต อของคอมพ ิวเตอร ที ่เน นไปย ังพอร ต USB ส งผลให การปร ับปร ุง
IPST-MicroBOX ครั้ งนี้  จึ งต องเลื อกฮาร ดแวร ที่ สามารถรองรั บกั บพอร ต USB เลื อกซอฟต แวร ที่ ใช ในการพั ฒนา
โปรแกรมที ่รองร ับก ับความหลากหลายของระบบปฏิ บ ัต ิการ และย ังต องม ีการพ ัฒนาช ุดค ําสั ่งต างๆ ที ่ท ําให น ักเร ียน
ในระด ับม ัธยมต นสามารถเร ียนรู และท ําความเข าใจได 

IPST-MicroBOX  Secondary Education หร ือ IPST-MicroBOX (SE) จึ งเก ิดขึ ้น โดยในช ุดจะม ีอุ ปกรณ ที ่
เพ ียงพอส ําหร ับการเร ียนรู ในเบื ้องต น ต อยอดไปท ําโครงงานอย างง ายและขั ้นกลางได  ทั ้งย ังม ีชิ ้นส วนในที ่น ําไปสร าง
เป นหุ นยนต อ ัตโนม ัต ิขนาดเล ็กได ด วย ภายใต งบประมาณรวมที ่ถ ูกลง ทางด านซอฟต แวร เล ือกใช  ซอฟต แวร  Wiring
IDE (www.wiring.org.co) อ ันเป นซอฟต แวร ส ําหร ับพ ัฒนาโปรแกรมด วยภาษา C/C++ ที ่ใช งานได ก ับระบบปฏิ บ ัต ิ
การวิ นโดวส , ลี นุ กซ  และ MAC OS ทั้ งยั งเป นซอฟต แวร แบบซอร สเป ด ใช งานได โดยไม มี ค าใช จ าย และไม จํ ากั ด
ระยะเวลาใช งาน รวมถ ึงม ีการปร ับปร ุงอย างต อเนื ่องเพื ่อให ได ซอฟต แวร ที ่ม ีประส ิทธ ิภาพส ูง

ชุ ดกล องสมองกล IPST-MicroBOX  Secondary Education หรื อ IPST-MicroBOX (SE) เป นสื่ อการเรี ยนรู ทาง
เลื อกสํ าหรั บครู , อาจารย  และนั กเรี ยนที่ มี ความประสงค ในการต อยอดหรื อประยุ กต ใช กล องสมองกลที่ มี ไมโคร
คอนโทรลเลอร เป นต ัวควบค ุมหล ักในการเร ียนรู และพ ัฒนาโครงงานด านว ิทยาศาสตร และเทคโนโลย ี

การจ ัดหาสื ่อการเร ียนรู นี ้เป นไปในร ูปแบบสม ัครใจ การบร ิการเกี ่ยวก ับการจ ัดหาและซ อมแซมอ ุปกรณ อยู ภายใต ความ
รั บผิ ดชอบของบริ ษั ท อิ นโนเวตี ฟ เอ็ กเพอริ เมนต  จํ ากั ด (www.inex.co.th หรื อ www.ipst-microbox.com)
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
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การใช งานชุ ดกล องสมองกล IPST-MicroBOX Secondary Education (SE) มี ขั้ นตอนโดยสรุ ป

ดั งแผนภาพในรู ปที่  1-1 ในบทนี้ จะอธิ บายถึ งขั้ นตอนต างๆ ในการเริ่ มต นใช งานชุ ดกล องสมองกล
IPST-MicroBOX (SE) เป นลํ าดั บไป

เตรียมการสรางโปรแกรมควบคุม
1. เปดซอฟตแวร Arduino IDE 1.7.10 สรางไฟลใหม
2. เลือกชนิดของแผงวงจร ที่เมนู Tools > Board > IPST-SE >
ATmega644P@16MHz
3. เลือกชองตอคอมพวิเตอร ที่เมนู Tools > Serial port > COMx
โดย x เปนเลขใดๆ ไดมาจากการตรวจสอบตําแหนงที่ Device
manager

เขียนโปรแกรมภาษา C/C++ แลวบันทึกไฟล

คอมไพล

ติดตั้งซอฟตแวร
- Arduino IDE 1.7.10 ซอฟตแวรเขียนโปรแกรมภาษา C/C++
- ไดรเวอร USB ของแผงวงจรหลัก IPST-SE
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -

ตรวจสอบชองเช่ือมตอคอมพิวเตอร
ของแผงวงจร IPST-SE

- เช่ือมตอแผงวงจรหลัก IPST-SE เขากับพอรต USB
- เลือกเปด Control panel > System > Hardware > Device
Manager > Ports ดูที่หัวขอ USB serial port (COMx)
- จําตําแหนงของ USB serial port (COMx) โดย x เปนตัวเลข
ใดๆ ปกติมคีามากกวา 3 เพือ่เลือกชองติดตอส่ือสารระหวาง
คอมพวิเตอรกับแผงวงจรหลัก IPST-SE

อัปโหลดโปรแกรม

โปรแกรมที่แผงวงจร IPST-SE เริ่มทํางาน

ร ูปที ่ 1-1 แผนภาพแสดงขั ้นตอนและกระบวนการเร ียนรู เพื ่อใช งานช ุดกล องสมองกล IPST-MicroBOX(SE)
เริ ่มจากด านซ าย ตั ้งแต การต ิดตั ้งโปรแกรม และการตรวจสอบการเชื ่อมต อ ระหว างแผงวงจรควบค ุม
กั บคอมพิ วเตอร  ไล มาทางขวา เริ่ มจากขั้ นตอนเตรี ยมการสร างโปรแกรมควบคุ ม, เขี ยนโปรแกรม,
คอมไพล หร ือการแปลโปรแกรมภาษา C เป นภาษาเครื ่อง, อ ัปโหลดหร ือส งโปรแกรมไปย ังแผงวงจรหล ัก  IPST-
SE จากนั ้นจ ึงท ําการร ันโปรแกรมเพื ่อตรวจสอบการท ํางาน
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1.1 ต ิดตั ้งโปรแกรมซอฟต แวร และไดรเวอร 

1.1.1 ระบบปฏิ บ ัติ การที ่รองรั บ
ซอฟต แวร ส ําหร ับพ ัฒนาโปรแกรมค ือ Arduino IDE 1.7.10 ท ํางานได ก ับระบบปฏ ิบ ัต ิการหร ือ

แพล ็ตฟอร ม (platform) ด ังนี ้

 Mac OS X 10.6 (ทั้ งรุ นที่ ใช ซี พี พี ยู เพาเวอร พี ซี และอิ นเทล)

 วิ นโดวส  7 ขึ้ นไป

1.1.2 ขั ้นตอนต ิดตั ้งซอฟต แวร และไดรเวอร  USB
(1.1.2.1) นํ าแผ นซี ดี รอมที่ มากั บชุ ดกล องสมองกล IPST-MicroBOX (SE) ใส เข าไปใน

ซ ีด ีรอมไดรฟของคอมพ ิวเตอร  ค นหาและด ับเบิ ้ลคล ิกที ่ไฟล  Arduino1.7.10_Setup160603.exe (หมายเลข
รุ นของซอฟต แวร เปลี่ ยนแปลงได ) จะปรากฎหน าต างต อนร ับสู การต ิดตั ้งให คล ิก Next

(1.1.2.2) คลิ กตอบรั บการติ ดตั้ งในแต ละขั้ นตอน จนกระทั่ งการติ ดตั้ งเสร็ จสิ้ น
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(1.1.2.3) จากนั้ นจะเข าสู การติ ดตั้ งไดรเวอร  USB ตั วที่  1 ให คลิ กปุ ม Next เพื่ อตอบรั บ เมื่ อ
การติ ดตั้ งเสร็ จสิ้ น คลิ กปุ ม Finish เพื่ อเข าสู ขั้ นตอนถั ดไป

    

(1.1.2.4) ต อไปเป นการติ ดตั ้งไดรเวอร  USB ตั วที่ สอง ซึ ่งเป นไดรเวอร ส ําหร ับแผงวงจร IPST-
SE  คลิ กปุ ม Install เพื่ อทํ าการติ ดตั้ งไดรเวอร  และคลิ ก Finish เมื่ อการติ ดตั้ งเสร็ จสมบู รณ 
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(1.1.2.5) เมื่ อติ ดตั้ งโปรแกรมเสร็ จ จะมี การเรี ยกซอฟต แวร  Arduino IDE ให ทํ างานทั นที  มี 
หน าต างเลื อกฮาร ดแวร ที่ ต องการใช งานปรากฏขึ้ นมา ในที่ นี้ ให เลื อก IPST-SE จากนั้ นจะปรากฏ
หน าต างให ยื นยั น คลิ กปุ ม OK เพื่ อตอบรั บ

(1.1.2.6) รอส ักครู ซอฟต แวร  Arduino IDE เวอร ช ัน 1.7.10 จะท ํางาน แสดงหน าต างหล ักพร อม
กั บโค ดเริ่ มต นของโปรแกรม ซึ่ งก็ คื อ คํ าสั่ ง #include <ipst.h> เพื่ อเรี ยกใช งานไลบรารี  ipst.h
ตามด วยส วนประกอบหลั กของโปรแกรมคื อ ฟ งก ชั่ น setup() และ loop()
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(1.1.2.7) เมื่ อได ตามนี้  แสดงว า การติ ดตั้ งซอฟต แวร  Arduino IDE และไดรเวอร ต างๆ เสร็ จ
สมบู รณ  พร อมสํ าหรั บการพั ฒนาโปรแกรมต อไป หากต องการเรี ยกให  Arduino IDE 1.7.10 ทํ างาน
ในครั้ งต อไป ให คลิ กที่  Start > All Programs > Arduino 1.7.x > Arduino 1.7.10

จากนี้ ซอฟต แวร  Arduino IDE (เวอร ชั นสํ าหรั บกล องสมองกล  IPST- MicroBOX(SE) พร อม
สํ าหรั บการพั ฒนาโปรแกรมแล ว

1.2 แผงวงจรหลั ก IPST-SE ของชุ ดกล องสมอง IPST-MicroBOX (SE)
อ ุปกรณ หล ักที ่ใช ในการเร ียนรู กล องสมองกลค ือ ช ุดกล องสมองกล IPST-MicroBOX (SE) ที ่ม ี

แผงวงจรหลั กชื่ อ IPST-SE มี หน าตาแสดงดั งรู ปที่  1-2 พร อมคํ าอธิ บายของส วนประกอบต างๆ แผง
วงจร IPST-SE เป นแผงวงจรขนาดเล็ กที่ มี ไมโครคอนโทรลเลอร เบอร  ATmega644P เป นหั วใจหลั ก
ในการควบค ุมการท ํางาน โดยต ัวควบค ุมหล ักหร ือไมโครคอนโทรลเลอร จะได ร ับการโปรแกรมผ าน
ทางพอร ต USB ด วยซอฟต แวร  Arduino IDE 1.7.10

27A3 30A6

29A526A2

28A425A1

2
4

A
0

USB

D

9SDA 8SCL

1
2

1
3

1
4

1
5

S
V
0

S
V
1

S
V
2

S
V
3

12
6V
G

13
6V
G

14
6V
G

15
6V
G

21

D
C
 M

O
T
O

R

3 TxD1

LOW+5

2 RxD1

UART1

SERVO

000000000000000000000

000000000000000000000

000000000000000000000

000000000000000000000

000000000000000000000

000000000000000000000

000000000000000000000

000000000000000000000

000000000000000000000

000000000000000000000

000000000000000000000

000000000000000000000

000000000000000000000

000000000000000000000

000000000000000000000

000000000000000000000

RESET2019

18

17

16

KNOB

OK

SW1







ON



































































ร ูปที ่ 1-2 แสดงส วนประกอบและหน าที ่ของแผงวงจร IPST-SE ในช ุดกล องสมองกล IPST-MicroBOX (SE)
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บนแผงวงจรควบคุ มนี้ มี จุ ดต อเพื่ อรั บสั ญญาณจากตั วตรวจจั บภายนอกทั้ งแบบอะนาลอก
และดิ จิ ตอลเพื่ อช วยให แผงวงจรสามารถรั บข อมู ลจากส ่ิ งแวดล อม เช น แสง, อุ ณหภู มิ , ระยะห างจาก
วั ตถุ ของตั วตรวจจั บ เป นต น  นอกจากนั้ นยั งมี จุ ดต อเพ่ื อส งสั ญญาณออกไปควบคุ มอุ ปกรณ ภายนอก
อาทิ  ไดโอดเปล งแสง ลํ าโพง มอเตอร ไฟตรง และเซอร โวมอเตอร 

ด านการแสดงผล แผงวงจร IPST-SE มี จอแสดงผลแบบกราฟ ก LCD สี ขนาด 1.8 นิ้ วในตั ว
มี ความละเอี ยด 128 x 160 จุ ด แสดงตั วอั กษรได สู งสุ ด 21 ตั วอั กษร 16 บรรทั ด แสดงภาพกราฟ กสี 
ได  (ไม รองรั บภาพถ ายที่ มี ความละเอี ยดสู ง) และเลื อกทิ ศทางในการแสดงผลได 

1.3 ทดสอบการอ ัปโหลดโปรแกรม
ส ําหร ับการเข ียนโปรแกรมลงไปบนแผงวงจร IPST-SE ครั ้งแรก จะเร ียกว า การอ ัปโหลด (upload)

ปกติ แล วจะใช คํ าว า “ดาวน โหลด” แต สํ าหรั บการทํ างานกั บซอฟต แวร  Arduino IDE1.7.10 จะ
เร ียกกระบวนการนี ้ว า อ ัปโหลด

ขั ้นตอนการอ ัปโหลดโปรแกรมครั ้งแรก ม ี 2 ขั ้นตอนหล ักๆ ค ือ การตรวจสอบต ําแหน งของพอร 
ตที ่ใช ในการต ิดต อระหว างแผงวงจรหล ัก IPST-SE ก ับซอฟต แวร  Arduino IDE1.7.10 บนคอมพ ิวเตอร 
และขั ้นตอนการตั ้งค าเพื ่อใช ในการอ ัปโหลดโปรแกรม
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ร ูปที ่ 1-3 การเชื ่อมต อแผงวงจร IPST-SE ก ับคอมพ ิวเตอร เพื ่อเตร ียมใช งานก ับซอฟต แวร  Arduino IDE
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1.3.1 การตรวจสอบตํ าแหน งของพอร ตอนุ กรมเสมื อน หรื อ USB Serial port
ส ําหร ับแผงวงจร IPST-SE

(1) เส ียบสาย USB เชื ่อมต อระหว างแผงวงจร IPST-SE ก ับพอร ต USB ของคอมพ ิวเตอร  เป ดสว ิตช 
เพื ่อจ ายไฟ รอจนกระทั ่งไฟส ีนํ ้าเง ินที ่ต ําแหน ง USB บนแผงวงจรควบค ุมต ิดสว าง ด ังร ูปที ่ 1-3

(2) คลิ กที่ ปุ ม Start แล วเลื อกไปที่  Control Panel

(3) จากนั้ นดั บเบิ ลคลิ กเลื อกที่  System

(4) เลื อกไปที่ แท็ ป Hardware แล วคลิ กที่  Device Manager

(5) ตรวจสอบรายการฮาร ดแวร ที ่ห ัวข อ Port จะพบ USB Serial port ให ด ูว าม ีการเล ือกต ําแหน ง
ของพอร ตอน ุกรม USB Serial port ไว ที ่ต ําแหน งใด ปกต ิจะเป น COM3 ขึ ้นไป ให ใช ค าของต ําแหน ง
ของพอร ตอน ุกรมนี ้ในการก ําหนดการเชื ่อมต อก ับโปรแกรมต อไป ตามร ูปต ัวอย างจะเป น COM3
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1.3.2  เชื่ อมต อแผงวงจรหลั ก IPST-SE  กั บซอฟต แวร  Arduino IDE
หลั งจากทราบถึ งตํ าแหน งของพอร ตที่ เชื่ อมต อกั บคอมพิ วเตอร แล ว ในลํ าดั บต อไปเป นการ

เชื่ อมต อเข ากั บซอฟต แวร  Arduino IDE 1.7.10

(1.3.2.1) เป ดโปรแกรม Arduino IDE รอส ักครู หนึ ่ง หน าต างหล ักของโปรแกรมจะปรากฏขึ ้น
การเป ดใช งาน Arduino IDE ในครั ้งแรกอาจใช เวลาพอสมควร (ขึ ้นอยู ก ับคอมพ ิวเตอร แต ละเครื ่อง)

(1.3.2.2) เล ือกฮาร ดแวร ที ่ใช  โดยเล ือกเมน ู Tools > Board >  IPST-SE > ATmega644P @16MHz

(1.3.2.3) เลื อกพอร ตติ ดต อ โดยไปที่ เมนู  Tools > Serial Port เลื อกตํ าแหน งของพอร ตอนุ 
กรมที่ ใช ในการเชื่ อมต อกั บแผงวงจร IPST-SE ในที่ นี้ คื อ COM3

ขั้ นตอนนี้ ควรทํ าทุ กครั้ งที่ เชื่ อมต อแผงวงจร IPST-SE กั บพอร ต USB ของคอมพิ วเตอร ใหม 

เพี ยงเท านี้ แผงวงจร IPST-SE พร อมสํ าหรั บการติ ดต อกั บซอฟต แวร  Arduino IDE 1.7.10 แล ว
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1.3.3 ขั ้นตอนการพ ัฒนาโปรแกรม
(1.3.31) สร างไฟล ใหม ด วยการคล ิกที ่ปุ ม New บนแถบเครื ่องม ือหร ือเล ือกจากเมน ู File > New

(1.3.3.2) พิ มพ โค ดโปรแกรมต อไปนี้ 

#include <ipst.h> // ผนวกไฟล ไลบรารี หลั ก ipst.h
void setup()
{

glcdClear(); // ล างการแสดงผล
glcdMode(0); // เลื อกทิ ศทางการแสดงผลโหมด 0

}
void loop()
{

setTextSize(2); // เลื อกขนาดตั วอั กษร 2 เท า
setTextColor(GLCD_YELLOW); // เลื อกสี ของตั วอั กษรเป นสี เหลื อง
glcd(1,1,"Hello"); // กํ าหนดข อความที่ บรรทั ด 1 คอลั มน  1
setTextColor(GLCD_SKY); // เลื อกสี ของตั วอั กษรเป นสี ฟ า
glcd(3,1,"IPST"); // กํ าหนดข อความที่ บรรทั ด 3 คอลั มน  1
glcd(4,1,"MicroBOX"); // กํ าหนดข อความที่ บรรทั ด 4 คอลั มน  1
setTextSize(1); // เล ือกขนาดตั วอั กษรปกติ 
glcd(10,2,"Secondary Education"); // กํ าหนดข อความที่ บรรทั ด 10 คอลั มน  2

}

โปรแกรมนี ้ใช ทดสอบการท ํางานเบื ้องต นของแผงวงจร IPST-SE โดยก ําหนดให แสดงข อความที ่จอแสดงผล
ด วยขนาดและสี ของต ัวอั กษรที ่ต างก ัน

(1.3.3.3) ไปที่ เมนู  File เลื อกคํ าสั่ ง Save As เพื่ อบั นทึ กไฟล ในชื่ อ  microbox_Hello ตอนนี้ 
จะมี ไฟล  microbox_Hello.ino เกิ ดขึ้ นในโฟลเดอร ชื่ อว า microbox_Hello
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(1.3.3.4) ตรวจสอบการเข ียนโปรแกรมด วยการคล ิกที ่ปุ ม Run  ที ่แถบเครื ่องม ือ หร ือเล ือกค ําสั ่ง
จากเมน ู Sketch > Verify/Compile

หากมี ความผิ ดพลาดเกิ ดขึ้ นจากการคอมไพล  จะปรากฏข อความแจ งความผิ ดพลาดใน
ช องแสดงสถานะและพื้ นที่ แสดงข อความ ต องทํ าการแก ไขโปรแกรม

 หากการคอมไพล ถู กต อง ที่ ช องแสดงสถานะจะแจ งแสดงข อความ Done compiling

(1.3.3.5) ต อสาย USB เข ากั บแผงวงจร IPST-SE จากนั้ นเป ดสวิ ตช จ ายไฟเลี้ ยง แล วรอให การ
เชื่ อมต อกั บคอมพิ วเตอร เสร็ จสมบู รณ  (ดู จากไฟแสดงผลสี นํ้ าเงิ นที่ ตํ าแหน ง USB ติ ดสว าง)

(1.3.3.6) ตรวจสอบต ําแหน งพอร ต แล วเล ือกฮาร ดแวร และต ําแหน งพอร ตที ่ท ําการเชื ่อมต อให 
ถู กต องตามขั้ นตอนในหั วข อ 1.3.2
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(1.3.3.7) คลิ กที่ ปุ ม  Upload to Wiring Hardware  บนแถบเครื่ องมื อ ถ าทุ กอย างเป น

ปกติ  เมื่ อทํ าการอ ัปโหลดเสร็ จ จะมี ข อความแจ งที่ ช องแสดงสถานะว า Done uploading.  และที่ พื ้นที่ 
แสดงข อความจะแจ งกระบวนการและผลคอมไพล  รวมถึ งขนาดของไฟล ผลลั พธ ที่ เกิ ดขึ้ น

ถ ามี ข อผิ ดพลาดเกิ ดขึ้ นจะมี ข อความแจ งเตื อนในพื้ นที่ แสดงข อความด านล าง ของหน า
ต างโปรแกรมหลั ก

ซึ่ งส วนใหญ แล วมั กเกิ ดจากการเลื อกพอร ตอนุ กรมไม ถู กต อง หรื อไม ได ต อแผงวงจรไว 
หรื อไม ได เป ดสวิ ตช จ ายไฟให แก แผงวงจร IPST-SE

(1.3.3.8)  หล ังจากอ ัปโหลดโปรแกรมแล ว แผงวงจรหล ัก IPST-SE จะท ํางานท ันท ี ได ผลการ
ท ํางานตามร ูป
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1.4 การแก ป ญหาในกรณ ีที ่อ ัปโหลดโปรแกรมไม ได 

สาเหตุ  :

ซอฟต แวร  Arduino IDE ไม สามารถติ ดต อกั บแผงวงจรหลั ก IPST-SE ได 

ทางแก ไข :

(1) ตรวจสอบการต อสาย miniB-USB

(2) ตรวจสอบการเลื อกพอร ตหรื อช องเชื่ อมต อว า ถู กต องหรื อไม 

(3) เก ิดความผ ิดปกต ิขึ ้นในระบบคอมพ ิวเตอร  จ ึงต องหย ุดการท ํางานในส วนของการอ ัปโหลด
โปรแกรม โดยกดค ีย  Ctrl, Alt และ Delete พร อมก ัน หน าต าง Window Security ปรากฏขึ ้น แล วคล ิก
เล ือก Task Manager หร ือในคอมพ ิวเตอร บางเครื ่องอาจเข าสู หน าต าง Window Task mangaer ท ันท ี
ให เล ือกแท ็ป  Processes แล วหาชื ่อไฟล  avrdude.exe คล ิกเล ือกที ่ไฟล นั ้น แล วคล ิกที ่ปุ ม End Process

จากนั้ นซอฟต แวร  Arduino IDE จะกลั บมาทํ างานในสถานะปกติ ได  ทํ าการจ ายไฟให กั บ
บอร ดอี กครั้ ง เลื อกพอร ตเชื่ อมต อให ถู กต อง แล วทํ าการอั ปโหลดโปรแกรมอี กครั้ ง
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1.5 การเป ดไฟล ตั วอย าง

เพื่ ออํ านวยความสะดวกและลดการผิ ดพลาดในการพั ฒนาโปรแกรมสํ าหรั บผู เริ่ มต นใช งาน
Arduino IDE จึ งได เตรี ยมไฟล ตั วอย างไว พอสมควร

การเป ดไฟล ตั วอย างทํ าได ง ายมาก โดยไปที่ เมนู  Help > Example > IPST-SE จะเห็ นชื่ อไฟล 
ให เลื อกเป ดใช งานตามต องการ

หร ือเล ือกเป ดผ านทางค ําสั ่ง Open ซึ ่งจะปรากฏหน าต าง Explorer ขึ ้นมาเพื ่อให ค นหาไฟล  ให 
เลื อกไปที่  C:/Wiring/Examples/IPST-SE จะพบโฟลเดอร ที่ ใช เก็ บไฟล สเก็ ตช จํ านวนมาก

เมื่ อเลื อกเป ดโฟลเดอร ที่ ต องการ จะพบไฟล  .ino ซึ่ งก็ คื อไฟล ที่ ใช งานกั บ Arduino IDE
จากนั้ นจะแก ไข, คอมไฟล  รวมทั้ งอั ปโหลดโปรแกรมก็ ทํ าได ตามต องการ

1.6 ข อกํ าหนดในการแก ไขและบ ันท ึกไฟล 

ในกรณ ีที ่ต องการแก ไขไฟล ต ัวอย างเด ิม ต องเป ดไฟล นั ้นๆ ขึ ้นมา ท ําการแก ไขโค ดโปรแกรม
ตรวจสอบไวยกรณ ด วยการคอมไพล  เมื่ อเรี ยบร อยแล ว มี ทางเลื อกในการบั นทึ กไฟล  2 ทางคื อ

1. บั นทึ กในชื่ อเดิ ม ให ใช คํ าสั่ ง Save

2. บั นทึ กในชื่ อใหม ด วยคํ าสั่ ง Save As แต ไม ควรบั นทึ กทั บไฟล เดิ มที่ ไม ได ถู กเป ดขึ้ นมา
เพราะจะทํ าให การเชื่ อมโยงไฟล สั บสน และทํ าให เกิ ดความผิ ดพลาดในการเป ดใช งานครั้ งต อไปได 
ถ าหากม ีความต องการบ ันท ึกท ับไฟล เด ิมที ่ไม ได ถ ูกเป ดขึ ้นมา จะต องท ําการลบโฟลเดอร ของไฟล เด ิม
นั ้นออกไปเส ียก อน
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IPST-MicroBOX (SE) เป นช ุดแผงวงจรอเนกประสงค ที ่ใช อ ุปกรณ ควบค ุมแบบโปรแกรมได 
ขนาดเล ็กที ่เร ียกว า “ไมโครคอนโทรลเลอร ” (microcontroller) ท ํางานร วมก ับวงจรเชื ่อมต อคอมพ ิวเตอร 
เพื ่อการโปรแกรมและสื ่อสารข อม ูล โดยในช ุดประกอบด วย แผงวงจรควบค ุมหล ัก IPST-SE ซึ ่งม ีไมโคร
คอนโทรลเลอร เป นอ ุปกรณ หล ัก, กลุ มของแผงวงจรอ ุปกรณ แสดงผลการท ํางานหร ืออ ุปกรณ เอาต พ ุต อาท ิ
แผงวงจรแสดงผลด วยไดโอดเปล งแสง 8 ดวง และแผงวงจรแสดงผลด วยไดโอดเปล งแสงแบบต ัวเดี ่ยว
รวมถ ึงแผงวงจรอ ุปกรณ ตรวจจ ับส ัญญาณหร ือเซนเซอร  (sensor)ซึ ่งม ีด วยก ันหลากหลายร ูปแบบ จ ึงท ําให 
ผู ใช งานสามารถน ําช ุดกล องสมองกล IPST-MicroBOX(SE) นี ้มาใช ในการเร ียนรู , ทดลองและพ ัฒนา
โครงงานทางว ิทยาศาสตร ที ่เกี ่ยวข องก ับระบบควบค ุมอ ัตโนม ัต ิได อย างสะดวกและม ีประส ิทธ ิภาพส ูง

IPST-MicroBOX (SE) เริ่ มต นมี ด วยกั น 2 รุ นคื อ รุ นมาตรฐาน 1 และ 2 ต อมาได มี การพั ฒนา
โดยบรรจ ุอ ุปกรณ ต ัวตรวจจ ับและอ ุปกรณ แสดงการทํ างานหร ืออุ ปกรณ เอาต พ ุตเพิ ่มเต ิม กลายมาเป น
รุ นมาตรฐาน 3 ดั งมี รายละเอี ยดขั้ นต นต อไปนี้ 

1. รุ นมาตรฐาน 1  ในชุ ดนี้ ประกอบด วย แผงวงจรควบคุ มหลั ก IPST-SE เป นอุ ปกรณ หลั กที่ มี 
โมดู ลแสดงผลกราฟ ก LCD สี ในตั ว, แผงวงจร LED, แผงวงจรลํ าโพง, แผงวงจรตรวจจั บสั ญญาณ
หรื อเซนเซอร  (sensor) พื้ นฐาน,  และเครื่ องจ ายไฟ ทํ าให นํ าชุ ด IPST-MicroBOX (SE) นี้ ไปใช ในการ
เร ียนรู และเข ียนโปรแกรมเพื ่อพ ัฒนาเป นโครงงานทางว ิทยาศาสตร ที ่ม ีการควบค ุมด วยระบบอ ัตโนม ัต ิ
โดยใช โปรแกรมภาษา C/C++ ในเบื้ องต นได ภายใต งบประมาณที่ เหมาะสม

2. รุ นมาตรฐาน 2 ในชุ ดประกอบด วยอุ ปกรณ หลั กเหมื อนกั บชุ ด IPST-MicroBOX (SE) รุ น
มาตรฐาน 1 มี การเพิ่ มตั วตรวจจั บแสงสะท อนอิ นฟราเรดอี ก 2 ตั ว, มอเตอร ไฟตรงพร อมชุ ดเฟ องขั บ
และชิ้ นส วนทางกลที่ จํ าเป น เพื่ อให ต อยอดการเรี ยนการสอนและการใช งาน IPST-MicroBOX (SE)
นี้ ไปสร างเป นหุ นยนต อั ตโนมั ติ แบบโปรแกรมได  ทั้ งยั งรองรั บกิ จกรรมการแข งขั นได เป นอย างดี 






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3. รุ นมาตรฐาน 3 ประกอบด วย อ ุปกรณ หล ักเหม ือนก ับช ุด IPST-MicroBOX (SE) รุ นมาตรฐาน
2 ม ีการเพิ ่มต ัวตรวจจ ับอ ีกหลายรายการ อาท ิ ต ัวตรวจจ ับและว ัดระยะทาง, ต ัวตรวจจ ับแสงอ ินฟราเรด,
ต ัวตรวจจ ับส ัญญาณร ีโมตคอนโทรล และแผงวงจรตรวจจ ับเส ียง นอกจากนั ้น ย ังเพิ ่มแผงวงจรแสดงการ
ท ํางานและข ับโหลดกระแสไฟฟ าส ูง อาท ิ แผงวงจรแสดงผลต ัวเลข 7 ส วน 4 หล ัก, แผงวงจรข ับแสงอ ิน
ฟราเรด และแผงวงจรข ับร ีเลย  4 ช อง จ ึงท ําให ผู ใช งานต อยอดการน ําช ุดกล องสมองกล IPST-MicroBOX
SE นี้ ไปทํ าโครงงานวิ ทยาศาสตร ประยุ กต ได หลากหลายเพิ่ มมากขึ้ น สอดคล องกั บแนวคิ ดการเรี ยน
การสอนสมั ยใหม ที่ อ างอิ งกั บ STEM ศึ กษาได เป นอย างดี และมี ประสิ ทธิ ภาพ

3.1 รายการอุ ปกรณ ของชุ ดกล องสมองกล IPST-MicroBOX (SE)

รุ นมาตรฐาน 1 ประกอบด วย

1. แผงวงจรควบคุ มหลั ก IPST-SE 2. แผงวงจร LED เดี ่ยวพร อมสายส ัญญาณ 3 ช ุด

3. แผงวงจร LED 8 ดวงพร อมสายสั ญญาณ 4. แผงวงจรลํ าโพงเป ยโซพร อมสายสั ญญาณ

5. แผงวงจรสวิ ตช พร อมสายสั ญญาณ  2 ชุ ด 6. แผงวงจรตรวจจั บแสงพร อมสายสั ญญาณ

7. แผงวงจรตั วต านทานปรั บค าได พร อมสายสั ญญาณ 2 ชุ ด

8. ไอซี วั ดอ ุณหภู ม ิพร อมสายต อ 9. อะแดปเตอร ไฟตรง +9V 1A

10. สายเชื่ อมต อ USB-miniB 11. ซี ดี รอม

12. คู มื อการทดลอง 13. กล องบรรจุ 

14. ไขควง
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รุ นมาตรฐาน 2 ประกอบด วย รายการที ่ 1 ถ ึง 13 ของรุ นมาตรฐาน 1 และอ ุปกรณ เพิ ่มเต ิมด ังนี ้

14. แผงวงจรตรวจจั บแสงสะท อนอิ นฟราเรดพร อมสายสั ญญาณ 2 ชุ ด

15. มอเตอร ไฟตรงพร อมชุ ดเฟ องขั บรุ น BO2 อั ตราทด 48:1 พร อมสายเชื่ อมต อ 2 ตั ว

16. ล อพลาสติ กกลมสํ าหรั บชุ ดเฟ องขั บมอเตอร และยาง จํ านวน 2 ชุ ด

17. แผ นกริ ดขนาด 80 x 60 เซนติ เมตรและ 80 x 80 เซนติ เมตร จํ านวน 2 ชุ ด

18. แผ นฐานกลมพร อมล ออิ สระ 1 แผ น

19. แผ นฐานกลมสํ าหรั บทํ าโครงหุ นยนต  1 แผ น

20. ชิ้ นต อ/แท งต อพลาสติ กและเสารองพลาสติ ก

21. ชุ ดเสารองโลหะ, นอตและสกรู 

22. กะบะถ าน AA 6 ก อน พร อมสายและห ัวต อป องก ันการกล ับขั ้วส ําหร ับต อก ับแผงวงจรหล ัก

23. แผ นทดสอบการเคลื่ อนที่ ตามเส นของหุ นยนต 
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รุ นมาตรฐาน 3 ประกอบด วย รายการที ่ 1 ถ ึง 23 ของรุ นมาตรฐาน 1 และ 2 มี อ ุปกรณ เพิ ่มเต ิม

ด ังนี ้

24. แผงวงจร LED ตั วเลข 7 ส วน 4 หลั กพร อมสายสั ญญาณ

25. แผงวงจร LED อิ นฟราเรดพร อมสายสั ญญาณ 2 ชุ ด

26. แผงวงจรขั บรี เลย  4 ช องพร อมสายสั ญญาณ 4 เส น

27. แผงวงจรโฟโต ทรานซิ สเตอร สํ าหรั บตรวจจั บแสงอิ นฟราเรดพร อมสายสั ญญาณ 2 ชุ ด

28. แผงวงจรตรวจจั บเสี ยงพร อมสายสั ญญาณ

29. แผงวงจรโมดู ลรั บแสงอิ นฟราเรด 38kHz พร อมสายสั ญญาณ

30. โมดู ลตรวจจั บและวั ดระยะทางด วยแสงอิ นฟราเรดพร อมสายสั ญญาณ

31. รี โมตคอนโทรลอิ นฟราเรดที่ ใช รหั สข อมู ลในรู ปแบบของโซนี่ 

32. อะแดปเตอร ไฟตรง +12V 1A สํ าหรั บแผงวงจรขั บรี เลย 
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ร ูปที ่ 2-1 แผงวงจรหล ัก IPST-SE ม ีจอแสดงผล
กราฟ กสี ความละเอี ยด 128 x 160 จุ ด
แสดงต ัวอ ักษรขนาดมาตรฐานได มากถ ึง 21
ต ัวอ ักษร 16 บรรท ัด อ ัปโหลดโปรแกรมผ าน
พอร ต USB

2.2 คุ ณสมบั ติ ของแผงวงจรหลั ก IPST-SE

มี หน าตาของแผงวงจรแสดงในรู ปที่  2-1 ส วนรู ปที่  2-2 แสดงรายละเอี ยดที่ สํ าคั ญของแผงวงจร
IPST-SE ที่ ควรทราบเพื่ อใช ประโยชน ในการอ างถึ งเมื่ อทํ าการทดลอง ส วนคุ ณสมบั ติ โดยสรุ ปของ
IPST-SE เป นดั งนี้ 

 ใช ไมโครคอนโทรลเลอร  8 บิ ตเบอร  ATmega644P ของ Atmel รองรั บโปรแกรมควบ
คุ มที่ พั ฒนาจากภาษาแอสเซมบลี , เบสิ ก และ C โดยในที่ นี้ จะเน นไปที่ โปรแกรมภาษา C/C++ โดย
ภายในมี โมดู ลแปลงสั ญญาณอะนาลอกเป นดิ จิ ตอล ความละเอี ยด 10 บิ ต ให ค าของข อมู ลในช วง 0
ถึ ง 1,023 จึ งนํ ามาต อกั บแผงวงจรตรวจจั บที่ ให ผลการทํ างานเป นแรงดั นไฟฟ าได ง าย  มี หน วยความ
จํ าโปรแกรมแบบแฟลชมากถึ ง 64 กิ โลไบต  โปรแกรมใหม ได  10,000 ครั้ ง มี หน วยความจํ าข อมู ลอี 
อี พรอม 512 ไบต  และหน วยความจํ าข อมู ลแรม 1 กิ โลไบต 

 สั ญญาณนาฬิ กาหลั ก 16MHz จากคริ สตอล

 มี จุ ดต อพอร ต USB  สํ าหรั บดาวน โหลดโปรแกรมและสื่ อสารข อมู ลกั บคอมพิ วเตอร 

 มี สวิ ตช  RESET การทํ างาน

 มี จุ ดต อพอร ตแบบ 3 ขา (ขาไฟเลี้ ยง, สั ญญาณ และกราวด ) จํ านวน 20 จุ ด แบ งเป นขา
พอร ตดิ จิ ตอล 13 จุ ด (ขาพอร ตหมายเลข 2, 3, 8, 9, 12 ถึ ง 20) และขาพอร ตแบบดิ จิ ตอลหรื ออะนา
ลอก (กํ าหนดได ) 7 จุ ด (หากใช เป นขาอิ นพุ ตอะนาลอกเป นขา A0 ถึ ง A6 และถ าใช เป นขาพอร 
ตดิ จิ ตอลเป นขาพอร ตหมายเลข 24 ถึ ง 30)
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ร ูปที ่ 2-2 แสดงส วนประกอบที ่ควรทราบของแผงวงจรหล ัก IPST-SE
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 ม ีจ ุดต อระบบบั ส 2 สาย (I2C) เพื ่อขยายระบบ

 ม ีจ ุดต อสํ าหรั บสื่ อสารข อมู ลอนุ กรมหรื อ UART (Universal Asynchronous Receiver
Transmitter) เพื ่อขยายระบบ

 ใช ไฟเลี ้ยงในย าน +6.5 ถ ึง +12V กระแสไฟฟ า 1,500mA กรณ ีต อใช งานมอเตอร ไฟตรง
และเซอร โวมอเตอร ร วมด วย หร ือ 500mA กรณ ีไม ใช งานมอเตอร  บนแผงวงจรหล ัก IPST-SE ม ีวงจร
ควบค ุมแรงด ันคงที ่ +5V จ ึงน ําไปจ ายให ก ับแผงวงจรต อพ วงอื ่นๆ รวมทั ้งแผงวงจรต ัวตรวจจ ับด วย

 มี จุ ดต อไฟเลี้ ยง (DC INPUT) ผ านทางจุ ดต อแบบหั วเสี ยบป องกั นการต อกลั บขั้ วและ
แจ กอะแดปเตอร  ร ับไฟเลี ้ยงได ตั ้งแต  7.2V ถ ึง +12V โดยม ีสว ิตช เป ด-ป ดเพื ่อต ัดต อไฟเลี ้ยงแก แผงวงจร
พร อมไฟแสดงสถานะไฟเลี ้ยง +5V และม ีวงจรแจ งสถานะแบตเตอร่ี อ อน (LOW) ด วย LED สี เหลื อง
ในกรณี ที่ ใช แหล งจ ายไฟเป นแบตเตอร่ี  โดยกํ าหนดระดั บแรงดั นไว ที่  +7V

 มี วงจรควบคุ มไฟเลี้ ยงคงที่  +5V 2A แบบสวิ ตชิ่ งสํ าหรั บรั กษาระดั บไฟเลี้ ยงให แก 
ไมโครคอนโทรลเลอร 

 มี วงจรขั บมอเตอร ไฟตรง 2 ช อง พร อมไฟแสดงผล

 ม ีจ ุดต อขาพอร ตของไมโครคอนโทรลเลอร สํ าหร ับข ับเซอร โวมอเตอร  4 ช องค ือ จ ุดต อ
15, 14, 13 และ 12 (เรี ยงตามลํ าดั บ SERVO0, SERVO1, SERVO2 และ SERVO3)

 มี โมดู ลแสดงผลแบบกราฟ กสี  ความละเอี ยด 128 x 160 จุ ด แสดงภาพกราฟ กลายเส น
และพื้ นสี  (ไม รองรั บไฟล รู ปภาพใดๆ) พร อมไฟส องหลั ง แสดงผลเป นตั วอั กษรขนาดปกติ  (5x7 จุ ด)
ได  21 ตั วอั กษร 16 บรรทั ด (21 x 16)

 มี สวิ ตช กดติ ดปล อยดั บใช งานอิ สระ 1 ตั ว คื อ SW1 ซึ่ งต อกั บขาพอร ตหมายเลข 22

 มี สวิ ตช กดติ ดปล อยดั บชื่ อ สวิ ตช  OK ซึ่ งต อร วมกั บตั วต านทานปรั บค าได ชื่ อ KNOB
ซึ่ งเชื่ อมต อไปยั งขาพอร ตดิ จิ ตอลหมายเลข 31 (หรื ออิ นพุ ตอะนาลอก A7) ทํ าให อ านค าสั ญญาณ
ดิ จิ ตอลและอะนาลอกได ในขาพอร ตเดี ยวกั น

 ม ีจ ุดต อ ISP ส ําหร ับอ ัปเกรดหร ือกู เฟ ร มแวร  โดยใช ช ุดโปรแกรมแบบ ISP เพิ ่มเต ิม (แนะ
นํ าเครื่ องโปรแกรม AVR-ISP mark II ของ Atmel)
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Q1
KRC102

(DTC114)

R1
(Default = 510)

LED1

+

S

ร ูปที ่ 2-3 ร ูปร างและวงจรของแผงวงจรไฟแสดงผล ZX-LED ที ่ใช ในช ุดกล องสมองกล IPST-MicroBOX(SE)

รู ปที่  2-4 รู ปร างของแผงวงจรไฟแสดงผล ZX-LED
ที่ ใช ในชุ ดกล องสมองกล IPST-MicroBOX(SE)

2.3 ค ุณสมบ ัต ิของช ุดอ ุปกรณ เอาต พ ุต

2.3.1 แผงวงจรไฟแสดงผล : ZX-LED (มี ในชุ ดมาตรฐาน 1 ถึ ง 3)

ใช  LED ขนาด 8 มิ ลลิ เมตร ต องการลอจิ ก “1” ในการขั บให สว าง มี วงจรแสดงในรู ปที่  2-3

2.3.2 แผงวงจรไฟแสดงผล 8 ดวง  : ZX-LED8 (มี ในชุ ดมาตรฐาน 1 ถึ ง 3)

เป นแผงวงจรที ่ม ี LED ขนาด 3 ม ิลล ิเมตรส ําหร ับแสดงผล 8 ดวง พร อมจ ุดต อพ วงเอาต พ ุตเพื ่อ
น ําไปใช ในการข ับร ีเลย ได ด วย โดยแผงวงจร ZX-LED8 นี ้จะต อเข าก ับขาพอร ตใดของแผงวงจร IPST-
SE ก ็ได  โดยใช ขาพอร ตเพ ียงขาเด ียวในการควบค ุมและข ับ LED ให ต ิดด ับตามที ่ต องการได พร อมก ัน
ถึ ง 8 ดวง มี หน าตาของแผงวงจรแสดงในรู ปที่  2-4

ในแผงวงจร ZX-LED8 ใช การต ิดต อก ับ
แผงวงจรหล ัก IPST-SE ในแบบอน ุกรม ร วมก ับ
ค ําสั ่งทางซอฟต แวร  ผู พ ัฒนาโปรแกรมสามารถ
เขี ยนโปรแกรมให  ZX-LED8 ติ ดดั บได ตั้ งแต  1
ถึ ง 8 ตั ว หรื อจะเขี ยนโปรแกรมให ทํ างานเป น
ไฟวิ่ งได ตั้ งแต  1 ถึ ง 8 ดวงเช นกั น

ที่ ด านบนของแผงวงจร ZX-LED8 มี จุ ด
ต อซึ ่งต อพ วงมาจาก LED ทํ างานที ่ลอจิ ก “1” ม ี
ระด ับแรงด ันไฟตรงขาออกประมาณ +5V จ ึงใช 
สั ญญาณจากจุ ดนี้ ไปต อกั บวงจรขั บโหลด
กระแสไฟฟ าส ูง อาท ิ แผงวงจรข ับร ีเลย  ได ท ันท ี
โดยไม ต องเขี ยนโปรแกรมควบคุ มเพิ่ มเติ ม
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2.3.4 แผงวงจร LED ตั วเลข 7 ส วน 4 หลั ก : DSP-4S (มี เฉพาะในชุ ดมาตรฐาน 3)

มี หน าตาของแผงวงจรแสดงในรู ปที่  2-6 คุ ณสมบั ติ ทางเทคนิ คที่ สํ าคั ญมี ดั งนี้ 

 ใช แสดงผลในรู ปแบบของตั วเลข 4 หลั ก, สั ญลั กษณ  และเครื่ องหมายวรรคตอน เช น
โคลอน (สํ าหรั บแสดงเวลา), ไฮเฟน (สํ าหรั บแสดงค าของหน วยองศา)

 ใช  LED ต ัวเลข 7 ส วน 4 หลั กแบบแคโทดร วม เล ือกให แสดงผลแยกเป นหล ักหร ือรวม
กั นก็ ได ด วยการเขี ยนคํ าสั่ งสํ าหรั บควบคุ มการทํ างาน

 ม ีจ ุดต อขาพอร ต 1 จุ ด เพื ่อติ ดต อก ับแผงวงจรหล ัก IPST-SE ในแบบอนุ กรม

 เชื่ อมต อกั บแผงวงจรหล ัก IPST-SE ได พร อมกั นสู งสุ ด 16 แผง

รู ปที่  2-5 วงจรของแผงวงจรลํ าโพงเป ยโซ
ZX-SPEAKER

C1
10/16V

SP1
Piezo

speaker

S
+

K1
SOUND

2.3.3 แผงวงจรลํ าโพงเป ยโซ  :
ZX-SPEAKER    (มี ในชุ ดมาตรฐาน 1 ถึ ง 3)

มี วงจรและหน าตาของแผงวงจรแสดงในรู ปที่ 
2-5 คุ ณสมบั ติ ทางเทคนิ คที่ สํ าคั ญมี ดั งนี้ 

 ใช ลํ าโพงเป ยโซ มี อิ มพี แดนซ  32

 มี ค าความถี่ เรโซแนนซ ในย าน1 ถึ ง 3kHz

รู ปที่  2-6 รู ปร างของ DSP-4S แผงวงจรแสดงผล LED ตั วเลข 7 ส วน 4 หลั ก
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2.3.5 แผงวงจร LED อิ นฟราเรด : ZX-IrLED (มี เฉพาะในชุ ดมาตรฐาน 3)

ใช  LED เปล งแสงอิ นฟราเรด 3 มม. มี วงจรและหน าตาของแผงวงจรแสดงในรู ปที่  2-7 ใช งาน
ได  2 แบบคื อ

1. ส งแบบต อเนื่ อง  ทํ างานเมื่ อได รั บลอจิ ก "1" ใช กั บแผงวงจรตรวจจั บแสงอิ นฟราเรดที่ 
ใช โฟโต ทรานซิ สเตอร เพื่ อวั ดระดั บความเข มของแสงอิ นฟราเรดที่ ส งออกไป

2. ส งแบบสั ญญาณความถี่   โดยผสมสั ญญาณพาห ความถี่  38kHz ในกรณี นี้ จะใช งานร วม

กั บแผงวงจรโมดู ลรั บแสงอิ นฟราเรด 38kHz (ZX-IRM) เพื่ อตรวจสอบการรั บสั ญญาณ

O ZX-iR LED

Infrared LED

150

S
+

ร ูปที ่ 2-7 ร ูปร างและวงจรของแผงวงจรก ําเน ิดแสงอ ินฟราเรดที ่ใช ในช ุดกล องสมองกล IPST-MicroBOX (SE)
มาตรฐาน 3

2.3.6 แผงวงจรขั บรี เลย  4 ช อง : Relay-4i (มี เฉพาะในชุ ดมาตรฐาน 3)

มี วงจรและหน าตาของบอร ดแสดงในรู ปที่  2-8 มี คุ ณสมบั ติ โดยสรุ ปดั งนี้ 

 ใช ไอซ ีข ับโหลดกระแสส ูงเบอร  ULN2003 บนบอร ดจ ัดวงจรเพื ่อข ับร ีเลย  12V 4 ช อง

 ใช ไฟเลี้ ยง +12V แยกต างหาก

 รั บสั ญญาณลอจิ ก “1” จากไมโครคอนโทรลเลอร หรื อวงจรขั บจากภายนอกในการ
กระตุ นให รี เลย ทํ างาน

 มี ไฟแสดงการทํ างานของรี เลย 

 จุ ดต อหน าสั มผั สรี เลย เป นแบบขั นสกรู  ทํ าให สามารถต อใช งานได อย างสะดวก

 อ ัตราทนได ของหน าส ัมผ ัสร ีเลย  220Vac 5A สามารถรองร ับโหลดได ไม เก ิน 300 ว ัตต 



  Arduino IDE29

ร ูปที ่ 2-8 วงจรสมบ ูรณ ของแผงวงจรข ับร ีเลย  4 ช อง

14

13

IN4

IN3

OUT4

OUT3

OUT3

OUT4

+V

GND

IC1
ULN2003

LED1
RY1

R1
1.8k

RY1
Relay 12V

K4
RELAY-4

C1
0.1F/63V

LED2
RY2

R2
1.8k

RY2
Relay 12V

+12V

+12V

15

LED3
RY3

R3
1.8k

RY3
Relay 12V

+12V

16

LED4
RY4

R4
1.8k

RY4
Relay 12V

NO

C

NC

10

1

2K3
RELAY-3

IN2
3K2

RELAY-2

IN1
4K1

RELAY-1

8

NO

C

NC

NO

C

NC

NO

C

NC

+12V

GND

จุ ดต อไฟเลี้ ยง +12V จุ ดต อหน าสั มผั สรี เลย  (NO : ปกติ เป ดวงจร, NC : ปกติ ต อวงจร
และ C : ขาร วม) รวม 4 ช อง ต อไฟสลั บ/ไฟตรงได สู งสุ ด 220Vac 5A

LED แสดงการทํ างานของ
วงจรขั บรี เลย แต ละช อง

จุ ดต อพอร ตใดๆ ของ
แผงวงจรหลั ก IPST-SE
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2.4 ค ุณสมบ ัต ิของช ุดอ ุปกรณ ตรวจจ ับส ัญญาณ

2.4.1 แผงวงจรสวิ ตช  : ZX-SWITCH01  (มี ในชุ ดมาตรฐาน 1 ถึ ง 3)

มี วงจรแสดงในรู ปที่  2-9 ประกอบด วยสวิ ตช พร อมไฟแสดงผล

ให เอาต พุ ตคื อ หากมี การกดสวิ ตช   จะส งลอจิ ก “0” (ระดั บแรงดั น 0V) และไฟสี แดงติ ด

A ZX-LDR

10k

LDR

+

+

+S

+S

LDR
Light

A เมื่อแสงมากขึ้น
แรงดันที่ไดจะลดลง

เมื่อแสงมากขึ้น
แรงดันที่ไดจะมากขึ้น+

+

H
IG

H
L
O

W

D เมื่อกดเปนลอจิก 0
และแสดงไฟเปนสีเขียว

เมื่อกดเปนลอจิก 1
และแสดงไฟเปนสีแดง

D ZX-SWITCH

LOW

HIGH510

Bi-color LED

10kSWITCH +S

+S
R

G

ร ูปที ่ 2-9 ร ูปร างและวงจรของแผงวงจรสว ิตช ที ่ใช ในช ุดกล องสมองกล IPST-MicroBOX (SE)

ร ูปที ่ 2-10 ร ูปร างและวงจรของแผงวงจรตรวจจ ับแสงที ่ใช ในช ุดกล องสมองกล IPST-MicroBOX (SE)

2.4.2 แผงวงจรตรวจจั บแสง : ZX-LDR   (มี ในชุ ดมาตรฐาน 1 ถึ ง 3)

ใช ตรวจจั บแสงสว าง เลื อกเอาต พุ ตได  2 แบบคื อ

   +  แรงดั นเอาต พุ ตเพ่ิ ม  เมื่ อแสงตกกระทบ

    แรงดั นเอาต พุ ตลดลง เมื่ อแสงตกกระทบ

มี วงจรและรู ปร างของแผงวงจรแสดงในรู ปที่  2-10
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2.4.3 แผงวงจรต ัวต านทานปร ับค าได แบบ
แกนหม ุน : ZX-POTV POTENTIOMETER
(มี ในชุ ดมาตรฐาน 1 ถึ ง 3)

ใช กํ าหนดแรงดั น 0 ถึ ง +5V ตามการหมุ น
แกน นํ าไปใช วั ดค ามุ มและระยะทางได   มี เอาต พุ ต
2 แบบค ือ  แรงด ันมากขึ ้นเมื ่อหม ุนทวนเข ็มนาฬ ิกา
หรื อ ตามเข็ มนาฬิ กา

มี วงจรและหน าตาของแผงวงจรแสดงใน
ร ูปที ่  2-11

เมือ่หมนุทวนเข็มนาฬกิา
แรงดนัทีไ่ดจะมากข้ึน

เมือ่หมนุตามเข็มนาฬกิา
แรงดนัทีไ่ดจะมากข้ึน

A

POTENTIOMETER

A ZX-POTV

10kB

+

S

+

S

รู ปที่  1-11 แสดงรู ปร าง, วงจร และการทํ างาน
ของแผงวงจรต ัวต านทานปร ับค าได แบบแกนหม ุน

2.4.4 ไอซี วั ดอุ ณหภู มิ  MCP9701  (มี ในชุ ดมาตรฐาน 1 ถึ ง 3)

เป นอ ุปกรณ ตรวจจ ับและว ัดอ ุณหภ ูม ิที ่ให ผลการท ํางานเป นแรงด ันไฟฟ าแบบเช ิงเส น ร ับรู การ
เปลี่ ยนแปลงของอุ ณหภู มิ ภายในเวลาไม ถึ ง 2 วิ นาที  เชื่ อมต อกั บอิ นพุ ตอะนาลอก A0 ถึ ง A6 ของแผง
วงจรหลั ก IPST-SE ได ทั นที  ในรู ปที่  2-12  แสดงการจั ดขาและกราฟคุ ณสมบั ติ ของไอซี วั ดอุ ณหภู มิ 
เบอร  MCP9701

ร ูปที ่ 2-12 การจ ัดขาของ MCP9701, หน าตาเมื ่อต อสายส ัญญาณพร อมใช งานและกราฟค ุณสมบ ัต ิ
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คุ ณสมบั ติ ทางเทคนิ คของ MCP9701 ที่ ควรทราบ

  เป นไอซี วั ดอุ ณหภู มิ ในกลุ มเทอร มิ สเตอร แบบแอกตี ฟที่ ให ผลการทํ างานแบบเชิ งเส น

  ย านวั ด -40 ถึ ง +125 องศาเซลเซี ยส

  ผลการวั ดอ างอิ งกั บหน วยขององศาเซลเซี ยสโดยตรง

  ความผิ ดพลาดเฉลี่ ย 2 องศาเซลเซี ยส

  ย านไฟเลี ้ยง +3.1 ถ ึง +5.5V ก ินกระแสไฟฟ าเพ ียง 6uA ใช แบตเตอรี ่เป นแหล งจ ายไฟได 

  ค าแรงดั นเอาต พุ ต  500mV (ที่  0๐C) ถึ ง 2.9375V (ที่  125๐)

  ค าแรงดั นเอาต พุ ตต อการเปลี่ ยนแปลงอุ ณหภู มิ  19.5mV/๐C ใช งานกั บวงจรแปลง
สั ญญาณอะนาลอกเป นดิ จิ ตอลความละเอี ยดตั้ งแต  8 บิ ตได  โดยมี ความคลาดเคลื่ อนตํ่ า

  ไม ต องการอุ ปกรณ ภายนอกต อเพ่ิ มเติ มเพื่ อชดเชยการทํ างาน

2.4.5 แผงวงจรตรวจจั บแสงสะท อนอิ นฟราเรด : ZX-03 (มี ในชุ ดมาตรฐาน 2 และ 3)

มี วงจรและหน าตาของแผงวงจรแสดงในรู ปที่  2-13 เป นแผงวงจรที่ ใช ในการตรวจสอบการ
สะท อนของแสงอ ินฟราเรดของต ัวตรวจจ ับแสงสะท อนอ ินฟราเรดซึ ่งรวมต ัวส งและต ัวร ับไว ในต ัวถ ัง
เดี ยวกั น โดยตั วตรวจจั บแสงสะท อนอิ นฟราเรดที่ นํ ามาใช คื อ TCRT5000

เมื่ อจ ายไฟเลี้ ยง LED อิ นฟราเรดภายในตั วโมดู ล TCRT5000 จะเปล งแสงออกมาตลอดเวลา
ส วนตั วรั บซึ่ งเป นโฟโต ทรานซิ สเตอร จะได รั บแสงอิ นฟราเรดจากการสะท อนกลั บ โดยปริ มาณของ
แสงที ่ได ร ับจะมากหร ือน อยขึ ้นอยู ก ับว า ม ีว ัตถ ุมาก ีดขวางหร ือไม  และว ัตถ ุนั ้นม ีความสามารถในการ

ร ูปที ่ 2-13 หน าตาและวงจรของแผงวงจรตรวจจ ับแสงสะท อนอ ินฟราเรดที ่ใช ในช ุด IPST-MicroBOX (SE)
รุ นมาตรฐาน 2 และ 3

10k

TCRT5000

510

+V

GND

OUT

ตั วตรวจจั บแสงสะท อนอิ นฟราเรด

จ ุดต อสั ญญาณ
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สะท อนแสงอ ินฟราเรดได ด ีเพ ียงไร ซึ ่งขึ ้นก ับล ักษณะพื ้นผ ิวและส ีของว ัตถ ุ โดยว ัตถ ุส ีขาวผ ิวเรี ยบจะ
สะท อนแสงอ ินฟราเรดได ด ี ท ําให ต ัวร ับแสงอ ินฟราเรดได ร ับแสงสะท อนมาก ส งผลให แรงด ันที ่เอาต 
พุ ตของวงจรสู งตามไปด วย ในขณะที่ วั ตถุ สี ดํ าสะท อนแสงอิ นฟราเรดได น อย ทํ าให ตั วรั บอิ นฟราเรด
ส งแรงด ันออกมาตํ ่า ด วยค ุณสมบ ัต ิด ังกล าวจ ึงน ิยมน ําแผงวงจรตรวจจ ับแสงสะท อนอ ินฟราเรดนี ้มาใช 
ในการตรวจจั บพื้ นหรื อเส น โดยต องติ ดตั้ งไว ด านล างของโครงหุ นยนต 

เนื ่องจากแผงวงจรตรวจจ ับแสงสะท อนอ ินฟราเรด ZX-03 ให ผลการท ํางานเป นแรงด ันไฟตรง
ดั งนั้ นในการใช งานกั บแผงวงจรหลั ก  IPST-SE จึ งต องต อเข ากั บช องอิ นพุ ตอะนาลอก (A0 ถึ ง A6)
ของแผงวงจรหล ัก จากนั ้นใช ความรู จากการอ านค าส ัญญาณอะนาลอก เพื ่ออ านค าจากแผงวงจรตรวจ
จั บแสงสะท อนอิ นฟราเรดนํ าไปสู การตรวจจั บเส นต อไป

2.4.5 แผงวงจรตรวจจั บเสี ยง : ZX-SOUND  (มี ในชุ ดมาตรฐาน 3)

ใช ตรวจจั บการเปลี่ ยนแปลงระดั บเสี ยง เช นเสี ยงปรบมื อ เสี ยงพู ด ใช งานเป นได ทั้ งตั วตรวจ
จั บดิ จิ ตอลและอะนาลอก

กรณี ทํ างานกั บอิ นพุ ตอะนาลอก (A1 ถึ ง A7) ของแผงวงจรหลั ก IPST-SE

ในภาวะปกติ แรงดั นเอาต พุ ต 0V

เมื ่อม ีเส ียงเข ามา แรงดั นเปลี่ ยนแปลงในช วงมากกว า 0V ถึ ง +5V

แสดงวงจรและลั กษณะของแผงวงจรในรู ปที่  2-14

+

-

R1
22k

MIC1

C1
470uF/16VC2

0.1uF/50V

R2
100k

R3
1k

R4
100k

+

-

3

2

1 5

6 8

4

7

IC1 : TLC272

IC1/1

IC1/2

C3
22uF

R6
1k

R5
68k R7

12R

+ S

ร ูปที ่ 2-14 วงจรสมบ ูรณ ของแผงวงจรตรวจจ ับเส ียงและหน าตาของแผงวงจรที ่ใช งานจร ิง
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2.4.6 แผงวงจรตรวจจั บแสงอ ินฟราเรดโดยใช โฟโต ทรานซิ สเตอร  :
 ZX-Photo Transistor (มี ในชุ ดมาตรฐาน 3)

มี วงจรและรู ปร างของแผงวงจรแสดงในรู ปที่  2-15

ใช ตรวจจ ับแสงที ่ม ีความยาวคลื ่นอยู ในช วงอ ินฟราเรด ซึ ่งม ีค าระหว าง 1 ไมโครเมตร (m) ถึ ง
1 ม ิลล ิเมตร (mm) ใช งานได  2 ล ักษณะค ือ

1. อ านค าเป นระดั บความเข มแสงแบบอะนาลอก โดยแรงดั นเอาต พุ ตที่ ได จะลดลงเมื่ อได 
รั บแสงอิ นฟราเรดที่ มี ความเข มเพิ่ มขึ้ น (ถ าเลื อกการทํ างานแบบนี้ ให ต อสั ญญาณเข ากั บจุ ดต อพอร ต
A0 ถึ ง A6 ของแผงวงจรหลั ก IPST-SE)

2. ตรวจสอบว าตรวจจั บแสงอิ นฟราเรดได หรื อไม  ให เอาต พุ ตเป นสั ญญาณดิ จิ ตอลแบบ
ลอจิ ก "0" เมื่ อตรวจจั บแสงอิ นฟราเรดได   (ถ าเลื อกการทํ างานแบบนี้ ให ต อสั ญญาณเข ากั บพอร ตใด
ก็ ได ของแผงวงจรหลั ก IPST-SE)

ควรใช งานแผงวงจรตรวจจ ับแสงอ ินฟราเรดต ัวนี ้ก ับแผงวงจรก ําเน ิดแสงอ ินฟราเรด ZX-IrLED

นอกจากนั ้น ย ังใช แผงวงจรตรวจจ ับแสงอ ินฟราเรดในการตรวจจ ับเปลวเท ียนได ด วย เนื ่องจาก
เมื่ อเที ยนถู กจั ด เกิ ดการเผาไหม ไส เที ยน ทํ าให เกิ ดแสงสว าง และรั งสี อิ นฟราเรดออกจากเปลวเที ยน

A ZX-PHOTO

10k

Photo
transistor

+
S

รู ปที่  2-15 รู ปร างและวงจรของแผงวงจรตรวจจั บแสงอิ นฟราเรดโดยใช โฟโต ทรานซิ สเตอร ที่ ใช ใน
ชุ ดกล องสมองกล IPST-MicroBOX
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2.4.7 แผงวงจรโมดู ลรั บแสงอิ นฟราเรด 38kHz  : ZX-IRM (มี ในชุ ดมาตรฐาน 3)
ม ีวงจรและหน าตาของบอร ดแสดงในร ูปที ่ 2-16 ใช ตรวจจ ับแสงอ ินฟราเรดที ่ผสมส ัญญาณพาห 

ความถี่  38 kHz

ให ผลเป นลอจิ ก “1” เมื่ อตรวจจั บสั ญญาณไม ได 

ให ผลเป นลอจิ ก “0” เมื่ อตรวจจั บสั ญญาณแสงได 

โดยปกติ แล วโมดู ลรั บแสงอิ นฟราเรดทํ างานได ดี ที่ สุ ดที่ ความถี่  38.5kHz แต ในความเป นจริ ง
โมดู ลรั บแสงอิ นฟราเรด 38kHz สามารถรั บสั ญญาณที่ มี ความถี่ ใกล เคี ยงเข ามาได  แต การตอบสนอง
หร ือความไวจะลดลงอย างมาก จากกราฟค ุณสมบ ัต ิในการท ํางานของโมด ูลร ับแสงอ ินฟราเรด 38kHz
ในรู ปที่  2-16 แสดงให เห็ นถึ งความไวในการรั บสั ญญาณของโมดู ลรั บแสงอิ นฟราเรดที่ ความถี่ ต างๆ
ที่ ความถี่  38.5kHz จะเป นจุ ดที่ ให ความแรงของสั ญญาณสู งสุ ด

D INFRARED RECEIVER

0.1/50V

38kHz
IRM
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GND

18 22 26 30 34 38 42 46 50 54 58
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าม
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 (5
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รู ปที่  2-16 หน าตา, วงจร และกราฟคุ ณสมบั ติ ในการทํ างานของแผงวงจรโมดู ลรั บอิ นฟราเรด38kHz
ที่ ใช ในชุ ดกล องสมองกล IPST-MicroBOX (SE) รุ นมาตรฐาน 3

โมดู ลรั บแสงอิ นฟราเรด 38kHz

2.4.8 ร ีโมตคอนโทรลอ ินฟราเรด
(ม ีในช ุดมาตรฐาน 3)

เป นรี โมตคอนโทรลที่ ใช รู ปแบบข อมู ลของ SONY
ซึ่ งเป นรหั สข อมู ลแบบอนุ กรมที่ เรี ยกว า โปรโตคอล  SIRCS
(serial infrared remote control system) สํ าหรั บรี โมต
คอนโทรลของโทรทั ศน มี ชื่ อรหั สคื อ Sony D7C5 มี หน าตา
แสดงในรู ปที ่ 2-17 ใช งานร วมก ับ ZX-IRM แผงวงจรโมด ูลร ับ
แสงอิ นฟราเรด 38kHz

ร ูปที ่ 2-17 ร ีโมตคอนโทรลอ ินฟราเรด
ที ่ใช รห ัสข อม ูลของ SONY
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2.4.9 GP2Y0A41 โมดู ลตรวจจั บระยะทางแบบอิ นฟราเรด    (มี ในชุ ดมาตรฐาน 3)

GPY0A41 (หรื อ GP2D120) เป นโมดู ลตรวจจั บระยะทางแบบอิ นฟราเรดมี ขาต อใช งาน 3
ขาคื อ ขาต อไฟเลี้ ยง (Vcc), ขากราวด  (GND) และขาแรงดั นเอาต พุ ต (Vout) การอ านค าแรงดั นจาก
GP2D120 จะต องรอให พ นช วงเตรี ยมความพร อมของโมดู ลก อน ซึ่ งใช เวลาประมาณ 32.7-52.9 มิ ลลิ 
ว ินาท ี ด ังนั ้นในการอ านค าแรงด ันจ ึงควรรอให พ นช วงเวลาด ังกล าวไปก อน ด ังแสดงข อม ูลเบื ้องต นใน
รู ปที่  2-18

ค าแรงดั นเอาต พุ ตของ GP2Y0A41 ที่ ระยะทาง 30 เซนติ เมตรที่ ไฟเลี้ ยง +5V อยู ในช วง 0.25
ถึ ง 0.55V โดยค ากลางคื อ 0.4V ช วงของการเปลี่ ยนแปลงแรงดั นเอาต พุ ตที่ ระยะทาง 4 เซนติ เมตรคื อ
2.25V 0.3V

รู ปที่  2-18 แสดงรู ปร าง การจั ดขา ไดอะแกรมเวลาจั งหวะการทํ างาน และกราฟแสดงการทํ างานของ
GP2Y0A41 (หรื อ GP2D120)

LED อินฟราเรดตัวสง ตัวรบัแสงอินฟราเรด

GP2Y0A41

GNDVout Vcc

GP2D120

วัดครั้งที่ 1 วัดครั้งที่ 2

ไมแนนอน เอาตพุตครั้งท่ี 1 เอาตพุตครั้งท่ี 2 เอาตพุตครั้งท่ี n

วัดครั้งท่ี n

38.3ฑ9.6 มิลลิวินาที

5 มิลลิวินาที

การวัดระยะหาง

แรงดันเอาตพุต

ไฟเลี้ยง

* ใช กระดาษเทาขาวรุ น R-27 ของ Kodak ซึ่ ง
ด านขาวมี อั ตราการสะท อนแสง 90% เป น
วั ตถุ สํ าหรั บสะท อนแสงเพื่ อวั ดระยะทาง

4 8 12 16 20 24 28 320
0

0.4

0.8

1.2

1.6

2.0

2.4

2.8

แรงดันเอาตพุต
(V)

ระยะหางจากวัตถุที่ตรวจจับ (cm)

กราฟแสดงการทํ างานของ GP2Y0A41



  Arduino IDE37

2.5 ข อม ูลของอ ุปกรณ ทางกลที ่ใช ในช ุดกล องสมองกล IPST-MicroBOX (SE)
รุ นมาตรฐาน 2 และ 3

2.5.1 มอเตอร ไฟตรงพร อมชุ ดเฟ องขั บ

เป นชุ ดมอเตอร พร อมเฟ องขั บรุ น BO-2 อั ตราทด 48:1 มี สายต อ 2 เส น คุ ณสมบั ติ ทางเทคนิ คที่ 
สํ าคั ญมี ดั งนี้ 

  ต องการไฟเลี้ ยงในย าน +3 ถึ ง +9Vdc

  กิ นกระแสไฟฟ า 130mA (ที่ ไฟเลี้ ยง +6V และไม มี โหลด)

  ความเร็ วเฉลี่ ย 170 ถึ ง 250 รอบต อนาที  (ที่ ไฟเลี้ ยง +6V และไม มี โหลด)

  นํ้ าหนั ก 30 กรั ม

  แรงบิ ดตํ่ าสุ ด 0.5 กิ โลกรั ม-เซนติ เมตร

  ติ ดตั้ งเข ากั บตั วยึ ดพลาสติ กแบบมี พุ กทองเหลื องสํ าหรั บยึ ดในตั ว

  ขนาด (กว าง x ยาว x สู ง) 42 x 45 x 22.7 มิ ลลิ เมตร

2.5.2  ล อพลาสต ิกส ําหร ับช ุดเฟ องข ับมอตอร และยาง

เป นล อกลม ม ีเส นผ านศ ูนย กลาง 65 ม ิลล ิเมตร สามารถสวมเข าก ับแกนของช ุดเฟ องข ับมอเตอร 
ได ท ันท ีโดยไม ต องด ัดแปลงเพิ ่มเต ิม ข ันย ึดด วยสกร ูเกล ียวปล อย 2 ม ิลล ิเมตร ส วนยางขอบล อที ่ใช ร วม
ด วยผลิ ตจากยางพารา ผิ วมี ดอกยางเพื่ อช วยเพิ่ มสมรรถนะในการเกาะพื้ นผิ ว
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2.5.3 แผ นกริ ด

เป นแผ นพลาสติ กที่ ผลิ ตจากวั สดุ  ABS ขนาด 80 x  60 มิ ลลิ เมตร และ 80 x  80 มิ ลลิ เมตร
อย างละ 1 แผ น ในแต ละมี รู ขนาด 3 มิ ลลิ เมตรที่ มี ระยะห างกั น 5 มิ ลลิ เมตร

2.5.4 แผ นฐานกลม

เป นแผ นพลาสติ กที่ ผลิ ตจากวั สดุ  ABS ขนาดเส นผ านศู นย กลาง 250 มิ ลลิ เมตร เป นแผ นฐาน
สํ าหรั บยึ ดอุ ปกรณ ต างๆ ที่ แผ นฐานมี รู ขนาด 3 มิ ลลิ เมตรสํ าหรั บติ ดตั้ งอุ ปกรณ หรื อโครงสร างกลไก
เพิ่ มเติ ม มี รู ปร างเป นแผ นกลม ในชุ ดมี ให  2 แบบ แบบมี ล อกลมกึ่ งอิ สระทั้ งด านหน าและหลั ง และ
แบบมาตรฐานไม มี ล อกลมกึ่ งอิ สระ

 

2.5.5 ชิ้ นต อพลาสติ ก

เป นชิ้ นส วนพลาสติ กแข็ งเหนี ยว มี  3 แบบคื อ ชิ้ นต อแนวตรง, ชิ้ นต อมุ มฉาก และชิ้ นต อมุ ม
ป าน สามารถเสี ยบต อกั นได  ใช ต อกั นเป นโครงสร างหรื อตกแต ง บรรจุ  3 แบบ รวม 30 ชิ้ น
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2.5.6 แท งต อพลาสติ ก

เป นชิ้ นส วนพลาสติ กแข็ งเหนี ยวในแต ละชิ้ นจะมี รู ขนาด 3 มิ ลลิ เมตรสํ าหรั บร อยสกรู เพื่ อติ ด
ตั้ งหรื อต อกั บชิ้ นส วนโครงสร างอื่ นๆ ที่ ปลายของแท งต อสามารถเสี ยบเข ากั บชิ้ นต อพลาสติ กได  ใน
ชุ ดมี  3 ขนาด คื อ 3, 5 และ 12 รู   แต ละขนาดมี  4 ชิ้ น

2.5.7  สกรู และนอต

เป นอุ ปกรณ สํ าหรั บยึ ดชิ้ นส วนต างๆ เข าด วยกั น ในชุ ดประกอบด วย สกรู มื อหมุ น (4 ตั ว),
สกรู เกลี ยวปล อย 2 มิ ลลิ เมตร (2 ตั ว), สกรู  3 x 8 มิ ลลิ เมตร (4 ตั ว), 3 x 10 มิ ลลิ เมตร (30 ตั ว), 3 x 15
มิ ลลิ เมตร (4 ตั ว), 3 x 40 มิ ลลิ เมตร (4 ตั ว), สกรู หั วตั ด 3 x 8 มิ ลลิ เมตร (10 ตั ว)  และนอต 3 มิ ลลิ เมตร
(30 ตั ว)

      

2.5.8 เสารองโลหะ

เป นอุ ปกรณ ช วยยึ ดชิ้ นส วนต างๆ และรองรั บแผงวงจร, แผ นกริ ดและแผ นฐาน ทํ าจากโลหะ
ชุ บนิ เกิ ลกั นสนิ ม มี ลั กษณะเป นแท งทรงกระบอกยาว 50 มิ ลลิ เมตร ภายในมี รู เกลี ยวตลอดตั วสํ าหรั บ
ขั นสกรู  3 มิ ลลิ เมตร ในชุ ดมี  4 ตั ว
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2.5.9 เสารองพลาสติ ก

เป นอุ ปกรณ ช วยยึ ดชิ้ นส วนต างๆ และประคอง
รองรั บแผงวงจร, แผ นกริ ดและแผ นฐาน ทํ าจากพลาสติ ก
ABS เหนี ยว สามารถตั ดได  มี ลั กษณะเป นแท งทรงกระ
บอก ภายในมี รู ตลอดตั วสํ าหรั บร อยสกรู  3 มิ ลลิ เมตร ใน
ชุ ดประกอบด วย เสารองขนาด 3 มิ ลลิ เมตร (4 ตั ว), 10
มิ ลลิ เมตร (4 ตั ว), 15 มิ ลลิ เมตร (4 ตั ว) และ 25 มิ ลลิ เมตร
(4 ตั ว)

2.5.11 อะแดปเตอร ไฟตรง

เป นแหล งจ ายไฟตรงแบบสวิ ตชิ่ ง มี  2 ตั ว

1. อะแดปเตอร  +9V 2A ให แรงดั นขาออก
+9V จ ายกระแสไฟฟ าได ส ูงส ุด 2A  ปลายสายเป นห ัวปลั ๊ก
แบบบาร เรล (barrel) ซึ่ งเป นมาตรฐานที่ พบโดยทั่ วไป

2. อะแดปเตอร  +12V 1A  ให แรงดั นขาออก
+12V จ ายกระแสไฟฟ าได สู งสุ ด 1A ปลายสายต อเป น
แบบขั้ วต อที่ ป องกั นการต อกลั บขั้ ว มี แถบสี แดงระบุ ขั้ ว
บวกไว อย างชั ดเจน

2.5.10 กะบะถ าน

ใช บรรจุ แบตเตอร่ี ขนาด AA จํ านวน 6 ก อน มี หั ว
ต อแบบเด ียวก ับปลั ๊กอะแดปเตอร ส ําหร ับต อก ับแผงวงจร
ควบคุ มหลั ก IPST-SE ได ทั นที 
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2.6 ข อม ูลของสายส ัญญาณที ่ใช ในช ุดกล องสมองกล IPST-MicroBOX(SE)

2.6.1  สาย JST3AA-8 : สายเชื่ อมต อระหว างแผงวงจร

สาย JST3AA-8 ใช เชื่ อมต อระหว างแผงวงจรควบคุ ม IPST-SE กั บแผงวงจรตรวจจั บและแผง
วงจรอุ ปกรณ ต างๆ เป นสายแพ 3 เส น ยาว 8 นิ้ ว ปลายสายทั้ งสองด านติ ดตั้ งคอนเน็ กเตอร แบบ JST 3
ขา ตั วเมี ย ระยะห างระหว างขา 2 มิ ลลิ เมตร  มี การจั ดขาดั งนี้ 

ระยะหางระหวางขา 2 มม. ระยะหางระหวางขา 2 มม.

GND
S

+5V

2.6.2 สาย USB-miniB

เป นสายสั ญญาณสํ าหรั บเชื่ อมต อระหว างพอร ต USB ของคอมพิ วเตอร กั บแผงวงจร IPST-SE
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ในบทนี ้จะอธ ิบายส วนประกอบและรายละเอ ียดของซอฟต แวร  Arduino IDE 1.7.10 ที ่ใช ในการ
เข ียนโปรแกรม คอมไพล โปรแกรม และอ ัปโหลดโปรแกรมไปย ังแผงวงจร IPST-SE โดยซอฟต แวร 
Arduino IDE 1.7.10 ท ํางานบนระบบปฏ ิบ ัต ิการได ท ุกแบบ ไม ว าจะเป นว ินโดวส ที ่รองร ับตั ้งแต ว ินโดวส 
XP ขึ ้นไป (แนะนํ า 8 ขึ้ นไป), MAC OS และ Linux

3.1 ส วนประกอบของหน าจอโปรแกรม Arduino1.7.10

เมื ่อเร ียกให โปรแกรมท ํางาน จะม ีหน าตาด ังร ูปที ่ 3-1 ต ัวโปรแกรมประกอบด วยส วนต างๆ ด ังนี ้

 เมนู  (Menu) ใช เลื อกคํ าสั่ งต างๆ ในการใช งานโปรแกรม

 แถบเครื ่องม ือ (Toolbar) เป นการน ําค ําสั ่งที ่ใช งานบ อยมาสร างเป นปุ ม เพื ่อเร ียกใช ได เร ็วขึ ้น

 แถบเลื อกโปรแกรม (Tabs) เป นแถบที่ ใช เลื อกไฟล โปรแกรมแต ละตั ว (กรณี ที่ เขี ยน
โปรแกรมขนาดใหญ ประกอบด วยไฟล หลายตั ว)

 พื้ นที่ เขี ยนโปรแกรม (Text editor) เป นพื้ นที่ สํ าหรั บเขี ยนโปรแกรมภาษา C/C++

 พื้ นที่ แสดงสถานะการทํ างาน (Status area) เป นพื้ นที่ ใช แจ งสถานะการทํ างานของ
โปรแกรม เช น ผลการคอมไพล โปรแกรม

 พื ้นที ่แสดงข อความ (Message area) ใช แจ งว าโปรแกรมที ่ผ านการคอมไพล แล วม ีขนาด
กี่ ไบต  และแจ งตํ าแหน งหรื อรายละเอี ยดของข อผิ ดพลาดในการทํ างานของโปรแกรม

 ปุ มสํ าหรั บเป ดหน าต าง Serial Monitor ปุ มนี้ จะอยู ทางมุ มบนด านขวามื อ คลิ กปุ มนี้ 
เมื ่อต องการเป ดหน าต างสื ่อสารและแสดงข อม ูลอน ุกรม โดยต องม ีการต อฮาร ดแวร  Arduino และเล ือก
พอร ตการเชื่ อมต อให ถู กต องก อน


Arduino IDE






44   Arduino IDE

ร ูปที ่ 3-1 แสดงส วนประกอบของโปรแกรม Arduino IDE 1.7.10

แถบเครื่ องม ือ (Tools bar)

แถบเลื อกโปรแกรม (Tab)

เมนู  (Menu)

พื้ นที่ สํ าหรั บเขี ยนโปรแกรม
(Text Editor)

พื้ นที่ แสดงข อความ (Message area)

Serial Monitor คลิ กเพื่ อเป ดหน าต าง

สํ าหรั บรั บและส งข อมู ลอนุ กรมระหว าง
ฮาร ดแวร  Arduino กั บคอมพิ วเตอร 

พื้ นที่ แสดงสถานะการทํ างาน (Status area)

3.2 รายละเอี ยดแถบคํ าสั่ งหรื อเมนู  (Menu)

เป นส วนที่ แสดงรายการ (เมนู ) ของคํ าสั่ งต างๆ ของโปรแกรม ประกอบด วย

1. เมนู  File

ใน Arduino เร ียกโปรแกรมที ่พ ัฒนาขึ ้นว า สเก ็ตช  (Sketch) และในโปรแกรมของผู ใช งาน
อาจมี ไฟล โปรแกรมหลายตั ว จึ งเรี ยกรวมว าเป น สเก็ ตช บุ ก (Sketchbook) ในเมนู นี้ เกี่ ยวข องกั บการ
เป ด-บั นทึ ก-ป ดไฟล ดั งนี้ 
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 New : ใช สร างไฟล สเก็ ตช ตั วใหม   เพื่ อเริ่ มเขี ยนโปรแกรมใหม 

 Open ใช เป ดสเก็ ตช ที่ บั นทึ กไว ก อนหน านี้ 

 Sketchbook : ใช เป ดไฟล สเก็ ตช ล าสุ ดที่ เป ดใช งานเสมอ

 Example : ใช เป ดไฟล สเก ็ตช ต ัวอย างในโฟลเดอร  Arduino

 Close : ใช ป ดไฟล สเก็ ตช ที่ เป ดอยู 

 Save : ใช ในการบั นทึ กไฟล สเก็ ตช ป จจุ บั น

 Save as : ใช บั นทึ กไฟล สเก็ ตช โดยเปลี่ ยนชื่ อไฟล 

 Upload : ใช อั ปโหลดโปรแกรมไปยั งฮาร ดแวร ของ Arduino

 Preference : ใช กํ าหนดค าการทํ างานของโปรแกรม

 Quit : ใช จบการทํ างานและออกจากโปรแกรม

2. เมนู  Edit

ในขณะที่ พิ มพ โปรแกรมให ใช คํ าสั่ งในเมนู นี้ ในการแก ไขโปรแกรม รวมถึ งยกเลิ กคํ าสั่ ง
ที่ แล ว ทํ าซํ้ า ตั ด คั ดลอก วางข อความ ค นหาคํ า เป นต น มี เมนู ต างๆ ดั งน ี้ 

 Undo : ยกเลิ กคํ าสั่ งหรื อการพิ มพ ครั้ งสุ ดท าย

 Redo : ทํ าซํ้ าคํ าสั่ งหรื อการพิ มพ ครั้ งสุ ดท าย

 Cut : ตั ดข อความที่ เลื อกไว ไปเก็ บในคลิ ปบอร ดของโปรแกรม

 Copy : คั ดลอกข อความที่ เลื อกไว มาเก็ บในคลิ ปบอร ด

 Paste : นํ าข อความที่ อยู ในคลิ ปบอร ดมาแปะลงในตํ าแหน งที่ เคอร เซอร ชี้ อยู 

 Select All : เลื อกข อความทั้ งหมด

 Comment/Uncomment : ใช เติ มเครื่ องหมาย // เพื่ อสร างหมายเหตุ หรื อคํ าอธิ บายลง
ในโปรแกรมหรื อยกเลิ กหมายเหตุ ด วยการนํ าเครื่ องหมาย // ออก

 Find : ค นหาข อความ

 Find Next : ค นหาข อความถั ดไป
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3. เมนู  Sketch

เป นเมนู ที่ บรรจุ คํ าสั่ งที่ ใช คอมไพล โปรแกรม เพิ่ มไฟล ไลบรารี  ฯลฯ มี เมนู ย อยดั งนี้ 

 Verify/Compile : ใช คอมไพล แปลโปรแกรมภาษาซี ให เป นภาษาเครื่ อง

 Import Library : เป นค ําสั ่งเร ียกใช ไลบราร ีเพิ ่มเต ิม เมื ่อเล ือกค ําสั ่งนี ้แล ว โปรแกรม
Arduino IDE จะแสดงไลบราร ีให เล ือก เมื ่อเล ือกแล ว ต องแทรกบรรท ัดค ําสั ่ง #include ที ่ส วนต นของ
โปรแกรม

 Add file : เพิ ่มไฟล ให ก ับสเก ็ตช บุ กป จจ ุบ ัน เมื ่อใช ค ําสั ่งนี ้โปรแกรม Arduino จะค ัดลอกไฟล 
ที ่เล ือกไว มาเก ็บไว ในโฟลเดอร เด ียวก ันก ับโปรแกรมที ่ก ําล ังพ ัฒนา

 Show Sketch folder : สั่ งเป ดโฟลเดอร ที่ เก็ บโปรแกรมของผู ใช 

4. เมนู  Tools

ใช จั ดรู ปแบบของโค ดโปรแกรม, เลื อกฮาร ดแวร ไมโครคอนโทรลเลอร Arduino หรื อ
เลื อกพอร ตอนุ กรม มี เมนู พื้ นฐานดั งนี้ 

 Auto Format  : จั ดรู ปแบบของโค ดโปรแกรมให สวยงาม  เช น กั้ นหน าเยื้ องขวา
จั ดตํ าแหน งวงเล็ บป กกาป ดให ตรงกั บป กกาเป ด ถ าเป นคํ าสั่ งที่ อยู ภายในวงเล็ บป กกาเป ดและป ดจะ
ถู กกั้ นหน าเยื้ องไปทางขวามากขึ้ น

 Archive Sketch : สั ่งบ ีบอ ัดไฟล โปรแกรมทั ้งโฟลเดอร หล ักและโฟลเดอร ย อยของไฟล 
สเก็ ตช ป จจุ บั น ไฟล ที่ สร างใหม จะมี ชื่ อเดี ยวกั บไฟล สเก็ ตช ป จจุ บั นและ
ต อท ายด วยวั นเดื อนป ที่ สร างไฟล สเก็ ตช ขึ้ น เช น  -510123.zip

 Board : เลื อกฮาร ดแวร ของบอร ดไมโครคอนโทรลเลอร  Arduino สํ าหรั บแผงวงจร
IPST-SE ให เลื อก IPST-SE, Atmega644P@16MHz

 Serial Port : เลื อกหมายเลขพอร ตอนุ กรมเสมื อน (COM) ของคอมพิ วเตอร ที่ ใช ติ ดต อ
กั บฮาร ดแวร  Arduino

5. เมนู  Help

เมื ่อต องการความช วยเหล ือ หร ือข อม ูลเกี ่ยวก ับโปรแกรมให เล ือกเมน ูนี ้ เมื ่อเล ือกเมน ูย อย
ตั วโปรแกรมจะเป ดไฟล เว็ บเพจ (ไฟล นามสกุ ล .html) ที่ เกี่ ยวข องกั บหั วข อนั้ นๆ โดยไฟล จะเก็ บใน
คอมพิ วเตอร ของผู ใช งาน ภายในโฟลเดอร ที่ เก็ บ Arduino IDE
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3.3 แถบเครื่ องมื อ (Toolbar)

เป นการนํ าคํ าสั่ งที่ ใช งานบ อยๆ มาสร างเป นปุ ม เพื่ อให เรี ยกใช คํ าสั่ งได รวดเร็ วขึ้ น

สํ าหรั บคํ าสั่ งที่ มี การใช บ อยๆ ตั วโปรแกรม Arduino จะนํ ามาสร างเป นปุ มบนแถบเครื่ องมื อ
เพื่ อให คลิ กเลื อกได ทั นที  ปุ มต างๆ บนแถบเครื่ องมื อมี ดั งนี้ 

 Verfy/Compile ใช ตรวจสอบการเข ียนค ําสั ่งในโปรแกรมว า ถ ูกต องตามหล ักไวยกรณ 

หร ือไม  และคอมไพล โปรแกรม

 Upload to I/O Board ใช อั ปโหลดโปรแกรมที่ เขี ยนขึ้ นไปยั งบอร ดหรื อฮาร ดแวร 
Arduino  ก อนจะอั ปโหลดไฟล  ต องแน ใจว าได บั นทึ กไฟล และคอมไพล ไฟล สเก็ ตช เรี ยบร อยแล ว

 New ใช สร างสเก็ ตไฟล  (ไฟล โปรแกรม) ตั วใหม 

 Open ใช แทนเมนู  File > Sketchbook เพื่ อเป ดสเก็ ตช  (ไฟล โปรแกรม) ที่ มี ในเครื่ อง

 Save ใช บั นทึ กไฟล สเก็ ตชบุ กที่ เขี ยนขึ้ น

3.4 แถบเลื อกโปรแกรม (Tabs)

เป นแถบที่ ใช เลื อกไฟล โปรแกรมแต ละตั ว (กรณี ที่ เขี ยนโปรแกรมขนาดใหญ ประกอบด วย
ไฟล หลายตั ว)
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3.5 พื้ นที่ เขี ยนโปรแกรม (Text editor)
เป นพื้ นที่ สํ าหรั บเขี ยนโปรแกรมภาษา C/C++

3.6 พื้ นที่ แสดงสถานะการทํ างาน (Status area)

เป นพื้ นที่ โปรแกรมใช แจ งสถานะการทํ างานของโปรแกรม เช น ผลการคอมไพล โปรแกรม
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3.7 พื้ นที่ แสดงข อมู ล (Message area)
ใช แจ งว าโปรแกรมที่ ผ านการคอมไพล แล วมี ขนาดกี่ ไบต และแจ งสาเหตุ ของการคอมไพล 

โปรแกรมไม ผ าน ตํ าแหน งหรื อคํ าสั่ งที่ ผิ ดพลาด

3.8 ปุ มเป ดหน าต าง Serial Monitor

ปุ มนี้ จะอยู ทางมุ มบนด านขวามื อ คลิ กปุ มนี้ เมื่ อต องการเป ดหน าต างสื่ อสารและแสดงข อมู ล
อนุ กรม โดยต องมี การต อฮาร ดแวร  Arduino และเลื อกพอร ต การเชื่ อมต อให ถู กต องก อน

เมื่ อคลิ กเป ดหน าต าง Serial Monitor ขึ้ นมา จะปรากฏหน าต างดั งรู ปที่  3-2
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ร ูปที ่ 3-2 แสดงส วนประกอบของหน าต าง Serial Monitor ของซอฟต แวร  Arduino IDE

หน าต าง Serial Monitor มี บทบาทมากในการใช แสดงผลการทํ างานของโปรแกรมแทนการ
ใช อุ ปกรณ แสดงผลอื่ นๆ เนื่ องจาก Arduino ได เตรี ยมคํ าสั่ งสํ าหรั บใช แสดงค าของตั วแปรที่ ต องการ
ดู ผลการทํ างานไว แล ว นั่ นคื อ Serial.print()

ส วนการส งข อม ูลจากคอมพ ิวเตอร ไปย ังฮาร ดแวร  Arduino หร ือแผงวงจรควบค ุม IPST-SE ให 
พิ มพ ข อความและคลิ กปุ ม Send

ในการร ับส งข อม ูลต องก ําหนดอ ัตราเร ็วในการถ ายทอดข อม ูลหร ือบอดเรต (baud rate) ให ก ับ
โปรแกรมในคํ าสั่ ง Serial.begin()

ตั วฮาร ดแวร ของ Arduino จะรี เซตเมื่ อเริ่ มเป ดใช งานหน าต าง Serial monitor
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3.9 ตํ าแหน งการเก็ บไฟล สเก็ ตช ของ Arduino IDE

ผู พ ัฒนาโปรแกรมบ ันท ึกไฟล สเก ็ตช ไว ที ่ใดในพื ้นที ่จ ัดเก ็บแฟ มข อม ูลของคอมพ ิวเตอร ก ็ได  แต 
เพื ่ออ ํานวยความสะดวกและจดจ ําง าย Arduino IDE จ ึงก ําหนดค าตั ้งต น (default) ของต ําแหน งจ ัดเก ็บ
โฟลเดอร ของไฟล สเก็ ตช ที่ พั ฒนาขึ้ นไว ที่  C:\Documents and Settings\Admin (หรื อชื่ อผู ใช ) \My
Documents\Arduino สามารถตรวจสอบรวมถ ึงก ําหนดต ําแหน งใหม ได  โดยไปที ่เมน ู File > Preference

จะปรากฏหน าต าง Preference ขึ้ นมาดั งรู ป หากต องการเปลี่ ยนแปลงตํ าแหน งโฟลเดอร ที่ จั ด
เก ็บไฟล สเก ็ตช ที ่ช อง Sketchbook location โดยใช เมาส คล ิกที ่ปุ มค นหาทางด านขวาม ือ หร ือจะพ ิมพ 
ตํ าแหน งลงไปในช อง  Sketchbook location โดยตรงก็ ได  จากนั้ นคลิ กปุ ม OK เพื่ อตอบตกลงและ
ยื นยั นการเปลี่ ยนแปลง

ส วนพาราม ิเตอร หร ือข อก ําหนดอื ่นๆ แนะน ําให ใช ตามค าที ่ก ําหนดมา ทั ้งนี ้เพื ่อลดขั ้นตอนการ
พั ฒนาโปรแกรมและความผิ ดพลาดที ่อาจเกิ ดขึ ้นได สํ าหร ับนั กพั ฒนาโปรแกรมมื อใหม หรื อผู เริ ่มต น
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หลั งจากการแนะนํ าขั้ นตอนแนวทางการพั ฒนาโปรแกรมภาษา C/C++ ด วยซอฟต แวร 
Arduino IDE 1.7.10 ไปแล วในบทที่  3 เพื่ อให การเรี ยนรู เป นไปอย างต อเนื่ อง ในบทนี้ จึ งนํ าเสนอ
ต ัวอย างการทดสอบการท ํางานในส วนต างๆ ที ่ส ําค ัญของแผงวงจร IPST-SE อ ันเป นแผงวงจรควบค ุม
หลั กของชุ ดกล องสมองกล IPST-MicroBOX (SE) เพื่ อเป นแนวทางในการต อยอดสู การพั ฒนา
โปรแกรมเพื่ อสร างโครงงานและหุ นยนต อั ตโนมั ติ อย างเต็ มรู ปแบบต อไป

หั วข อกิ จกรรมสํ าหรั บทดสอบเบื้ องต นมี ทั้ งสิ้ น 4 กิ จกรรม ประกอบด วย

กิ จกรรมที่  1 แสดงผลข อความที่ หน าจอภาพกราฟ ก LCD (มี กิ จกรรมย อย 5 กิ จกรรม)

กิ จกรรมที่  2 อ านค าจากปุ ม KNOB และสวิ ตช  OK บนแผงวงจร IPST-SE

กิ จกรรมที่  3 ขั บอุ ปกรณ เอาต พุ ตอย างง าย

กิ จกรรมที่  4 ขั บเสี ยงออกลํ าโพงเป ยโซ

ขั้ นตอนการพั ฒนาโปรแกรมในแต ละกิ จกรรมจะเหมื อนกั น นั่ นคื อ เป ดซอฟต แวร  Arduino
IDE 1.7.10 ท ําการเข ียนโปรแกรม คอมไพล  และอ ัปโหลดลงบนแผงวงจร IPST-SE ของช ุดกล องสมอง
กล IPST-MicroBOX (SE) จากนั้ นทดสอบการทํ างาน

สิ ่งส ําค ัญที ่ต องเน นยํ ้าค ือ ท ุกครั ้งที ่เป ดสว ิตช จ ายไฟแก แผงวงจร IPST-SE ต องรอ
ให ตั วควบคุ มพร อมทํ างานเสี ยก อน ซ่ึ งใช เวลาประมาณ 3 ถึ ง 5 วิ นาที หลั งจากเป ด
ไฟเลี้ ยงหรื อหลั งจากการกดสวิ ตช  RESET หากมี การอั ปโหลดก อนที่ แผงวงจร IPST-SE จะ

พร อมทํ างาน อาจทํ าให เกิ ดความผิ ดพลาดในการเชื่ อมต อ หรื อโค ดที่ อั ปโหลดลงไปไม ทํ างานตามที่ 
ควรจะเป น แต จะไม ส งผลจนทํ าให แผงวงจรเกิ ดความเสี ยหาย สิ่ งที่ เกิ ดขึ้ นมี เพี ยงแผงวงจรไม ทํ างาน
หรื อทํ างานไม ถู กต องเท านั้ น





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   



(A1.1.1) เป ดซอฟต แวร  Arduino IDE 1.7.10 พิ มพ โปรแกรมที่  A1-1 แล วบั นทึ กไฟล 

(A1.1.2) เป ดสวิ ตช จ ายไฟแก แผงวงจร IPST-SE แล ว เชื่ อมต อสาย USB เข ากั บคอมพิ วเตอร 
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
4

(A1.1.3) เลื อกชนิ ดหรื อรุ นของฮาร ดแวร ให ถู กต อง โดยเลื อกท่ี เมนู  Tools > Board > IPST-SE >
ATmega644P @16MHz ดั งรู ป
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(A1.1.4) เลื อกพอร ตสํ าหรั บติ ดต อกั บแผงวงจร IPST-SE โดยเลื อกที่ เมนู  Tools > Serial Port  ดั งรู ป
(ต ําแหน งของพอร ตที ่ใช เชื ่อมต ออาจแตกต างก ันในคอมพ ิวเตอร แต ละเครื ่อง)

(A1.1.5) คอมไพล และอ ัปโหลดโปรแกรมไปย ังแผงวงจร IPST-SE โดยคล ิกที ่ปุ ม  หร ือเล ือกที ่เมน ู

File > Upload to Wiring Hardware

ที่ หน าจอแสดงผลกราฟ ก LCD ของแผงวงจร IPST-SE แสดงข อความ Hello World
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#include <ipst.h> // ผนวกไลบรารี หลั ก
void setup()
{
  glcd(1,0,"Hello World"); // แสดงข อความบนจอแสดงผล
}
void loop()
{}
คํ าอธิ บายโปรแกรม

โปรแกรมนี้ จะทํ างานโดยส งข อความ Hello World ออกไปแสดงผลที่ บรรทั ด 1 คอลั มน  0 ของจอ
แสดงผล จะทํ างานเพี ยงครั้ งเดี ยว จึ งเขี ยนโปรแกรมไว ที่ ตํ าแหน งของ void setup() เท านั้ น

โปรแกรมที ่ A1-1 ไฟล  microbox_HelloGLCD.ino ส ําหร ับทดสอบการแสดงผลของแผงวงจร IPST-SE
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

จอแสดงผลของแผงวงจร IPST-SE มี ขนาด 128 x 160 พิ กเซล แสดงตั วอั กษรความละเอี ยด
5 x 7 จุ ด จํ านวน 21 ตั วอั กษร 16 บรรทั ด ผู ใช งานสามารถระบุ ตํ าแหน งบรรทั ดและตํ าแหน งคอลั มน 
ที่ ต องการแสดงผลได  โดยกํ าหนดผ านคํ าสั่ ง glcd ซึ่ งมี อยู ในไฟล ไลบรารี  ipst.h

นอกจากน้ั นคํ าสั่ ง glcd  ยั งมี อั กขระพิ เศษเพื่ อระบุ ตํ าแหน งแทนการใช ค าตั วเลข ดั งแสดงใน
โปรแกรมที่  A1-2

#include <ipst.h> // ผนวกไฟล ไลบรารี หลั ก
int i,j;
void setup()
{

glcdFillScreen(GLCD_WHITE); // กํ าหนดให สี ของพื้ นหลั งของจอแสดงผลเป นสี ขาว
setTextColor(GLCD_BLACK); // กํ าหนดสี ตั วอั กษรเป นสี ดํ า
setTextBackgroundColor(GLCD_WHITE); // กํ าหนดสี พื้ นหลั งของตั วอั กษรเป นสี ขาว
for (i=0;i<16;i++) // วนลู ป 16 รอบเพื่ อแสดงข อความ
{

glcd(i,i,"Row %d ",i); // แสดงข อความที่ จอแสดงผล
}

}
void loop()
{}

โปรแกรมที ่ A1-2 ไฟล  microbox_GLCDmultipleLine.ino ส ําหร ับทดสอบการแสดงผลของแผงวงจร IPST-SE

คํ าอธิ บายโปรแกรม

ในโปรแกรมนี้ เพิ่ มเติ มคํ าสั่ งสํ าหรั บการใช งานจอแสดงผลอี ก 3 คํ าสั่ งคื อ

1. glcdFillScreen เป นคํ าสั่ งกํ าหนดสี พื้ นหลั งของจอแสดงผล

2. setTextColor สํ าหรั บกํ าหนดสี ให แก ตั วอั กษร

3. setTextBackground สํ าหรั บกํ าหนดสี พื้ นหลั งของตั วอั กษร

เมื่ อตั้ งค าของจอแสดงผลแล ว จึ งทํ าการส งข อความ Row ตามด วยหมายเลขบรรทั ดซึ่ งมาจากการ
เพิ ่มค าของต ัวแปร i และม ีการเลื ่อนต ําแหน งตามค าของ i ด วย ด ังนั ้นที ่บรรท ัดแรก ข อความ Row0 ถ ูกแสดง
ที่ คอลั มน  0 ที่ บรรทั ด 2 แสดงข อความ Row 1 ที่ คอลั มน  1 ไล ไปตามลํ าดั บจนถึ งบรรทั ด 15 (บรรทั ดท่ี  16)
จะแสดงเป น Row 15 ท่ี คอลั มน  15
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(A1.2.1) เป ดซอฟต แวร  Arduino IDE 1.7.10 พิ มพ โปรแกรมที่  A1-2 แล วบั นทึ กไฟล 

(A1.2.2) เป ดสวิ ตช จ ายไฟแก แผงวงจร IPST-SE แล ว เชื่ อมต อสาย USB เข ากั บคอมพิ วเตอร 

(A1.2.3) คอมไพล และอ ัปโหลดโปรแกรมไปย ังแผงวงจร IPST-SE โดยคล ิกที ่ปุ ม  หร ือเล ือกที ่เมน ู

File > Upload to Wiring Hardware

ที่ หน าจอแสดงผลกราฟ ก LCD ของแผงวงจร IPST-SE แสดงข อความ Row 0 ถึ ง Row 15
เรี ยงไปบรรทั ดละข อความ
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

ขนาดต ัวอ ักษรปกต ิที ่แสดงบนจอแสดงผลของแผงวงจร IPST-SE เมื ่อเริ ่มต นท ํางานเป นขนาด
เล็ กสุ ด ใช จํ านวนจุ ดต อตั วอั กษรคื อ 6 x 10 จุ ด (อั กษรจริ งมี ขนาด 5 x 7 จุ ด) ถ าต องการปรั บขนาด
ตั วอั กษรให ใหญ ขึ ้น จะมี ค ําสั่ ง setTextSize ไว สํ าหรั บปรั บขนาด โดยค าท่ี กํ าหนดจะเป นจํ านวนเท า
ของตั วอั กษรปกติ  เช น

setTextSize(2) หมายถึ งขนาดตั วอั กษรใหญ ขึ้ นเป น 2 เท า ใช  12 x 20 พิ กเซลต อ 1
ตั วอั กษร

setTextSize(3) หมายถึ งขนาดตั วอั กษรใหญ ขึ้ นเป น 3 เท า ใช  18 x 30 พิ กเซลต อ 1
ตั วอั กษร

เม่ื อปรั บขนาดตั วอั กษรมี ขนาดใหญ ขึ้ น จํ านวนตั วอั กษรต อบรรทั ดก็ ต องลดลง จากเดิ ม 21
ตั วอั กษร 16 บรรทั ด เม่ื อขนาดของตั วอั กษรเพิ่ มขึ้ นเป นสองเท า ก็ จะทํ าให แสดงได  10 ตั วอั กษร 8
บรรทั ดแทน ดั งนั้ นเมื่ อเขี ยนโปรแกรมจะต องคํ านึ งถึ งค าเหล าน้ี ด วย

#include <ipst.h>
int x,m;
void setup()
{

//glcdSetColorWordRGB(); // หากสี ของการแสดงผลผิ ด ให เป ดใช ฟ งก ชั่ นนี้ 
setTextColor(GLCD_RED); // กํ าหนดสี ตั วอั กษรเป นสี แดง

}
void loop()
{

for (x=1;x<6;x++)
{

setTextSize(x); // กํ าหนดขนาดตั วอั กษร
for(m=0;m<4;m++)
{

glcdClear(); // เคลี ยร หน าจอ
glcdMode(m); // กํ าหนดทิ ศทาง
glcd(0,0,"%dX",x); // แสดงขนาดตั วอั กษร
glcd(1,0,"M=%d",m); // แสดงโหมดทิ ศทาง
sleep(500);

}
}

}

โปรแกรมที ่ A1-3 ไฟล  microbox_GLCDtextFlip.ino ส ําหร ับทดสอบการเพิ ่มขนาดต ัวอ ักษรในการแสดงผล
และการเปลี่ ยนทิ ศทางของการแสดงผลของแผงวงจร IPST-SE
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นอกจากขนาดตั วอั กษรแล ว ยั งกํ าหนดทิ ศทางการแสดงผลของจอแสดงผลได  โดยใช คํ าสั่ ง
glcdMode() โดยมี ค าตั้ งต นคื อ โหมด 0 (glcdMode(0)) นั่ นคื อ แสดงผลในแนวตั้ ง สํ าหรั บอี ก 3
โหมดคื อ โหมด 1, 2 และ 3 ใช ปรั บให การแสดงผลหมถนไปโหมดละ 90 องศา นั่ นคื อ โหมด 1 หมุ น
ไป 90 องศา, โหมด 2 หมุ นไป 180 องศา และโหมด 3 หมุ นไป 270 องศา

(A1.3.1) เป ดซอฟต แวร  Aruino IDE 1.7.10 พิ มพ โปรแกรมที่  A1-3 แล วบั นทึ กไฟล 

(A1.3.2) เป ดสวิ ตช จ ายไฟแก แผงวงจร IPST-SE แล ว เชื่ อมต อสาย USB เข ากั บคอมพิ วเตอร 

(A1.3.3) คอมไพล และอ ัปโหลดโปรแกรมไปย ังแผงวงจร IPST-SE โดยคล ิกที ่ปุ ม  หร ือเล ือกที ่เมน ู

File > Upload to Wiring Hardware

ที ่หน าจอแสดงผลของแผงวงจร IPST-SE แสดงข อความแจ งขนาดของต ัวอ ักษรและโหมดการ
แสดงผลในท ิศทางที ่ต างก ัน เริ ่มจากม ุมบนซ าย, ม ุมบนขวา, ม ุมล างขวา และม ุมล างซ าย โดยรอบการ
แสดงผลจะเริ ่มจาก 1X, 2X, 3X , 4X และ 5X แต ละรอบม ีการแสดงผล 4 ท ิศทาง โดยด ูจากค า M

M = 0 จอแสดงข อความแนวตั้ ง    M = 1 หมุ นการแสดงผลไป 90 องศาทางขวา
ตั วอั กษรขนาด 3 เท า    ตั วอั กษรขนาด 4 เท า

   

M = 2 หมุ นการการแสดงผลไป 180 องศา    M = 3 หมุ นการแสดงผลไป 270 องศา
    จะได ภาพที่ กลั บหั วเมื่ อเที ยบกั บ M = 0    ตั วอั กษรขนาด 5 เท า

ตั วอั กษรขนาด 4 เท า
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ฟ งก ชั ่น glcd เป นฟ งก ชั ่นหล ักในการต ิดต อก ับจอแสดงผลกราฟ ก LCD นอกจากม ีค ําสั ่งแสดง
ข อความแล ว ยั งมี คํ าสั่ งในการวาดลายเส นกราฟ กอี กหลายคํ าสั่ ง ประกอบด วย

glcdRect(int x1,int y1,int width,int height,uint color) เป นคํ าสั่ งสร าง
รู ปสี่ เหลี่ ยม

glcdFillRect(int x1,int y1,int width,int height,uint color) เป นค ําสั ่ง
สร างพื ้นสี ่เหลี ่ยม

glcdLine(int x1, int y1, int x2, int y2,uint color) เป นคํ าสั่ งลากเส น

glcdCircle(int x, int y, int radius,uint color) เป นคํ าสั่ งวาดเส นวงกลม

glcdFillCircle(int x, int y, int radius,uint color) เป นคํ าสั่ งสร างพื้ นท่ี 
วงกลม

glcdClear(uint color) เป นการเคลี ยร หน าจอแสดงผล

โดยทดสอบเขี ยนโปรแกรมได ดั งโปรแกรมที่  A1-4 แล วอั ปโหลดเพื่ อทดสอบการทํ างานไปยั ง
แผงวงจร IPST-SE จะได ผลดั งรู ป

ถ าหากสี ของการแสดงผลไม ถู กต อง อาจเกิ ดจากรุ นของจอแสดงผลเนื่ องจากจอภาพแบบนี้ 
มี  2 รุ น มี การเรี ยงข อมู ลที่ สร างสี แตกต างกั นเล็ กน อย ทางแก ไขคื อ นํ าเครื่ องหมาย // ที่ หน าฟ งก ชั่ น
glcdSetColorWordRGB(); ออก เพื่ อเปลี่ ยนรู ปแบบการเรี ยงข อมู ลสี 
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#include <ipst.h> // ผนวกไฟล ไลบรารี หลั ก
int i,j;
void setup()
{

//glcdSetColorWordRGB(); // หากสี ของการแสดงผลผิ ด ให เป ดใช ฟ งก ชั่ นนี้ 
}
void loop()
{

glcdClear; // เคลี ยร หน าจอและพื้ นหลั งเป นสี ดํ า
sleep(300);
for (i=0;i<160;i+=4)
{

glcdLine(0,0,128,i,GLCD_WHITE); // วาดเส นสี ขาวจากพิ กั ด 0,0 ไปยั งจุ ดที่ กํ าหนด
}
for (i=0;i<128;i+=4)
{

glcdLine(0,0,i,160,GLCD_RED); // วาดเส นสี แดงจากพิ กั ด 0,0 ไปยั งจุ ดที่ กํ าหนด
}
delay(2000);
glcdRect(32,40,64,80,GLCD_BLUE); // วาดเส นกรอบสี่ เหลี่ ยมสี นํ้ าเงิ น
delay(300);
glcdFillCircle(32,40,31,GLCD_GREEN); // สร างวงกลมพื้ นสี เขี ยว
glcdFillCircle(96,40,31,GLCD_YELLOW); // สร างวงกลมพื้ นสี เหลื อง
glcdFillCircle(32,120,31,GLCD_MAGENTA); // สร างวงกลมพื้ นสี บานเย็ น
glcdFillCircle(96,120,31,GLCD_SKY); // สร างวงกลมพื้ นสี ฟ า
delay(1000);
glcdCircle(64,40,31,GLCD_GREEN); // วาดเส นรอบวงกลมสี เขี ยว
glcdCircle(32,80,31,GLCD_BLUE); // วาดเส นรอบวงกลมสี นํ้ าเงิ น
glcdCircle(64,120,31,GLCD_YELLOW); // วาดเส นรอบวงกลมสี เหลื อง
glcdCircle(96,80,31,GLCD_SKY); // วาดเส นรอบวงกลมเส นสี ฟ า
delay(1000);
glcdFillRect(0,0,128,160,GLCD_YELLOW); // สร างรู ปส่ี เหลี่ ยมสี เหลื อง
delay(1000);

}

โปรแกรมที ่ A1-4 ไฟล  microbox_GLCDsimpleGraphic.ino ส ําหร ับทดสอบการแสดงผลของแผงวงจร IPST-SE
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

นอกจากวงกลมและสี ่เหลี่ ยมแล ว เส นโค งก ็เป นส วนประกอบสํ าคั ญในการสร างภาพกราฟ ก
ในชุ ดคํ าสั่ งเกี่ ยวกั บการแสดงผลจอภาพแบบกราฟ กสี ของแผงวงจร IPST-SE ยั งมี คํ าสั่ ง glcdArc()
ส ําหร ับสร างเส นโค ง โดยม ีพาราม ิเตอร หร ือต ัวแปรที ่ต องก ําหนดอยู พอสมควร ด ูรายละเอ ียดเพิ ่มเต ิม
ในบทท่ี  6 เกี่ ยวกั บการใช งานจอแสดงผลแบบกราฟ ก LCD สี ตั วน้ี 

(A1.5.1) เป ดซอฟต แวร  Aruino IDE 1.7.10 พิ มพ โปรแกรมที่  A1-5 แล วบั นทึ กไฟล 

(A1.5.2) เป ดสวิ ตช จ ายไฟแก แผงวงจร IPST-SE แล ว เชื่ อมต อสาย USB เข ากั บคอมพิ วเตอร 

#include <ipst.h>
int i;
// ฟ งก ชั่ นสร างรู ปหน ายิ้ ม
void face()
{

glcdFillCircle(64,70,50,GLCD_WHITE);
glcdArc(48,60,16,30,150,GLCD_RED);
glcdCircle(48,55,5,GLCD_BLUE);
glcdCircle(80,55,5,GLCD_BLUE);
glcdArc(80,60,16,30,150,GLCD_RED);
glcdFillCircle(64,70,7,GLCD_YELLOW);
glcdArc(64,80,30,220,320,GLCD_RED);
glcdArc(64,80,29,220,320,GLCD_RED);

}
void setup()
{

//glcdSetColorWordRGB();      // หากสี ของการแสดงผลผิ ด ให เป ดใช ฟ งก ชั่ นนี้ 
}
void loop()
{

for(i=0;i<4;i++)
{

glcdClear();
glcdMode(i); // ส่ั งหมุ นการแสดงผล
face();
sleep(1000);

}
}

โปรแกรมที ่ A1-5 ไฟล  microbbox_GLCDarcTest.ino ส ําหร ับทดสอบการวาดเส นโค งของแผงวงจร IPST-SE
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(A1.5.3) คอมไพล และอ ัปโหลดโปรแกรมไปย ังแผงวงจร IPST-SE โดยคล ิกที ่ปุ ม  หร ือเล ือกที ่เมน ู

File > Upload to Wiring Hardware

(A1.5.4) รั นโปรแกรม ดู ผลการทํ างานที่ จอแสดงผลของแผงวงจร IPST-SE

ที่ จอแสดงผลแสดงเป นรู ปการ ตู นหน ายิ้ มนาน 1 วิ นาที  แล วหมุ นไปครั้ งละ 90 องศา แล ววน
กลั บมาท่ี หน าเริ่ มต น จะวนแสดงผลไปตลอดเวลา
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

ในระบบควบค ุมพื ้นฐานจะต องม ีการปร ับตั ้งค า ม ีเมน ู ม ีสว ิตช ในการสั ่งงานต างๆ บนแผงวงจร
IPST-SE ก็ มี ส วนติ ดตต อกั บผู ใช งานด วยเช นกั น ประกอบด วยปุ ม KNOB สํ าหรั บปรั บเลื อกรายการ
และสวิ ตช  OK กั บ SW1 สํ าหรั บยื นยั นการเข าสู รายการทางเลื อกน้ั นๆ
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




เขี ยนโปรแกรมที่  A2-1 แล วบั นทึ กไฟล ชื่ อ microbox_KnobSwitchTest.ino ทํ าการคอมไพล 
และอั ปโหลดไปยั งแผงวงจร IPST-SE แล วรั นโปรแกรมทดสอบการทํ างาน

เมื่ อโปรแกรมเริ่ มทํ างาน ที่ หน าจอแสดงผลของแผงวงจร IPST-SE แสดงข อความ

Press OK (ขนาดตั วอั กษรใหญ ขนาด 2x)

ให กดสว ิตช  OK เพื ่อทํ างานต อ

หน าจอแสดงรู ปวงกลมสี เหลื อง 1 วิ นาที  จากน้ั นแสดงข อความ

Knob value (ขนาดตั วอั กษรใหญ ขนาด 2x)

  XXXX (ขนาดตั วอั กษรใหญ ขึ้ นเป นขนาด 3x)

โดยที่  xxxx มี ค าได ตั้ งแต  94 ถึ ง 1023

ทดลองปรั บปุ ม KNOB บนแผงวงจร IPST-SE

ค าของ Knob ที่ จอแสดงผลจะต องเปลี่ ยนแปลงตามการปรั บที่ ปุ ม KNOB

จากน้ั นกดสวิ ตช  OK แล วปล อย

 หน าจอแสดงร ูปวงกลมส ีเข ียว 1 ว ินาท ี แล วกล ับไปแสดงข อความและค าของ KNOB
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#include <ipst.h> // ผนวกไฟล ไลบรารี หลั ก
void setup()
{

//glcdSetColorWordRGB(); // หากสี ของการแสดงผลผิ ด ให ใช ฟ งก ชั่ นนี้ 
glcdClear(); // เคลี ยร หน าจอแสดงผล กํ าหนดพื้ นหลั งเป นสี ดํ า
setTextSize(2); // เลื อกขนาดตั วอั กษรใหญ เป น 2 เท าจากขนาดปกติ 
glcd(1,1,"Press OK"); // แสดงข อความออกหน าจอแสดงผล
sw_OK_press(); // วนรอจนกระทั่ งกดสวิ ตช  OK
glcdClear(); // เคลี ยร หน าจอแสดงผล กํ าหนดพื้ นหลั งเป นสี ดํ า
glcdFillCircle(64,70,50,GLCD_YELLOW); // วาดวงกลมสี เหลื อง
delay(1000);                // แสดงผลวงกลมสี เหลื อง 1 วิ นาที 
glcdClear(); // เคลี ยร หน าจอแสดงผล กํ าหนดพื้ นหลั งเป นสี ดํ า

}
void loop()
{

if (sw_OK()) // ตรวจสอบการกดสวิ ตช  OK
{

glcdClear(); // เคลี ยร หน าจอแสดงผล กํ าหนดพื้ นหลั งเป นสี ดํ า
glcdFillCircle(64,70,50,GLCD_GREEN); // วาดวงกลมสี เขี ยว
delay(1000); // แสดงผลวงกลมสี เขี ยว 1 วิ นาที 
glcdClear(); // เคลี ยร หน าจอแสดงผล กํ าหนดพื้ นหลั งเป นสี ดํ า

}
if(sw1()) // ตรวจสอบสวิ ตช  SW1 ว ามี การกดหรื อไม 
{

glcdClear(); // เคลี ยร หน าจอแสดงผล กํ าหนดพื้ นหลั งเป นสี ดํ า
glcdFillCircle(64,70,50,GLCD_RED); // วาดวงกลมสี แดง
delay(1000); // แสดงผลวงกลมสี แดง 1 วิ นาที 
glcdClear(); // เคลี ยร หน าจอแสดงผล กํ าหนดพื้ นหลั งเป นสี ดํ า

}
glcd(1,0,"Knob value"); // แสดงข อความที่ จอแสดงผล
setTextSize(3); // เลื อกขนาดตั วอั กษรใหญ เป น 3 เท าจากขนาดปกติ 
glcd(2,2,"%d   ",knob()); // แสดงค าที่ อ านได จากการปรั บปุ ม KNOB ที่ หน าจอแสดงผล
setTextSize(2); // เลื อกขนาดตั วอั กษรใหญ เป น 2 เท าจากขนาดปกติ 

}

โปรแกรมที่  A2-1 ไฟล  microbox_KnobSwitchTest.ino สํ าหรั บทดสอบอ านค าจากปุ ม KNOB, สวิ ตช  OK
และ SW1

ทดลองกดสวิ ตช  SW1 แล วปล อย

หน าจอแสดงรู ปวงกลมสี แดง 1 วิ นาที  แล วกลั บไปแสดงข อความและค าของ KNOB
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

ในไฟล ไลบรารี  ipst.h มี คํ าสั่ ง out(int num,int _dat) ซึ่ งช วยให สามารถส งลอจิ ก
“0” หร ือ “1” ออกไปย ังขาพอร ตที ่ต องการได  ท ําให น ําแผงวงจร IPST-SE ไปใช ข ับอ ุปกรณ เอาต พ ุตพื ้น
ฐานได ง ายขึ้ น ยกตั วอย างง ายท่ี สุ ดคื อ ไดโอดเปล งแสงหรื อ LED

ในกิ จกรรมนี้ จึ งนํ าแผงวงจร ZX-LED อั นเป นแผงวงจร LED แสดงผลแบบเดี่ ยวที่ จะติ ดสว าง
เมื่ อได รั บลอจิ ก “1” และดั บลงเมื่ อได รั บลอจิ ก “0” มาต อกั บแผงวงจร IPST-SE เพื่ อทดลองใช งาน

(A3.1) นํ า ZX-LED ชุ ดที่  1 ต อเข ากั บจุ ดต อพอร ต 17 และชุ ดที่  2 ต อกั บจุ ดต อพอร ต 18
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#include <ipst.h> // ผนวกไฟล ไลบรารี หลั ก
void setup()
{

setTextSize(2); // เลื อกขนาดตั วอั กษรใหญ เป น 2 เท าจากขนาดปกติ 
glcd(1,1,"Press OK"); // แสดงข อความออกหน าจอ GLCD
sw_ok_press(); // วนรอการกดสวิ ตช  OK

}
void loop()
{

out(17,1); // ทํ าให  LED ที่ ต ออยู กั บพอร ต 17 ติ ดสว าง
out(18,0); // ทํ าให  LED ที่ ต ออยู กั บพอร ต 18 ดั บ
sleep(400);
out(17,0); // ทํ าให  LED ที่ ต ออยู กั บพอร ต 17 ดั บ
out(18,1); // ทํ าให  LED ที่ ต ออยู กั บพอร ต 18 ติ ดสว าง
delay(400);

}

โปรแกรมที ่ A3-1 ไฟล  microbox_LEDtest.ino ส ําหร ับทดสอบการข ับอ ุปกรณ เอาต พ ุตอย างง าย

(A3..2) เขี ยนโปรแกรมที่  A3-1 บั นทึ กไฟล ชื่ อ microbox_LEDtest.ino

(A3.3) เป ดสว ิตช จ ายไฟแก แผงวงจร IPST-SE จากนั ้นท ําการคอมไพล และอ ัปโหลดโปรแกรมไปย ังแผง
วงจร IPST-SE

(A3.4) รั นโปรแกรม สั งเกตการทํ างานของ ZX-LED

เมื่ อรั นโปรแกรม  ที่ หน าจอแสดงผลของแผงวงจร IPST-SE แสดงข อความ

Press OK

ให กดสวิ ตช  OK เพื่ อเริ่ มการทํ างาน จะเห็ น LED บนแผงวงจร ZX-LED ทั้ งสองชุ ดติ ดและ
ดั บสลั บกั นไปอย างต อเนื่ อง
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  

ในช ุดกล องสมองกล IPST-MicfoBOX (SE) ม ีแผงวงจรข ับเส ียงโดยใช ล ําโพง
เป ยโซ (ZX-SPEAKER) โดยตั วลํ าโพงเป ยโซขนาดเล็ กนี้ ตอบสนองความถี่ เสี ยงใน
ช วงความถี่ ประมาณ 300 ถึ ง 3,000Hz ในการเขี ยนโปรแกรมเพื่ อสั่ งงานแผงวงจร
IPST-SE ให ขั บเสี ยงออกทางแผงวงจร ZX-SPEAKER นี้ ทํ าได โดยใช คํ าสั่ ง beep()
และ sound()

ในโปรแกรมที่  A4-1 เป นตั วอย างการใช คํ าสั่ ง beep() เพื่ อขั บเสี ยง “ติ้ ด” ความถี่ เดี ยวออก
ทางลํ าโพงทุ กๆ 1 วิ นาที 

ส วนในโปรแกรมที่  A4-2 เป นตั วอย างการใช คํ าสั่ ง sound() เพื่ อขั บเสี ยงที่ มี ความถี่ ตามที่ 
กํ าหนดออกทางลํ าโพงเป ยโซ ตามเวลาท่ี กํ าหนดในโปรแกรม

(A4.1) นํ าแผงวงจรขั บเสี ยง ZX-SPEAKER ต อเข ากั บจุ ดต อพอร ต 19  ของแผงวงจร IPST-SE
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#include <ipst.h> // ผนวกไฟล ไลบรารี หลั ก
void setup()
{}
void loop()
{

sound(19,500,500); // ขั บเสี ยงความถี่  500Hz นาน 0.5 วิ นาที  ออกลํ าโพงผ านทางจุ ดต อพอร ต 19
sound(19,2500,500); // ขั บเสี ยงความถี่  2500Hz นาน 0.5 วิ นาที  ออกลํ าโพงผ านทางจุ ดต อพอร ต 19

}

โปรแกรมที ่ A4-2 ไฟล  microbox_SoundTest.ino ส ําหร ับทดสอบการข ับเส ียงออกล ําโพงของแผงวงจร IPST-
SE แบบก ําหนดความถี ่และเวลาได 

(A4..2) เข ียนโปรแกรมที ่ A4-1 บ ันทึ กไฟล ชื ่อ microbox_BeepTest.pde

(A4.3) เป ดสว ิตช จ ายไฟแก แผงวงจร IPST-SE จากนั ้นท ําการคอมไพล และอ ัปโหลดโปรแกรมไปย ังแผง
วงจร IPST-SE

(A4.4) ร ันโปรแกรม

จะได ยิ นเสี ยง “ติ้ ด” ดั งเป นจั งหวะในทุ กๆ 1 วิ นาที จากลํ าโพงของแผงวงจร ZX-SPEAKER

(A4.5) เขี ยนโปรแกรมที่  A4-2 บั นทึ กไฟล ชื่ อ microbox_SoundTest.ino แล วอั ปโหลดโปรแกรมไป
ยั งแผงวงจร IPST-SE เพื่ อทดสอบการทํ างานอี กครั้ ง

จะได ยิ นสั ญญาณเสี ยง 2 ความถี่ ดั งสลั บกั นออกจากลํ าโพงของแผงวงจร ZX-SPEAKER

#include <ipst.h> // ผนวกไฟล ไลบรารี หลั ก
void setup()
{}
void loop()
{
    beep(19); // ขั บเสี ยง “ติ้ ด” ออกลํ าโพงผ านทางจุ ดต อพอร ต 19
    delay(1000);
}

โปรแกรมที ่ A4-1 ไฟล  microbox_BeepTest.ino ส ําหร ับทดสอบข ับเส ียงออกล ําโพงของแผงวงจร IPST-SE
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การพ ัฒนาโปรแกรมภาษา C/C++  ส ําหร ับช ุดกล องสมองกล IPST-MicroBOX (SE) ด ําเน ินการ
ภายใต การสนั บสนุ นของไฟล ไลบรารี  ipst.h ทั้ งนี้ เพื่ อช วยลดขั้ นตอนและความซั บซ อนในการเขี ยน
โปรแกรมเพื่ อควบคุ มส วนต างๆ ของฮาร ดแวร ลง โครงสร างของไฟล ไลบรารี  ipst.h แสดงดั งรู ป









 











































































T
B
6
6
1
2
F
N
G

M

M





















 










72   Arduino IDE

5.1 ไฟล ไลบรารี  ipst.h

ในการเรี ยกใช งานชุ ดคํ าสั ่งย อยต างๆ เพื่ อการพั ฒนาโปรแกรมควบคุ มสํ าหรั บชุ ดกล องสมอง
กล IPST-MicroBOX (SE) ผู พ ัฒนาต องผนวกไฟล ไลบราร ีหล ัก ipst.h ไว ในตอนต นของโปรแกรมด วย
คํ าสั่ ง

#include <ipst.h>

เพื ่อประกาศให ให ต ัวแปลภาษา C หร ือคอมไพเลอร รู จ ักช ุดค ําสั ่งย อยที ่ก ําล ังจะถ ูกเร ียกใช งาน
จากไฟล ไลบรารี  ipst.h

ไลบรารี ย อยของไฟล ไลบรารี  ipst.h ประกอบด วย

 ipst_glcd.h  บรรจุ ฟ งก ชั่ นและคํ าสั่ งสํ าหรั บแสดงผลข อความ, ตั วเลข และสร าง
ภาพกราฟ กส ีที ่จอแสดงผลแบบกราฟ ก LCD ส ีบนแผงวงจร IPST-SE (ย ังไม รองร ับการท ํางานก ับไฟล 
รู ปภาพ) ฟ งก ชั่ นนี้ มี การกํ าหนดขาใช งานที่ เฉพาะเจาะจง  (มี รายละเอี ยดอธิ บายในบทที่  6)

 ipst_sleep.h บรรจุ ฟ งก ชั่ นและคํ าสั่ งสํ าหรั บการหน วงเวลา

 ipst_in_out.h บรรจ ุฟ งก ชั ่นและค ําสั ่งส ําหร ับอ านค าอ ินพ ุตด ิจ ิตอลและส งค าออกทาง
ขาพอร ตเอาต พุ ตดิ จิ ตอล

 ipst_analog.h บรรจุ ฟ งก ชั่ นและคํ าสั่ งอ านค าจากอิ นพุ ตอะนาลอกช อง A0 ถึ ง A6
ที่ ต อกั บตั วตรวจจั บและปุ ม KNOB กั บสวิ ตช  OK

 ipst_sound.h บรรจุ ฟ งก ชั่ นและคํ าสั่ งสํ าหรั บสร างเสี ยงเพื่ อขั บออกลํ าโพง

 ipst_motor.h บรรจ ุฟ งก ชั ่นและค ําสั ่งส ําหร ับข ับมอเตอร ไฟตรง 2 ช อง ต องท ํางานร วม
กั บวงจรขั บมอเตอร ที่ ใช ไอซี  TB6612 และใช ไฟเลี้ ยงอี กส วนหนึ่ งสํ าหรั บเลี้ ยงมอเตอร ไฟตรง

 ipst_servoMotor.h บรรจ ุฟ งก ชั ่นและค ําสั ่งส ําหร ับข ับเซอร โวมอเตอร  ต องท ํางานร วม
กั บเซอร โวมอเตอร  และต องใช ไฟเลี้ ยง +6V อี กส วนหนึ่ งสํ าหรั บเซอร โวมอเตอร  ฟ งก ชั่ นนี้ มี การ
กํ าหนดขาใช งานที่ เฉพาะเจาะจง

 ipst_serial.h บรรจ ุฟ งก ชั ่นและค ําสั ่งส ําหร ับสื ่อสารข อม ูลอน ุกรมผ านทางพอร ต USB
และผ านทางจุ ดต อพอร ต TxD1 และ RxD1 ของแผงวงจร IPST-SE

 ipst_led8.h บรรจ ุฟ งก ชั ่นและค ําสั ่งส ําหร ับแสดงผล LED 8 ดวงบนแผงวงจร ZX-LED8
โดยสั่ งให  LED ติ ดที ละดวง หรื อหลายดวงก็ ได 
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5.2 ไฟล ไลบรารี ของ Arduino 1.x

Arduino1.x ม ีไลบราร ีจ ํานวนมาก เพื ่อช วยให การเข ียนโปรแกรมเพื ่อต ิดต อและใช งานอ ุปกรณ 
ฟ งก ชั่ นพิ เศษ ตลอดจนตั วตรวจจั บแบบต างๆ ทํ าได สะดวกและง ายขึ้ น สรุ ปได ดั งนี้ 

1 .  EEPROM.h ไลบรารี สํ าหรั บการจั ดการหน วยความจํ าข อมู ลอี อี พรอมภายใน
ไมโครคอนโทรลเลอร  ATmega644P ที่ ใช ในแผงวงจร IPST-SE

2. LiquidCrystal.h ไลบรารี ติ ดต อกั บโมดู ล LCD แบบตั วอั กษร

3. Encoder.h ไลบราร ีส ําหร ับการใช งานวงจรเข ารห ัสขั ้นพื ้นฐาน (ต องการอ ุปกรณ เฉพาะ)

4. Wire.h ไลบรารี สํ าหรั บติ ดต อกั บอุ ปกรณ ระบบบั ส 2 สายและบั ส I2C

5. SoftwareSerial.h ไลบราร ีส ําหร ับสื ่อสารข อม ูลอน ุกรมก ับอ ุปกรณ ภายนอกผ านทาง
ขาพอร ตดิ จิ ตอลปกติ 

6. OneWire.h ไลบรารี สํ าหรั บติ ดต อกั บอุ ปกรณ บั สหนึ่ งสาย (เป นไลบรารี เสริ ม)

ในการเรี ยนรู เพื่ อใช งานแผงวงจร IPST-SE ในชุ ดกล องสมองกล IPST-MicroBOX (SE)
จะใช ไฟล ไลบรารี ทั้ งแบบมาตรฐานที่ มากั บซอฟต แวร  Arduino1.x และไฟล ไลบรารี  ipst.h ร วมกั น
เพื ่อช วยให การพ ัฒนาโปรแกรมส ําหร ับการใช งานม ีประส ิทธ ิภาพส ูงส ุด และท ําความเข าใจได ง าย ทั ้ง
นี้ เพื่ อประโยชน ในการต อยอดการเรี ยนรู ของผู ใช งานในวงกว าง

5.3 การเรี ยกใช ไลบรารี  ipst.h และไลบรารี ย อย
ไฟล ไลบราร ี ipst.h ประกอบด วยไลบราร ีหลายไฟล  การเร ียกใช งานท ําได  2 ว ิธ ีค ือ

1. เร ียกใช ทั ้งหมดผ านทาง #include <ipst.h> ว ิธ ีนี ้ง าย สะดวก และลดโอกาสที ่ผู เข ียน
โปรแกรมจะลื มผนวกไฟล ไลบรารี ที่ ต องใช งาน

2. เร ียกใช เฉพาะไลบราร ีที ่ต องการ ด วยค ําสั ่ง #include <ipst_xxxx.h> ต ัวอ ักษร xxxx
คื อชื่ อใดๆ ของไฟล ไลบรารี ภายในไฟล  ipst.h ดู ได จากหั วข อ 5.1 ในบทนี้  วิ ธี นี้ มี ข อดี คื อ ลดขนาด
ของไฟล โปรแกรมภาษา C/C++ ลง  เนื่ องจากมี การเรี ยกใช งานฟ งก ชั่ นหรื อชุ ดคํ าสั่ งเท าที่ จํ าเป น

ในห ัวข อต อไปนี ้เป นการอธ ิบายถ ึงข อม ูลที ่ผู พ ัฒนาโปรแกรมส ําหร ับช ุดกล องสมองกล IPST-
MicroBOX (SE) ควรทราบเกี่ ยวกั บฟ งก ชั่ นสํ าคั ญที่ อยู ในไฟล ไลบรารี ย อยของไลบรารี หลั ก ipst.h
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5.4 ipst_sleep.h ไฟล ไลบรารี ย อยการหน วงเวลา
เป นไฟล ไลบราร ีบรรจ ุช ุดค ําสั ่งเกี ่ยวก ับการหน วงเวลา ก อนเร ียกใช งานควรผนวกไฟล ไลบราร ี

ไว ในตอนต นของโปรแกรมด วยค ําสั ่ง

#include <ipst_sleep.h> หรื อเรี ยก #include <ipst.h>

5.4.1 sleep และ delay

sleep และ delay เป นฟ งก ชั ่นหน วงเวลาโดยประมาณในหน วยม ิลล ิว ินาท ี ม ีรายละเอ ียดด ังนี ้

รู ปแบบ
void sleep(unsigned int ms)

void delay(unsigned int ms)

พารามิ เตอร 

ms - กํ าหนดค าเวลาที่ ต องการหน วงในหน วยมิ ลลิ วิ นาที  มี ค า 0 ถึ ง 65,535

ตั วอย างที่  5-1
sleep(20); // หน วงเวลาประมาณ 20 มิ ลลิ วิ นาที 
delay(1000); // หน วงเวลาประมาณ 1 วิ นาที 

5.4.2 delay_us
เป นฟ งก ชั่ นหน วงเวลาโดยประมาณภายในโปรแกรมในหน วยไมโครวิ นาที 

รู ปแบบ

void delay_us(unsigned int us)

พารามิ เตอร 

us - กํ าหนดค าเวลาที่ ต องการหน วงในหน วยไมโครวิ นาที  มี ค า 0 ถึ ง 65,535

ตั วอย างที่  5-2
delay_us(100); // หน วงเวลาประมาณ 100 ไมโครวิ นาที 
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5.5 ipst_sound.h ไฟล ไลบรารี สร างส ัญญาณเส ียง

เป นไฟล ไลบรารี บรรจุ ชุ ดคํ าสั่ งเพื่ อสร างและขั บสั ญญาณเสี ยงไปยั งลํ าโพงหรื อแผงวงจร
ลํ าโพงเป ยโซ ก อนเรี ยกใช งานควรผนวกไฟล ไลบรารี ไว ในตอนต นของโปรแกรมด วยคํ าสั่ ง

#include <ipst_sound.h> หรื อเรี ยก #include <ipst.h>

5.5.1 beep
เป นฟ งก ชั่ นกํ าเนิ ดเสี ยง “ติ๊ ด” มี ความถี่  500Hz นาน 100 มิ ลลิ วิ นาที  เพื่ อขั บออกลํ าโพงเป ย

โซ ต องต อวงจรขั บลํ าโพงเป ยโซหรื อแผงวงจร ZX-SPEAKER เข าที่ จุ ดต อพอร ตใดๆ ของแผงวงจร
IPST-SE

รู ปแบบ

void beep(int pin)

พาราม ิเตอร 

pin - ขาพอร ตใดๆ ของแผงวงจร IPST-SE ม ีค า 0 ถ ึง 30 (แนะน ําให ใช จ ุดต อพอร ต 19 หร ือ 20)

ตั วอย างที่  5-3
beep(19); // กํ าเนิ ดเสี ยงความถี่  500Hz นาน 100 มิ ลลิ วิ นาที ออกทางจุ ดต อพอร ต 19

5.5.2 sound
เป นฟ งก ชั่ นกํ าเนิ ดสั ญญาณเสี ยงที่ กํ าหนดความถี่ , ระยะเวลาในการกํ าเนิ ดสั ญญาณ และจุ ด

ต อพอร ตที่ เลื อกใช งานได 

รู ปแบบ

void sound(int pin, int freq, int time)

พาราม ิเตอร 

pin - ขาพอร ตใดๆ ของแผงวงจร IPST-SE ม ีค า 0 ถ ึง 30 (แนะน ําให ใช จ ุดต อพอร ต 19 หร ือ 20)

freq - กํ าหนดความถี่ สั ญญาณเสี ยง มี ค า 0 ถึ ง 32,767

time - กํ าหนดค าเวลาในการกํ าเนิ ดสั ญญาณเสี ยงในหน วย 1 มิ ลลิ วิ นาที  มี ค า 0 ถึ ง 32,767

ตั วอย างที่  5-4
sound(19,1200,500); // กํ าเนิ ดสั ญญาณเสี ยงออกทางจุ ดต อพอร ต 19

// ด วยความถี่  1200Hz นาน 500 มิ ลลิ วิ นาที 
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5.6 ipst_in_out.h ไฟล ไลบรารี ย อยสํ าหรั บติ ดต อพอร ต

เป นไลบรารี ที่ มี คํ าสั่ งเกี่ ยวกั บการอ านและเขี ยนค ากั บพอร ตของแผงวงจร IPST-SE ใน
ช ุดกล องสมองกล IPST-MicroBOX (SE)  ก อนเร ียกใช งานฟ งก ชั ่นต องผนวกไฟล ไลบราร ีนี ้ไว ในตอน
ต นของโปรแกรมด วยคํ าสั่ ง

#include <ipst_in_out.h> หรื อเรี ยก #inclue <atx.h>

ฟ งก ชั่ นที่ สํ าคั ญของไฟล ไลบรารี นี้ ประกอบด วย

5.6.1 in
เป นฟ งก ชั่ นอ านค าสถานะลอจิ กของพอร ตที่ กํ าหนด

รู ปแบบ

char in(x)

พาราม ิเตอร 

x - กํ าหนดขาพอร ตที่ ต องการอ านค า มี ค าตั้ งแต  0 ถึ ง 50  สํ าหรั บ IPST-SE ใช ได ถึ ง 30

หมายเหตุ  : ไม แนะนํ าให ใช ฟ งก ชั่ นนี้ กั บจุ ดต อ 19 และ 20 บนแผงวงจร IPST-SE

การคื นค า

เป น 0 หรื อ 1

ตั วอย างที่  5-5
char x; // ประกาศตั วแปร x เพื่ อเก็ บค าผลลั พธ จาการอ านค าระดั บสั ญญาณ
x = in(16); // อ านค าดิ จิ ตอลจากพอร ตหมายเลข 16 แล วเก็ บค าไว ที่ ตั วแปร x

5.6.2 out
เป นฟ งก ชั่ นกํ าหนดระดั บสั ญญาณหรื อข อมู ลดิ จิ ตอลไปยั งขาพอร ตที่ กํ าหนด
รู ปแบบ

out(char _bit,char _dat)
พารามิ เตอร 

_bit - กํ าหนดขาพอร ตที่ ต องการ มี ค า 0 ถึ ง 50 สํ าหรั บ IPST-SE ใช ได ถึ ง 30

_dat - กํ าหนดข อมู ลที่ ต องการส งออก  มี ค าเป น 0 หรื อ 1

ตั วอย างที่  5-6
out(17,1); // กํ าหนดให ขาพอร ต 17 เป น “1”

out(18,0); // กํ าหนดให ขาพอร ต 18 เป น “0”
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5.5.3 sw1_press
เป นฟ งก ชั่ นวนตรวจสอบการกดสวิ ตช  SW1 บนแผงวงจร IPST-SE ต องรอจนกระทั่ ง SW1

ถู กปล อยหลั งจากมี การกดสวิ ตช  จึ งจะผ านพ นการทํ างานของฟ งก ชั่ นนี้ ไป

รู ปแบบ

void sw1_press()

ตั วอย างที่  5-7
............

sw1_press(); // รอจนกระทั่ งสวิ ตช  SW1 ถู กกดและปล อย

................

5.5.4 sw1
เป นฟ งก ชั่ นตรวจสอบการกดสวิ ตช  SW1 ในขณะใดๆ

รู ปแบบ

char sw1()

การค ืนค า

เป น “0” เมื่ อสวิ ตช  SW1 ถู กกด และ เป น “1” เมื่ อไม มี การกดสวิ ตช  SW1

ตั วอย างที่  5-8
char x; // ประกาศตั วแปร x เพื่ อเก็ บค าผลลั พธ จากการอ านค าดิ จิ ตอล
x = sw1(); // อ านค าสถานะของสวิ ตช  SW1 มาเก็ บไว ที่ ตั วแปร x


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5.6 ipst_analog.h ไฟล ไลบรารี จั ดการสั ญญาณอะนาลอก

เป นไฟล ไลบรารี ที่ บรรจุ ชุ ดคํ าสั่ งที่ เกี่ ยวกั บการอ านค าอิ นพุ ตอะนาลอก (A0 ถึ ง A6 และปุ ม
KNOB) ของแผงวงจร IPST-SE ซึ ่งใช ในการเชื ่อมต อก ับต ัวตรวจจ ับที ่ให ผลการท ํางานในร ูปแรงด ันไฟฟ า
ในย าน 0 ถ ึง +5V ก อนเร ียกใช งานต องผนวกไฟล ไลบราร ีไว ในตอนต นของโปรแกรมด วยค ําสั ่ง

#include <ipst_analog.h> หรื อ #inclue <ipst.h>




5.6.1 analog
เป นฟ งก ชั ่นอ านค าจากการแปลงส ัญญาณอะนาลอกของแผงวงจร IPST-SE ที ่จ ุดต อ A0 ถ ึง A6

รู ปแบบ

unsigned int analog(unsigned char channel)

พาราม ิเตอร 

channel - กํ าหนดช องอิ นพุ ตที่ ต องการ มี ค า 0 ถึ ง 6 ซึ่ งตรงกั บขาพอร ต A0 ถึ ง A6

การคื นค า

เป นข อม ูลที ่ได จากการแปลงส ัญญาณไฟฟ า 0 ถ ึง +5V จากช องอ ินพ ุตที ่ก ําหนด ม ีค า 0 ถ ึง 1,023
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ตั วอย างที่  5-9
#include <ipst.h> // ผนวกไฟล ไลบรารี หลั ก
int val=0; // กํ าหนดตั วแปรสํ าหรั บเก็ บค าที่ ได จากการแปลงสั ญญาณแล ว
void setup()
{

glcdClear();
setTextSize(2); // เลื อกขนาดตั วอั กษรใหญ เป น 2 เท าจากขนาดปกติ 

}
void loop()
{

glcd(1,0,"AnalogTest"); // แสดงข อความที่ จอแสดงผล
val  = analog(2);     // อ านค าของสั ญญาณช อง A2 มาเก็ บไว ที่ ตั วแปร val
setTextSize(3); // เลื อกขนาดตั วอั กษรใหญ เป น 3 เท าจากขนาดปกติ 
glcd(2,2,"%d   ",val); // แสดงค าที่ อ านได จากจุ ดต อ A2 ที่ หน าจอแสดงผล
setTextSize(2); // เลื อกขนาดตั วอั กษรใหญ เป น 2 เท าจากขนาดปกติ 

}
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5.6.2 knob( )
เป นฟ งก ชั่ นอ านค าข อมู ลที่ ได จากการแปลงสั ญญาณไฟฟ าที่ ขาพอร ต A7 ซึ่ งต อกั บตั วต าน

ทานปรั บค าได ที่ ตํ าแหน ง KNOB

รู ปแบบ
unsigned int knob()

การค ืนค า

เป นข อม ูลที ่ได จากการแปลงส ัญญาณไฟฟ าที ่มาจากการปร ับค าที ่ปุ ม KNOB บนแผงวงจร IPST-
SE มี ค า 95 ถึ ง 1,023

ตั วอย างที่  5-10
#include <ipst.h> // ผนวกไฟล ไลบรารี หลั ก
void setup()
{

glcdClear();
setTextSize(2); // เลื อกขนาดตั วอั กษรใหญ เป น 2 เท าจากขนาดปกติ 

}
void loop()
{

glcd(1,0," KnobTest"); // แสดงข อความที่ จอแสดงผล
setTextSize(3); // เลื อกขนาดตั วอั กษรใหญ เป น 3 เท าจากขนาดปกติ 
glcd(2,2,"%d   ",knob()); // แสดงค าที่ อ านได จากปุ ม KNOB ที่ จอแสดงผล
setTextSize(2); // เลื อกขนาดตั วอั กษรใหญ เป น 2 เท าจากขนาดปกติ 

}
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5.6.3 sw_OK()
เป นฟ งก ชั ่นตรวจสอบสถานะสว ิตช  OK บนแผงวงจร IPST-SE โดยให สถานะ “เป นจร ิง” เมื ่อ

มี การกดสวิ ตช และ “เป นเท็ จ” เมื่ อไม มี การกดสวิ ตช 

รู ปแบบ
unsigned char sw_ok()

การค ืนค า

1 (เป นจริ ง) เมื่ อมี การกดสวิ ตช 0 (เป นเท็ จ) เมื่ อไม มี การกดสวิ ตช 

หมายเหตุ  การกดสวิ ตช  OK มี ผลทํ าให ค าที่ อ านได จาก knob() เป น 0 ด วย

ตั วอย างที่  5-11
#include <ipst.h> // ผนวกไฟล ไลบรารี หลั ก
void setup()
{

glcdClear();
}
void loop()
{

if (sw_OK()) // ตรวจสอบการกดสวิ ตช  OK
{

glcdFillScreen(GLCD_YELLOW); // เปล่ี ยนสี พื้ นเป นสี เหลื อง
delay(3000); // แสดงสี พื้ นใหม นาน 3 วิ นาที 

}
glcdClear(); // เคลี ยร หน าจอแสดงผล กํ าหนดพื้ นหลั งเป นสี ดํ า

}

5.6.4 sw_OK_press()
เป นฟ งก ชั่ นวนตรวจสอบการกดสวิ ตช  OK บนแผงวงจร IPST-SE ต องรอจนกระทั่ งสวิ ตช ถู ก

ปล อยหลั งจากการกดสวิ ตช จึ งจะผ านฟ งก ชั่ นนี้ ไปกระทํ าคํ าสั่ งอื่ นๆ

ตั วอย างที่  5-12
............
sw_OK_press(); // รอจนกระทั่ งเกิ ดกดสวิ ตช  OK
.............
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5.7 ipst_led8.h ไฟล ไลบรารี ขั บ LED 8 ดวง

เป นไฟล ไลบราร ีบรรจ ุช ุดค ําสั ่งที ่เกี ่ยวก ับการติ ดต อกั บแผงวงจร ZX-LED8 เพื่ อขั บ LED 8 ดวง
ให แสดงผลตามต องการ ก อนเร ียกใช งานต องผนวกไฟล ไลบราร ีไว ในตอนต นของโปรแกรมด วยค ําสั ่ง

#include <ipst_led8.h> หรื อ #inclue <ipst.h>

5.7.1 การเชื่ อมต อทางฮาร ดแวร 
ไฟล ไลบรารี นี้ ใช งานกั บจุ ดต อพอร ตดิ จิ ตอลทั้ งหมดของแผงวงจร IPST-SE โดยใช เพี ยง 1

จุ ดต อพอร ตในการติ ดต อกั บแผงวงจร ZX-LED8 ดั งในรู ปที่  5-1
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















รู ปที่  5-1 การเชื่ อมต อเพื่ อใช งานแผงวงจร ZX-LED8 ของแผงวงจร IPST-SE เพื่ อขั บ LED 8 ดวง
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5.7.2 pinLED8
เป นฟ งก ชั ่นกํ าหนดจุ ดต อพอร ตของแผงวงจร IPST-SE ที่ ต องการเชื่ อมต อกั บแผงวงจร ZX-

LED8

รู ปแบบ

void pinLED8(int pin)

พารามิ เตอร 

pin - ขาพอร ตใดๆ ของแผงวงจร IPST-SE มี ค า 0 ถึ ง 30 (แนะนํ าให ใช จุ ดต อพอร ต 16 ถึ ง 20)

ตั วอย างที่  5-13
pinLED8(20); // เล ือกจุ ดต อพอร ต 20 ของแผงวงจร IPST-SE ในการต อก ับแผงวงจร ZX-LED8

5.7.3 LED8
เป นฟ งก ชั่ นกํ าหนดข อมู ลสํ าหรั บแสดงผลบนแผงวงจร ZX-LED8

รู ปแบบ

void LED8(unsigned char _dat) (ใช ในกรณี ที่ มี การกํ าหนดขาเชื่ อมต อด วย pinLED8)

void LED8(int pin, unsigned char _dat)

พารามิ เตอร 

pin - ขาพอร ตใดๆ ของแผงวงจร IPST-SE มี ค า 0 ถึ ง 30 (แนะนํ าให ใช จุ ดต อพอร ต 16 ถึ ง 20)

_dat - ข อมู ลสํ าหรั บนํ าไปแสดงผล มี ค า 0 ถึ ง 255

ตั วอย างที่  5-14
#include <ipst.h> // ผนวกไฟล ไลบรารี หลั ก
void setup()
{

pinLED8(20); // ใช จุ ดต อพอร ต 20 ในการต อกั บแผงวงจร ZX-LED8
}
void loop()
{

unsigned char i=0;
while(1)
{

LED8(i++); // แสดงค าเลขฐานสอง 8 บิ ต (00000000 ถึ ง 11111111)
delay(500); // หน วงเวลา 0.5 วิ นาที 

}
}
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ตั วอย างที่  5-15
#include <ipst.h> // ผนวกไฟล ไลบรารี หลั ก
void setup()
{}
void loop()
{

unsigned char i=0;
while(1)
{

LED8(20,i++); // เลื อกจุ ดต อพอร ต 20 ในการเชื่ อมต อกั บแผงวงจร ZX-LED8
// แล วแสดงค าเลขฐานสอง 8 บิ ต (00000000 ถึ ง 11111111)

delay(500); // หน วงเวลา 0.5 วิ นาที 
}

}
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5.8 ipst_motor.h ไลบรารี ขั บมอเตอร ไฟตรง

แผงวงจร IPST-SE ในชุ ดกล องสมองกล IPST-MicroBOX (SE) ขั บมอเตอร ไฟตรงได  2 ตั ว
โดยต อมอเตอร ไฟตรงขนาด 3 ถ ึง 9V เข าที ่จ ุดต อมอเตอร ช อง 1 และ 2 ฟ งก ชั ่นที ่ใช ในการข ับมอเตอร 
ไฟตรงมี ดั งนี้ 

5.8.1 motor
เป นฟ งก ชั่ นขั บเคลื่ อนมอเตอร ไฟตรง

รู ปแบบ

void motor(char _channel,int _power)

พาราม ิเตอร 

_channel - กํ าหนดช องเอาต พุ ตมอเตอร ไฟตรง มี ค า 1 และ 2

_power - กํ าหนดกํ าลั งขั บมอเตอร  มี ค าในช วง -100 ถึ ง 100
ถ ากํ าหนดค า _power เป นบวก (1 ถึ ง 100) ทํ าให มอเตอร หมุ นไปในทิ ศทางหนึ่ ง
ถ ากํ าหนดค า _power เป นลบ (-1 ถึ ง -100) มอเตอร จะถู กขั บให หมุ นไปในทิ ศทางตรงข าม
ถ ากํ าหนดค า _power เป น 0 มอเตอร หยุ ดหมุ น ไม แนะนํ าให กํ าหนดค าเป น 0 หากต อง

การให มอเตอร หยุ ดหมุ นควรเรี ยกใช ฟ งก ชั่ น motor_stop

ตั วอย างที่  5-16
#include <ipst.h> // ผนวกไลบรารี หลั ก
void setup()
{}
void loop()
{

motor(1,60);     // ขั บมอเตอร ช องที่  1 ด วย
//  กํ าลั ง 60%

delay(500);      // ขั บนาน 0.5 วิ นาที 
motor(1,-60);    // ขั บมอเตอร ช องที่  1

// กลั บทิ ศทางด วยกํ าลั ง 60%
delay(500);      // ขั บนาน 0.5 วิ นาที 

}

27A3 30A6

29A526A2

28A425A1

2
4

A
0

USB

D

9SDA 8SCL

1
2

1
3

1
4

1
5

S
V
0

S
V
1

S
V
2

S
V
3

12
6V
G

13
6V
G

14
6V
G

15
6V
G

21

D
C
 M

O
T
O

R

3 TxD1

LOW+5

2 RxD1

UART1

SERVO

00000000

0Row01000000000000000

00Row0200000000000000

000Row030000000000000

0000Row04000000000000

00000Row0500000000000

000000R00060000000000

0000000R0007000000000

00000000Row0800000000

000000000Row090000000

0000000000Row01000000

00000000000Row0110000

000000000000Row012000

0000000000000Row01300

00000000000000Row0140

000000000000000Row015

RESET2019

18

17

16

KNOB

OK

SW1

ON

Rowl00 rld00Wo





86   Arduino IDE

5.8.2 motor_stop
เป นฟ งก ชั่ นหยุ ดขั บมอเตอร 

รู ปแบบ

void motor_stop(char _channel)

พาราม ิเตอร 

_channel - กํ าหนดช องเอาต พุ ตมอเตอร ไฟตรง มี ค า 1, 2 และ ALL
โดย ALLเป นการเลื อกให มอเตอร ทั้ งหมดหยุ ดทํ างาน

ตั วอย างที่  5-17
#include <ipst.h> // ผนวกไลบรารี หลั ก
void setup()
{

sw_OK_press(); // ตรวจสอบการกดสวิ ตช  OK
}
void loop()
{

motor(1,60); // มอเตอร  1 หมุ นด วยกํ าลั งไฟฟ า 60%
delay(500); // หน วงเวลา 0.5 วิ นาที 
motor(1,-60); // มอเตอร  1 หมุ นกลั บทิ ศด วยกํ าลั งไฟฟ า 60%
delay(500); // หน วงเวลา 0.5 วิ นาที 
if (sw1()) // ตรวจสอบการกดสวิ ตช  SW1
{

motor_stop(1); // ถ าสวิ ตช  SW1 ถู กกด มอเตอร ช อง 1 หยุ ดหมุ น
while (1);

}
}
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ตั วอย างที่  5-18
#include <ipst.h> // ผนวกไฟล ไลบรารี หลั ก
void setup()
{}
void loop()
{

motor(1,50); // ขั บมอเตอร ช อง 1 ด วยกํ าลั ง 50% ของกํ าลั งสู งสุ ด
motor(2,50); // ขั บมอเตอร ช อง 2 ด วยกํ าลั ง 50% ของกํ าลั งสู งสุ ด
sleep(3000); // หน วงเวลา 3 วิ นาที 
motor(1,-50); // ขั บมอเตอร ช อง 1 กลั บทิ ศทางด วยกํ าลั ง 50% ของกํ าลั งสู งสุ ด
motor(2,-50); // ขั บมอเตอร ช อง 2 กลั บทิ ศทางด วยกํ าลั ง 50% ของกํ าลั งสู งสุ ด
sleep(3000); // หน วงเวลา 3 วิ นาที 
motor_stop(ALL); // หยุ ดขั บมอเตอร ทั้ งสองช อง
sleep(3000); // หน วงเวลา 3 วิ นาที 

}
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5.9 ipst_servoMotor.h ไฟล ไลบรารี ขั บเซอร โวมอเตอร 

เป นไฟล ไลบรารี ควบคุ มเซอร โวมอเตอร  มี ฟ งก ชั่ นสนั บสนุ นการควบคุ มตํ าแหน งแกนหมุ น
ของเซอร โวมอเตอร  โดยแผงวงจร IPST-SE ควบคุ มเซอร โวมอเตอร ได  4 ตั วในเวลาเดี ยวกั น ก อนใช 
งานต องผนวกไลบรารี ไว ในตอนต นของโปรแกรมด วยคํ าสั่ ง

#include <ipst_servoMotor.h> หรื อ #inclue <atx.h>

ในไฟล ไลบรารี นี้ มี  1 ฟ งก ชั่ นคื อ servo เป นฟ งก ชั่ นกํ าหนดตํ าแหน งแกนหมุ นของเซอร โว
มอเตอร 

รู ปแบบ

void servo(unsigned char _ch, int _angle)

พารามิ เตอร 

_ch - ช องเอาต พุ ตเซอร โวมอเตอร  มี ค า 0 ถึ ง 3

_pos - กํ าหนดตํ าแหน งแกนหมุ นของเซอร โวมอเตอร  มี ค าในช วง 0 ถึ ง 180 และ -1

ถ ากํ าหนดเป น -1 หมายถึ ง ไม ใช งานเซอร โวมอเตอร ที่ ช องนั้ นๆ

ตั วอย างที่  5-19
#include <ipst.h> // ผนวกไฟล ไลบรารี หลั ก
void setup()
{}
void loop()
{

servo(0,60); // ขั บเซอร โวมอเตอร ช อง 0 ไปยั งตํ าแหน ง 60 องศา
delay(5000); // หน วงเวลา 5 วิ นาที 
servo(0,120); // ขั บเซอร โวมอเตอร ช อง 0 ไปยั งตํ าแหน ง 120 องศา
delay(5000); // หน วงเวลา 5 วิ นาที 

}
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5.10 ipst_serial.h ไลบรารี รั บส งข อมู ลอนุ กรม

เป นไฟล ไลบรารี ที่ บรรจุ ชุ ดคํ าสั่ งเกี่ ยวกั บการรั บส งข อมู ลอนุ กรมผ านวงจรสื่ อสารข อมู ล
อนุ กรม (UART) ของไมโครคอนโทรลเลอร บนแผงวงจร IPST-SE ในชุ ดกล องสมองกล IPST-
MicroBOX (SE) ก อนเรี ยกใช งานต องผนวกไฟล ไลบรารี ไว ในตอนต นของโปรแกรมด วยคํ าสั่ ง

#include <ipst_serial.h> หรื อ #inclue <atx.h>

5.10.1 การเชื่ อมต อทางฮาร ดแวร 

เมื่ อต องการใช งานช อง UART0 (ทํ างานผ านพอร ต USB)
ให ต อสายจากจ ุดต อพอร ต USB บนแผงวงจร IPST-SE (เป นจ ุดต อเด ียวก ับที ่ใช ในการอ ัปโหลด)

เข ากั บพอร ต USB ของคอมพิ วเตอร 

เมื่ อต องการใช งานช อง UART1
ต อสายส ัญญาณเข าก ับจ ุดต อ RXD1 (จ ุดต อพอร ต 2) และ TXD1 (จ ุดต อพอร ต 3) บนแผงวงจร

IPST-SE








รู ปที่  5-2 แสดงจุ ดต อสั ญญาณของแผงวงจร IPST-SE เมื่ อมี การใช งานไลบรารี  ipst_serial.h
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5.10.2 uart
เป นฟ งก ชั่ นสํ าหรั บส งข อมู ลกลุ มอั กษรหรื อสายอั กขระหรื อสตริ ง (string) ออกจากโมดู ล

UART0 ไปยั งคอมพิ วเตอร ผ านพอร ต USB มี อั ตราการถ ายทอดข อมู ลเริ่ มต นที่  115,200 บิ ตต อวิ นาที 

รู ปแบบ

void uart(char *p,...)

พารามิ เตอร 
p - รั บรหั สของกลุ มข อความที่ ต องการส งออกจากภาคส งของโมดู ล UART0 กํ าหนดรู ปแบบการแทรก

สั ญลั กษณ พิ เศษเพื่ อใช ร วมในการแสดงผลได ดั งนี้ 

รห ัสบ ังค ับ การทํ างาน

%c หรื อ %C แสดงผลตั วอั กษร 1 ตั ว

%d หรื อ %D แสดงผลตั วเลขฐานสิ บช วงตั้ งแต  -32,768 ถึ ง +32,767

%l หรื อ %L แสดงผลตั วเลขฐานสิ บช วงตั้ งแต  -2,147,483,648 ถึ ง +2,147,483,647

%f หรื อ %F แสดงผลข อมู ลแบบจํ านวนจริ ง(แสดงทศนิ ยม 3 หลั ก)

\r กํ าหนดให ข อความชิ ดไปทางด านซ ายของบรรทั ด

\n กํ าหนดให ข อความขึ้ นบรรทั ดใหม 

ตั วอย างที่  5-20
#include <ipst.h> // ผนวกไฟล ไลบรารี หลั ก
void setup()
{}
void loop()
{

uart("Hello IPST-MicroBOX (SE)!\r\n"); // ส งข อม ูลไปย ังคอมพ ิวเตอร แบบขึ ้นบรรท ัดใหม 
delay(2000); // หน วงเวลา 2 วิ นาที 

}

ในการร ันโปรแกรมนี ้ต องต อสาย USB ระหว างแผงวงจร IPST-SE ก ับพอร ต USB ของคอมพ ิวเตอร ไว ตลอด
เวลา จากนั้ นเป ดหน าต าง Serial Monitor โดยคลิ กที่ ปุ ม  หรื อเลื อกเมนู  Tools > Serial Monitor
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จากนั้ นรอสั กครู  หน าต าง Serial Monitor จะปรากฏข้ึ นมา พร อมกั บแสดงข อความตามรู ป ให ทํ าการ
คลิ กทํ าเคร่ื องหมายท่ี ช อง Auto Scroll และเลื อก No line ending ส วนช องสุ ดท ายเลื อกเป น 9600 Baud

5.10.3 uart_set_baud
เป นฟ งก ชั ่นก ําหนดอ ัตราหร ือความเร ็วในการสื ่อสารข อม ูลของโมด ูล UART0 ก ับคอมพ ิวเตอร 

รู ปแบบ

void uart_set_baud(unsigned int baud)

พารามิ เตอร 

baud - อั ตราบอดในการสื่ อสารของโมดู ล UART0 กั บคอมพิ วเตอร  มี ค า 2400 ถึ ง 115,200

ตั วอย างที่  5-21
uart_set_baud(4800); // กํ าหนดอั ตราบอดในการส่ื อสารข อมู ลเป น 4,800 บิ ตต อวิ นาที 

5.10.4 uart_available
เป นฟ งก ชั่ นตรวจสอบการรั บข อมู ลเข ามาของโมดู ล UART0 เมื่ อติ ดต อกั บคอมพิ วเตอร 

รู ปแบบ

unsigned char uart_available(void)

การคื นค า

- เป น “0” เมื่ อยั งไม มี ข อมู ลเข ามา
- มากกว า 0 เมื่ อมี ข อมู ลเข ามา โดยมี ค าเท ากั บจํ านวนของอั กขระที่ ได รั บ

ตั วอย างที่  5-22
char x =uart_available();

// ตรวจสอบว า มี ข อมู ลเข ามาทางภาครั บของโมดู ล UART0 หรื อไม  ถ า x มี ค ามากกว า 0 แสดงว า
// มี ข อมู ลเข ามายั งภาครั บแล ว ควรอ านข อมู ลออกด วยฟ งก ชั่ น uart_getkey ในลํ าดั บถั ดไปทั นที 



92   Arduino IDE

5.10.5 uart_getkey
เป นฟ งก ชั่ นอ านข อมู ลจากบั ฟเฟอร ตั วรั บของโมดู ล UART0

รู ปแบบ

char uart_getkey(void)

การค ืนค า

- เป น “0” เมื่ อไม มี การรั บอั กขระใดๆ เข ามายั งวงจรภาครั บของโมดู ล UART
- เป นค าของอั กขระที่ รั บได ในรู ปแบบของรหั สแอสกี้ 

ตั วอย างที่  5-23
#include <ipst.h>
void setup()
{}
void loop() // ลู ปการทํ างานหลั ก
{

if(uart_available()) // ตรวจสอบว ามี ข อมู ลเข ามาหรื อไม 
{

if(uart_getkey()==’a’) // ตรวจจั บการกดคี ย  a ว า ถู กกดหรื อไม 
{

glcd(3,1,“Key a Active!”); // แสดงข อความเพื่ อตอบสนองต อการตรวจพบว ามี การคี ย  a
sleep(2000); // หน วงเวลาแสดงข อความประมาณ 2 วิ นาที 

}
else
{

glcdClear(); // เคลี ยร ข อความที่ หน าจอแสดงผล
}

}
}
หมายเหตุ  เมื ่อเร ียกใช ฟ งก ชั ่น uart เพื ่อส งข อม ูลออกทางโมด ูลพอร ตอน ุกรมหร ือ UART และ uart_getkey เพื ่อ

ตรวจจั บอั กขระใดๆ นั ้น อั ตราการส่ื อสารข อมู ลจะถ ูกก ําหนดเป น 115,200 บ ิตต อว ินาท ี ข อม ูล 8 บ ิต และไม ม ีการตรวจ
สอบพาร ิตี ้โดยอั ตโนม ัต ิ และเป นค าตั ้งต น เพื ่อลดความซั บซ อนในการเข ียนโปรแกรมลง หากต องการเปลี ่ยนอั ตราเร็ วใน
การส่ื อสารข อม ูลต องใช ค ําส่ั ง uart_set_baud อย างไรก ็ตาม ต องค ําน ึงด วยว า เมื ่ออั ตราการส่ื อสารสู งขึ ้นอาจส งผลกระทบ
ต อความถ ูกต องในการส่ื อสารข อม ูลได 

ในการรั นโปรแกรมนี้ ต องต อสาย USB ระหว างแผงวงจร IPST-SE กั บพอร ต USB ของคอมพิ วเตอร ไว ตลอด
เวลา จากนั้ นเป ดหน าต าง Serial Monitor โดยคลิ กที่ ปุ ม  หรื อเลื อกเมนู  Tools > Serial Monitor
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จากนั้ นรอสั กครู  หน าต าง Serial Monitor จะปรากฏข้ึ นมา ให กดป อนตั วอั กษร a ที่ ช องบนสุ ด แล วคลิ ก
กดปุ ม Send ทางขวามื อ โดยที่ ช องด านล างเลื อก No line ending ส วนช องสุ ดท ายด านล างขวามื อเลื อกเป น 9600
Baud

เมื่ อส งตั วอั กษร a จากคอมพิ วเตอร ไปยั งแผงวงจร IPST-SE แล ว ที่ แผงวงจร IPST-SE จะตรวจสอบการเข า
มาของข อมู ล หากถู กต อง จะแสดงข อความ Key a Active !
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5.10.6 uart1
เป นฟ งก ชั่ นส งข อมู ลสายอั กขระออกทางภาคส งของโมดู ล UART1 มี อั ตราการรั บส งข อมู ล

เริ่ มต นที่  9,600 บิ ตต อวิ นาที  โดยการใช งานต องต อสายสั ญญาณเข าที่ จุ ด TXD1

รู ปแบบ

void uart1(char *p,...)

พารามิ เตอร 

p - ร ับรห ัสของกลุ มข อความที ่ต องการส งออกจากภาคส งของโมด ูล UART1 โดยสามารถก ําหนด
รู ปแบบการแทรกสั ญลั กษณ พิ เศษเพื่ อใช ร วมในการแสดงผลเหมื อนกั บฟ งก ชั่ น uart1

5.10.7 uart1_set_baud
เป นฟ งก ชั่ นกํ าหนดอั ตราการรั บส งข อมู ลของโมดู ล UART1 กั บอุ ปกรณ ภายนอก

รู ปแบบ

void uart1_set_baud(unsigned int baud)

พารามิ เตอร 

baud - กํ าหนดค าอั ตราการรั บส งข อมู ลในการสื่ อสารข อมู ลของโมดู ล UART1

ตั วอย างที่  5-24
uart1_set_baud(19200); // กํ าหนดอั ตราบอดในการส่ื อสารเป น 19,200 บิ ตต อวิ นาที 

5.10.8 uart1_available
เป นฟ งก ชั่ นตรวจสอบการรั บข อมู ลเข ามาของโมดู ล UART1 เมื่ อติ ดต อกั บอุ ปกรณ ภายนอก

โดยการใช งานต องต อสายสั ญญาณเข าที่ จุ ด RXD1 และ TXD1

รู ปแบบ

unsigned char uart1_available(void)

การค ืนค า

- เป น 0 เมื่ อไม มี ข อมู ลเข ามา
- มากกว า 0 โดยมี ค าเท ากั บจํ านวนของอั กขระที่ ได รั บ

ตั วอย างที่  5-25
char x =uart1_available();
// ตรวจสอบว ามี ข อมู ลเข ามาทางภาครั บของโมดู ล UART1 หรื อไม 
// ถ า x มี ค ามากกว า 0 แสดงว ามี ข อมู ลเข ามาแล ว ควรอ านออกไปด วยฟ งก ชั่ น uart1_getkey ทั นที 
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5.10.9  uart1_getkey
เป นฟ งก ชั่ นอ านข อมู ลจากบั ฟเฟอร ตั วรั บของโมดู ล UART1

รู ปแบบ

char uart1_getkey(void)

การคื นค า

- เป น 0 เมื่ อยั งไม มี การรั บอั กขระใดๆ
- เป นค าของอั กขระที่ รั บได ในรู ปแบบของรหั สแอสกี้ 


1. เมื่ อต องการติ ดต อกั บอุ ปกรณ สื่ อสารข อมู ลไร สาย อาทิ  โมดู ลบลู ทู ธ, โมดู ล XBEE เป นต น
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

2. เมื่ อต องการสื่ อสารข อมู ลระหว างแผงวงจร IPST-SE 2 ชุ ด
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


3. เมื ่อต องการต ิดต อก ับอ ุปกรณ ภายนอกที ่ต องการร ูปแบบข อม ูลอน ุกรมในการสื ่อสาร อาท ิ แผงวงจรข ับเซอร 
โวมอเตอร  16 ช อง (ZX-SERVO16i) , แผงวงจรโมดู ล LCD แบบอนุ กรม (SLCD16x2), แผงวงจรฐานเวลา
นาฬิ กาจริ งแบบอนุ กรม (ZX-17)
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ในการพั ฒนาโครงงานวิ ทยาศาสตร สมั ยใหม  ที่ เกี่ ยวข องกั บการเขี ยนโปรแกรมและต องมี 
ระบบควบคุ มอั ตโนมั ติ เข ามาเกี่ ยวข อง รวมถึ งต องมี การติ ดต อกั บตั วตรวจจั บ ซึ่ งผู ใช งานต องการ
ทราบถึ งค าที่ ตั วตรวจจั บวั ดหรื อตรวจจั บได  อุ ปกรณ ตั วหนึ่ งที่ มี ความสํ าคั ญคื อ อุ ปกรณ แสดงผล
อุ ปกรณ พื้ นฐานที่ สุ ดที่ ใช ในการแสดงผลคื อ LED หากต องการให มี การแสดงผลเป นตั วเลข ก็๋ จะ
เปลี ่ยนมาใช  LED ตั วเลข 7 ส วน หากมี ความต องการเพิ ่มขึ ้นไปอี ก นั ่นค ือ ต องการแสดงเป นข อความ
เป นตั วอั กษรจํ านวนมากขึ้ น โมดู ล LCD แบบอั กขระ (character LCD module) ก็ จะเข ามาทํ าหน าที่ 
นี ้

ในชุ ดกล องสมองกล IPST-MicroBOX Secondary Education (SE) รองรั บทั้ งการแสดงผล
ด วยอุ ปกรณ พื้ นฐานอย าง LED และจอแสดงผลแบบกราฟ ก  LCD สี  ทํ าให ชุ ดกล องสมองกล IPST-
MicroBOX (SE) นี้ ความสมบู รณ พร อมในการแสดงผลการทํ างานอย างเพี ยงพอ ในบทนี้ เป นการนํ า
เสนอข อมู ลสํ าหรั บการใช งานจอแสดงผลแบบกราฟ ก LCD สี ที่ เป นอุ ปกรณ แสดงผลหลั กของ
ชุ ดกล องสมองกล IPST-MicroBOX (SE) เพื่ อให นํ าไปใช งานได อย างเกิ ดประโยชน สู งสุ ด

6.1 คุ ณสมบั ติ ของจอแสดงผลแบบกราฟ ก LCD สี ของแผงวงจร IPST-SE
ในช ุดกล องสมองกล IPST-MicroBOX (SE)

ค ุณสมบ ัต ิที ่ส ําค ัญโดยสร ุปของจอแสดงผลแบบกราฟ ก LCD ส ีของแผงวงจร IPST-SE ม ีด ังนี ้

 ขนาดจอแสดงผล 1.8 นิ้ ว ความละเอี ยด 128 x 160 จุ ด

 แสดงภาพกราฟ กลายเส นและพื ้นส ี 65,536 ส ี (ไม รองร ับไฟล ร ูปภาพ) พร อมไฟส องหล ัง

 แสดงผลเป นตั วอั กษรขนาดปกติ  (5 x 7 จุ ด) ได  21 ตั วอั กษร 16 บรรทั ด (หรื อ 21 x16)

 ม ีไฟล ไลบราร ี ipst_glcd.h รองร ับเพื ่อช วยให การเข ียนโปรแกรมเพื ่อก ําหนดร ูปแบบการ
แสดงผลทํ าได หลากหลายแบบและสะดวกขึ้ นอย างมาก





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6.2 การเร ียกใช ไฟล ไลบราร ีส ําหร ับจอแสดงผลแบบกราฟ ก LCD ส ี

ไฟล ไลบราร ีที ่ใช ในการต ิดต อและควบค ุมการท ํางานของจอแสดงผลกราฟ ก LCD ส ีจะได ร ับ

การติ ดตั้ งไปพร อมกั บการติ ดตั้ งซอฟต แวร  Arduino IDE 1.7.10 แล ว ไฟล ไลบรารี ชื่ อ ipst_glcd.h
ได รั บการคั ดลอกลงในโฟลเดอร  C:\Arduino17\libraries\IPST

การประกาศเพื ่อผนวกไฟล ไลบราร ีนี ้ในโปรแกรมหร ือสเก ็ตช ของ Arduino 1.7.10 ท ําได ด ังนี ้

#include <ipst_glcd.h> หรื อ  #include <ipst.h>

defghijk

0 0000000000

300000000000000000000

400000000000000000000

500000000000000000000

600000000000000000000

700000000000000000000

800000000000000000000

900000000000000000000

a00000000000000000000

b00000000000000000000

c00000000000000000000

d00000000000000000000

e00000000000000000000

f00000000000000000000

012345 89abc67

20000 0000d

100000000000000000000


















ร ูปที ่ 6-1 แสดงการก ําหนดต ําแหน งของการแสดงผลส ําหร ับจอแสดงผลกราฟ ก LCD ส ีที ่ใช บนแผงวงจร
IPST-SE ในช ุดกล องสมองกล IPST-MicroBOX (SE)
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6.3 ฟ งก ชั่ นเก่ี ยวกั บการแสดงผลจอภาพแบบกราฟ ก  LCD สี 

6.3.1 glcd
เป นฟ งก ชั่ นแสดงข อความที่ หน าจอแสดงผลกราฟ ก LCD สี  โดยแสดงตั วอั กษรขนาดปกติ 

ได  21 ตั วอั กษร 16 บรรทั ด

รู ปแบบ

void glcd(unsigned char x, unsigned char y ,char *p,...)

พาราม ิเตอร 
x คื อตํ าแหน งบรรทั ดมี ค าตั้ งแต  0 ถึ ง 15

y คื อตํ าแหน งตั วอั กษรมี ค าตั้ งแต  0 ถึ ง 20

*p ค ือข อความที ่ต องการน ํามาแสดงรวมถ ึงรห ัสที ่ใช ก ําหนดร ูปแบบพ ิเศษเพื ่อร วมแสดงผลข อม ูลต ัวเลขใน
ร ูปแบบอ่ื นๆ ประกอบด วย

%c หรื อ %C - รั บค าแสดงผลตั วอั กษร 1 ตั วอั กษร

%d หรื อ %D - รั บค าแสดงผลตั วเลขจํ านวนเต็ มในช วง -32,768 ถึ ง 32,767

%l หรื อ %L - รั บค าแสดงผลตั วเลขจํ านวนเต็ มในช วง -2,147,483,648 ถึ ง 2,147,483,647

%f หรื อ %F - รั บค าเพื่ อแสดงผลตั วเลขจํ านวนจริ ง (แสดงทศนิ ยม 3 หลั ก)

ตั วอย างที่  6-1
glcd(2,0,“Hello World”);  // แสดงข อความ Hello World  ที ่ต ําแหน งซ ายสุ ดของบรรท ัด 2 (บรรท ัดที ่ 3)
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ตั วอย างที่  6-2
int x=20;
glcd(1,2,”Value = %d”,x);
// แสดงตั วอั กษรและตั วเลขบนบรรทั ดเดี ยวกั น เริ่ มต นที่ คอลั มน  2 ของบรรทั ด 1 (บรรทั ดที่  2)
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6.3.2 colorRGB
เป นฟ งก ชั่ นเปลี่ ยนค าสี ในรู ปแบบ RGB (แดง เขี ยว นํ้ าเงิ น) ให อยู ในรู ปของตั วเลข 16 บิ ต

โดยแบ งเป นค าของสี แดง 5 บิ ต ต อด วยสี เขี ยว 6 บิ ต และป ดท ายด วยค าของสี นํ้ าเงิ น 5 บิ ต

รู ปแบบ

unsigned int colorRGB(uint red,uint green,uint blue)

พาราม ิเตอร 
red - เป นค าของสี แดง มี ค า 0 ถึ ง 31 ถ าค าที่ ป อนมากกว า 31 จะปรั บลดให เท ากั บ 31
green -  ค าของสี เขี ยว มี ค า 0 ถึ ง 63 ถ าค าที่ ป อนมากกว า 63 จะถู กปรั บลดให เท ากั บ 63
blue - ค าของสี นํ้ าเงิ น มี ค า 0 ถึ ง 31 ถ าค าที่ ป อนมากกว า 31 จะปรั บลดให เท ากั บ 31

ตั วอย างที่  6-3
#include <ipst.h>
int colors;
void setup()
{

int colors;
colors=colorRGB(31,0,0); // ส งค าสี  16 บิ ตของสี แดงให ตั วแปร colors
glcdFillScreen(colors); // นํ าค าไปแสดงเป นสี พื้ นของจอแสดงผล

}
void loop()
{}
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6.3.3 color[ ]
เป นต ัวแปรอะเรย ที ่ใช ก ําหนดส ีจ ํานวน 8 ส ีที ่เป นส ีพื ้นฐาน ผู พ ัฒนาโปรแกรมสามารถเร ียกใช 

ตั วแปร color[] หรื อเรี ยกใช ชื่ อสี ตรงๆ ก็ ได 

รู ปแบบ

unsigned int color[]= { GLCD_RED,
GLCD_GREEN,
GLCD_BLUE,
GLCD_YELLOW,
GLCD_BLACK,
GLCD_WHITE,
GLCD_SKY,
GLCD_MAGENTA};

พาราม ิเตอร 
GLCD_RED  - ใช กํ าหนดสี แดง

GLCD_GREEN - ใช กํ าหนดสี เข ียว

GLCD_BLUE - ใช กํ าหนดสี นํ้ าเงิ น

GLCD_YELLOW  - ใช กํ าหนดสี เหลื อง

GLCD_BLACK  - ใช กํ าหนดสี ดํ า

GLCD_WHITE  - ใช กํ าหนดสี ขาว

GLCD_SKY - ใช กํ าหนดสี ฟ า

GLCD_MAGENTA - ใช กํ าหนดสี บานเย ็น

ตั วอย างที่  6-4
glcdFillScreen(color[5]); // กํ าหนดให พื้ นหลั งเป นสี ขาว

ตั วอย างที่  6-5
glcdFillScreen(GLCD_BLUE); // กํ าหนดให พื้ นหลั งเป นสี นํ้ าเงิ น
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6.3.4 glcdSetColorWordBGR
เป นฟ งก ชั่ นกํ าหนดการเรี ยงบิ ตข อมู ลสี ให เป นแบบ BGR (5-6-5) นั่ นคื อ ค าของสี นํ้ าเงิ น 5 บิ ต

ต อด วยสี เขี ยว 6 บิ ต และป ดท ายด วยค าของสี แดง 5 บิ ต ทั้ งนี้ เนื่ องจากผู ผลิ ตจอแสดงผลกราฟ ก LCD
สี มี การผลิ ตจอแสดงที่ มี คุ ณสมบั ติ เหมื อนกั นออกมา 2 รุ น แต มี การเรี ยงบิ ตข อมู ลสี ต างกั น คื อ เรี ยง
แบบ BGR และเรี ยงแบบ RGB

อย างไรก็ ตาม ค าตั้ งต นของไฟล ไลบรารี  ipst_glcd.h เลื อกใช การเรี ยงบิ ตข อมู ลสี ให เป นแบบ
BGR นั่ นคื อ มี การเรี ยกใช ฟ งก ชั่ นนี้ ตั้ งแต ต น จึ งไม ต องเขี ยนฟ งก ชั่ นนี้ ลงในโปรแกรม

รู ปแบบ

glcdSetColorWordBGR()

ตั วอย างที่  6-6
#include <ipst.h>
void setup()
{

glcdSetColorWordBGR(); // เข ียนฟ งก ชั่ นนี ้ลงไปหร ือไม ก็ ได 
}
void loop()
{}

6.3.5 glcdSetColorWordRGB( );
เป นฟ งก ชั่ นกํ าหนดการเรี ยงบิ ตข อมู ลสี ให เป นแบบ RGB (5-6-5) นั่ นคื อ ค าของสี แดง 5 บิ ต

ต อด วยสี เขี ยว 6 บิ ต และป ดท ายด วยค าของสี นํ้ าเงิ น 5 บิ ต ทั้ งนี้ เนื่ องจากผู ผลิ ตจอแสดงผลกราฟ ก
LCD สี มี การผลิ ตจอแสดงผลแบบนี้  2 รุ น โดยมี การเรี ยงบิ ตข อมู ลสี แบบ BGR และแบบ RGB

หากผู ใช งานแผงวงจร IPST-SE และทดลองกํ าหนดสี ของภาพหรื อตั วอั กษรแล วพบว า สี ที่ ได 
ไม ถู กต อง จะต องเรี ยกใช ฟ งก ชั่ นนี้  โดยบรรจุ ไว ใน setup() ที่ ตอนต นของโปรแกรม

รู ปแบบ

glcdSetColorWordRGB()

ตั วอย างที่  6-7
#include <ipst.h>
void setup()
{

glcdSetColorWordBGR(); // เล ือกร ูปแบบการเร ียงบ ิตสี เป นแบบ RGB
}
void loop()
{}
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6.3.6 setTextColor
เป นการกํ าหนดค าสี ของตั วอั กษรที่ แสดงด วยฟ งก ชั่ น glcd() โดยค าตั้ งต นกํ าหนดเป นสี ขาว

รู ปแบบ

void setTextColor(unsigned int newColor)

พาราม ิเตอร 
newColor ค ือสี ที ่ต องการ เป นตั วเลข 16 บ ิต หร ือเป นค าตั วแปรที ่กํ าหนดค าไว แล วจากตั วแปร color[]

ตั วอย างที่  6-8
#include <ipst.h>
int colors;
void setup()
{

int colors;
colors=colorRGB(31,0,0); // ส งค าสี  16 บิ ตของสี แดงให ตั วแปร colors
setTextColor(colors); // กํ าหนดให สี ของตั วอั กษรเป นสี แดง
glcd(1,0,"Text color is Red"); // กํ าหนดข อความ

}
void loop()
{

setTextColor(GLCD_YELLOW); // กํ าหนดให สี ของตั วอั กษรเป นสี เหลื อง
glcd(3,0,"Text color is Yellow"); // กํ าหนดข อความ

}
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6.3.7 setTextBackgroundColor
เป นฟ งก ชั่ นกํ าหนดสี ของพ้ื นหลั งตั วอั กษร โดยค าตั้ งต นเป นสี ดํ า  สี ของพ้ื นหลั งตั วอั กษรจะ

เป นคนละส วนก ับส ีของพื ้นจอภาพ (screen background) ซึ ่งต องก ําหนดค าผ านฟ งก ชั ่น glcdFillScreen

รู ปแบบ

void setTextBackgroundColor(unsigned int newColor)

พาราม ิเตอร 
newColor คื อสี ที่ ต องการ เป นตั วเลข 16 บ ิต หร ือเป นค าตั วแปรที ่กํ าหนดค าไว แล วจากตั วแปร color[]

ตั วอย างที่  6-9
#include <ipst.h>

void setup()
{

setTextBackgroundColor(GLCD_RED); // กํ าหนดให สี พื้ นหลั งตั วอั กษรเป นสี แดง
}
void loop()
{

setTextColor(GLCD_YELLOW); // กํ าหนดให สี ของตั วอั กษรเป นสี เหลื อง
glcd(3,0,"Text color is Yellow."); // กํ าหนดข อความ
glcd(5,0,"Text background color"); // กํ าหนดข อความ
glcd(6,0,"is Red."); // กํ าหนดข อความ

}
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6.3.8 glcdClear
เป นการเคล ียร หน าจอแสดงผล โดยส ีของพื ้นหล ังจะเป นส ีพื ้นหล ังของต ัวอ ักษรล าส ุด โดยถ าไม 

ได ก ําหนดด วยค ําสั ่ง setTextBackGroundColor() มาก อนหน านี ้ หล ังจากท ําค ําสั ่ง glcdClear()แล ว
พื ้นหล ังจะเป นส ีด ํา

รู ปแบบ

void glcdClear()

ตั วอย างที่  6-10
glcdClear(); // เคลี ยร หน าจอแสดงผล

IPST-SE










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6.3.9 glcdFillScreen
เป นการเคลี ยร หน าจอแสดงผล แล วเปลี่ ยนสี พื้ นหลั งของจอแสดงผลด วยสี ที่ ระบุ 

รู ปแบบ

void glcdFillScreen(unsigned int color)

พาราม ิเตอร 
Color คื อสี ที่ ต องการ เป นตั วเลข 16 บิ ต หรื อเป นค าตั วแปรท่ี กํ าหนดค าไว แล วจากตั วแปร color[]

ตั วอย างที่  6-11
glcdFillScreen(GLCD_YELLOW);  // กํ าหนดสี พื้ นหลั งของจอภาพเป นสี เหลื อง











6.3.10 glcdMode
เป นการกํ าหนดทิ ศทางแสดงผลของจอกราฟ ก LCD สี  โดยกํ าหนดให ข อความหรื อภาพหน า

จอให แสดงภาพตั้ งฉากตรงหน า (โหมด 0), หมุ นขวา 90 องศา (โหมด 1), หมุ น 180 องศาหรื อกลั บ
หั ว (โหมด 2) และหมุ น 270 องศา (โหมด 3)

รู ปแบบ

glcdMode(unsigned int modeset)

พาราม ิเตอร 
modeset คื อค าทิ ศทางของการหมุ นมี ค า 0 ถึ ง 3 โดยใช แทนทิ ศทาง 0, 90, 180 หรื อ 270 องศา

โดยมี ค าเริ่ มต นคื อ 0 องศา ทํ างานอยู ในแนวตั้ ง
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











ตั วอย างที่  6-12
#include <ipst.h>
void setup()
{

setTextSize(2); // ขนาดตั วอั กษร 2 เท า
}
void loop()
{

glcdClear(); // เคลี ยร หน าจอ
glcdMode(0); // โหมด 0 องศา
glcd(0,0,"IPST-SE"); // แสดงข อความ
sw_ok_press(); // รอกดสวิ ตช เข าโหมดต อไป
glcdClear();
glcdMode(1);
glcd(0,0,"IPST-SE");
sw_ok_press();
glcdClear();
glcdMode(2);
glcd(0,0,"IPST-SE");
sw_ok_press();
glcdClear();
glcdMode(3);
glcd(0,0,"IPST-SE");
sw_ok_press();

}
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6.3.11 setTextSize
เป นการก ําหนดขนาดต ัวอ ักษรโดยระบ ุเป นจ ํานวนเท าของขนาดปกต ิ ค าตั ้งต นเมื ่อเริ ่มท ํางาน

ทุ กครั้ งคื อ ขนาดตั วอั กษรปกติ  ใช พื้ นที่ รวมระยะช องไฟคื อ 6 x  10 พิ กเซลต อ 1 ตั วอั กษร จึ งแสดง
ได  21 ตั วอั กษร 16 บรรทั ดในแนวตั้ ง















รู ปแบบ

setTextSize(unsigned int newSize)

พาราม ิเตอร 
newSize คื อค าขนาดจํ านวนเท าของขนาดปกติ  มี ค า 1 ถึ ง 16 เพื่ อให ตั วอั กษรที่ แสดงไม ล นหน าจอ

ถ าหากกํ าหนดเป น 1 เท า แสดงตั วอั กษรได  21 ตั ว 16 บรรทั ด

ถ าหากกํ าหนดเป น 2 เท า แสดงตั วอั กษรได  10 ตั ว 8 บรรทั ด

ถ าหากกํ าหนดเป น 3 เท า แสดงตั วอั กษรได  7 ตั ว 5 บรรทั ด

ถ าหากกํ าหนดเป น 4 เท า แสดงตั วอั กษรได  5 ตั ว 4 บรรทั ด

ถ าหากกํ าหนดเป น 5 เท า แสดงตั วอั กษรได  4 ตั ว 3 บรรทั ด

ถ าหากกํ าหนดเป น 6 และ 7 เท า แสดงตั วอั กษรได  3 ตั ว 2 บรรทั ด

ถ าหากกํ าหนดเป น 8 เท า แสดงตั วอั กษรได  2 ตั ว 2 บรรทั ด

ถ าหากกํ าหนดเป น 9 และ 10 เท า แสดงตั วอั กษรได  2 ตั ว 1 บรรทั ด

ถ าหากกํ าหนดเป น 11 ถึ ง 16 เท า แสดงตั วอั กษรได  1 ตั ว 1 บรรทั ด (แบบไม ล นจอแสดงผล)
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ตั วอย างที่  6-13
#include <ipst.h>
void setup()
{

setTextSize(1); // กํ าหนดขนาดข อความ 1 เท า
setTextColor(GLCD_GREEN); // สี ตั วอั กษรเป นสี เขี ยว
glcd(0,0,"Size1"); // แสดงข อความ
setTextSize(2);
glcd(1,0,"Size2"); // กํ าหนดขนาดข อความ 2 เท า
setTextSize(3);
glcd(2,0,"Size3"); // กํ าหนดขนาดข อความ 3 เท า
setTextSize(4);
glcd(3,0,"Size4"); // กํ าหนดขนาดข อความ 4 เท า

}
void loop()
{}

6.3.12 getTextColor
เป นคํ าสั่ งคื นค าสี ป จจุ บั นของตั วอั กษร

รู ปแบบ

unsigned int getTextColor()

การคื นค า
textColor เป นค าสี แสดงอยู ในรู ปของตั วเลข 16 บิ ต ดู รู ปแบบได จากฟ งก ชั่ น colorRGB()

ตั วอย างที่  6-14
unsigned int color;
color=getTextColor(); // น ําค าสี ของต ัวอั กษรเก ็บไว ที ่ต ัวแปร color
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6.3.13 getTextBackgroundColor
เป นคํ าสั่ งคื นค าสี พื้ นหลั งของตั วอั กษรในป จจุ บั น

รู ปแบบ

unsigned int getTextBackgroundColor()

การคื นค า
textBackgroundColor เป นค าสี แสดงอยู ในร ูปของต ัวเลข 16 บ ิต ด ูร ูปแบบได จากฟ งก ชั ่น colorRGB()

ตั วอย างที่  6-15
unsigned int color;
color=getTextBackgroundColor(); // น ําค าสี พื ้นหล ังของต ัวอั กษรเก ็บในต ัวแปร color

6.3.14 getTextSize
คื นค าขนาดของตั วอั กษรออกมาเป นจํ านวนเท าของค าปกติ 

รู ปแบบ

unsigned int getTextSize()

การคื นค า
textSize เป นค าจํ านวนเท าของขนาดตั วอั กษร

ตั วอย างที่  6-16
unsigned int textSize;
textSize=getTextSize(); // นํ าค าจํ านวนเท าของขนาดของตั วอั กษรเก็ บในตั วแปร textSize

6.3.15 glcdGetMode
เป นคํ าสั่ งคื นค าของโหมดทิ ศทางการแสดงผลในป จจุ บั น

รู ปแบบ

unsigned int glcdGetMode()

การคื นค า
mode เป นค าของโหมดทิ ศทางการแสดงผล เป นตั วเลข 0 ถึ ง 3 เพื่ อแสดงผลในทิ ศทาง 0 องศา, หมุ น 90

องศา, หมุ น 180 องศา และหมุ น 270 องศาตามลํ าดั บ

ตั วอย างที่  6-17
unsigned int Mode;
Mode=glcdGetMode(); // คื นค าทิ ศทางการแสดงผลของหน าจอ GLCD
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6.3.16 glcdPixel
เป นคํ าสั่ งพล็ อตจุ ดบนจอภาพตามพิ กั ดที่ กํ าหนด  โดยอ างอิ งถึ งตํ าแหน งของพิ กเซลหรื อจุ ด

ของจอแสดงผลที่ ความละเอี ยด 128 x 160 จุ ด ดั งรู ปที่  6-2

รู ปแบบ

void glcdPixel(unsigned int x,unsigned int y,unsigned int color)

พาราม ิเตอร 
x คื อค าพิ กั ดในแนวนอนหรื อแกน x มี ค าระหว าง 0 ถึ ง 127

y คื อค าพิ กั ดในแนวตั้ งหรื อแกน y มี ค าระหว าง 0 ถึ ง 159

color คื อค าของสี ที่ ต องการ เป นตั วเลข 16 บิ ต หรื อเป นค าตั วแปรท่ี กํ าหนดค าไว แล วจากตั วแปร color[]















  

ร ูปที ่ 6-2 แสดงการก ําหนดต ําแหน งของพ ิกเซลหร ือจ ุดของจอแสดงผลกราฟ ก LCD ส ีที ่ใช บนแผงวงจร
IPST-SE ในช ุดกล องสมองกล IPST-MicroBOX (SE)
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ตั วอย างที่  6-18
#include <ipst.h>
int i;
void setup()
{

for (i=0;i<128;i+=4)
{

glcdPixel(i,80,GLCD_RED); // พล็ อตจุ ดทุ กๆ 4 พิ กเซลในแนวแกน x กลางจอ
}
for (i=0;i<160;i+=4)
{

glcdPixel(64,i,GLCD_RED); // พล็ อตจุ ดทุ กๆ 4 พิ กเซลในแนวแกน y กลางจอ
}

}
void loop()
{}
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6.3.1.17  glcdRect

เป นฟ งก ชั ่นลากเส นจากพ ิก ัดที ่ก ําหนดมาย ังพ ิก ัดปลายทาง  โดยอ างอ ิงถ ึงต ําแหน งของพ ิกเซล
หรื อจุ ดของจอแสดงผลที่ ความละเอี ยด 128 x 160 จุ ด ตามรู ปที่  6-2

รู ปแบบ

void glcdRect(unsigned int x1,unsigned int y1,unsigned int width,unsigned int
height,unsigned int color)

พาราม ิเตอร 
x1 คื อ ค าตํ าแหน งเร่ิ มต นของรู ปส่ี เหลี่ ยมในแกน x มี ค าระหว าง 0 ถึ ง 127

y1 คื อ ค าตํ าแหน งเร่ิ มต นของรู ปส่ี เหลี่ ยมในแกน y มี ค าระหว าง 0 ถึ ง 159

width คื อ ค าความกว างของรู ปส่ี เหลี่ ยม (แนวนอน) มี ค าระหว าง 1 ถึ ง 128

height คื อ ค าความสู งของรู ปส่ี เหลี่ ยม (แนวตั้ ง) มี ค าระหว าง 1 ถึ ง 158

color คื อ สี ของเส น เป นค าตั วเลข 16 บิ ต หรื อเป นค าตั วแปรท่ี กํ าหนดค าไว แล วจากตั วแปร color[]

ตั วอย างที่  6-19
#include <ipst.h>
void setup()
{

glcdRect(32,40,64,80,GLCD_RED);  // วาดรู ปส่ี เหลี่ ยมเส นสี แดง ขนาด 64 x 80 พิ กเซล
}
void loop()
{}
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6.3.18 glcdFillRect
เป นการระบายส ีพื ้นของร ูปสี ่เหลี ่ยม โดยก ําหนดจ ุดเริ ่มต นและความกว างยาวของร ูปสี ่เหลี ่ยม

ที่ ต องการ ฟ งก ชั่ นนี้ เป นการสร างรู ปสี่ เหลี่ ยมที่ มี สี พื้ นแต ไม มี เส นกรอบ ในขณะที่ ฟ งก ชั่ น glcdRect
เป นการวาดรู ปกรอบสี่ เหลี่ ยมที่ กํ าหนดสี ของเส นกรอบได  แต ภายในกรอบไม มี สี 

รู ปแบบ

void glcdFillRect(unsigned int x1, unsigned int y1, unsigned int width, unsigned
int height,unsigned int color)

พาราม ิเตอร 
x1 คื อ ค าตํ าแหน งเร่ิ มต นของรู ปส่ี เหลี่ ยมในแกน x มี ค าระหว าง 0 ถึ ง 127

y1 คื อ ค าตํ าแหน งเร่ิ มต นของรู ปส่ี เหลี่ ยมในแกน y มี ค าระหว าง 0 ถึ ง 159

width คื อ ค าความกว างของรู ปส่ี เหลี่ ยม (แนวนอน) มี ค าระหว าง 1 ถึ ง 128

height คื อ ค าความสู งของรู ปส่ี เหลี่ ยม (แนวตั้ ง) มี ค าระหว าง 1 ถึ ง 158

color คื อ สี ของเส น เป นค าตั วเลข 16 บิ ต หรื อเป นค าตั วแปรท่ี กํ าหนดค าไว แล วจากตั วแปร color[]

ตั วอย างที่  6-20
#include <ipst.h>
void setup()
{

glcdFillRect(32,40,64,80,GLCD_RED);
// สร างภาพส่ี เหลี่ ยมพื้ นสี แดง ขนาด 64 x 80 พิ กเซล

}
void loop()
{}
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6.3.19 glcdLine
เป นฟ งก ชั่ นลากเส นจากจุ ดหนึ่ งไปยั งอี กจุ ดหนึ่ ง กํ าหนดเป นพิ กั ดในแนวแกนนอน (x) และ

แกนตั้ ง (y)

รู ปแบบ

void glcdLine(unsigned int x1,unsigned int y1,unsigned int x2,unsigned int
y2,unsigned int color)

พาราม ิเตอร 

x1 คื อค าตํ าแหน งเร่ิ มต นของเส นบนแกน x มี ค าระหว าง 0 ถึ ง 127

y1 คื อค าตํ าแหน งเร่ิ มต นของเส นบนแกน y มี ค าระหว าง 0 ถึ ง 159

x2 คื อค าตํ าแหน งส้ิ นสุ ดของเส นบนแกน x มี ค าระหว าง 0 ถึ ง 127

y2 คื อค าตํ าแหน งส้ิ นสุ ดของเส นบนแกน y มี ค าระหว าง 0 ถึ ง 159

color คื อ ค าสี ของเส น เป นตั วเลข 16 บิ ต หรื อเป นค าตั วแปรท่ี กํ าหนดค าไว แล วจากตั วแปร color[]

ตั วอย างที่  6-21
#include <ipst.h>
void setup()
{

glcdLine(0,0,127,159,GLCD_RED); // ลากเส นสี แดงทะแยงม ุมจากด านบนซ ายลงมาด านล างขวา
}
void loop()
{}
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6.3.20  glcdCircle
เป นฟ งก ชั ่นวาดเส นร ูปวงกลมจากการก ําหนดจ ุดกึ ่งกลางของวงกลมและความยาวของร ัศม ี

รู ปแบบ

void glcdCircle(unsgined int x, unsgined int y, unsgined int radius,unsgined int color)

พาราม ิเตอร 

x คื อ พิ กั ดจุ ดศู นย กลางของวงกลมบนแกน x มี ค าระหว าง 0 ถึ ง 127

y คื อ พิ กั ดจุ ดศู นย กลางของวงกลมบนแกน y มี ค าระหว าง 0 ถึ ง 159

radius คื อ ค ารั ศมี ของวงกลม

color คื อ ค าสี ของเส น เป นตั วเลข 16 บิ ต หรื อเป นค าตั วแปรท่ี กํ าหนดค าไว แล วจากตั วแปร color[]

ตั วอย างที่  6-22
#include <ipst.h>
void setup()
{

glcdCircle(32,120,31,GLCD_RED);// สร างเส นวงกลมสี แดง มี รั ศมี  31 พิ กเซล
}
void loop()
{}
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6.3.21 glcdFillCircle

เป นฟ งก ชั่ นวาดรู ปวงกลมที่ มี สี พื้ นจากการกํ าหนดจุ ดศู นย กลางของวงกลม และความยาว
ของรั ศมี   ฟ งก ชั่ นนี้ เป นการสร างรู ปวงกลมที่ มี สี พื้ นแต ไม มี เส นกรอบ ในขณะที่ ฟ งก ชั่ น glcdCircle
เป นการวาดรู ปวงกลมที่ กํ าหนดสี ของเส นรอบวงได  แต ภายในวงกลมไม มี สี 

รู ปแบบ

void glcdFillCircle(unsigned int x,unsigned int y,unsigned int radius,unsigned int color)

พาราม ิเตอร 

x คื อ พิ กั ดจุ ดศู นย กลางของวงกลมบนแกน x มี ค าระหว าง 0 ถึ ง 127

y คื อ พิ กั ดจุ ดศู นย กลางของวงกลมบนแกน y มี ค าระหว าง 0 ถึ ง 159

radius คื อ ค ารั ศมี ของวงกลม

color คื อ ค าสี ของเส น เป นตั วเลข 16 บิ ต หรื อเป นค าตั วแปรท่ี กํ าหนดค าไว แล วจากตั วแปร color[]

ตั วอย างที่  6-23
#include <ipst.h>
void setup()
{

glcdFillCircle(32,120,31,GLCD_RED); // สร างรู ปวงกลมพื้ นสี แดง รั ศมี  31 พิ กเซล
}
void loop()
{}

0000000000000000

0000000000000000

500000000000000000000

600000000000000000000

700000000000000000000

800000000000000000000

900000000000 00000000

a000000000 0000000000

b00000000000000000000

c00000000000000000000

d00000000000000000000

e00000000000000000000

f00000000000000000000











118   Arduino IDE

6.3.22 glcdArc
เป นฟ งก ชั ่นวาดส วนโค งของวงกลม โดยระบ ุต ําแหน งจ ุดกึ ่งกลาง ร ัศม ี ต ําแหน งจ ุดเริ ่ม จ ุดสิ ้น

สุ ดและส ีของเส น

รู ปแบบ

void glcdArc(unsigned int x,unsigned int y,unsigned int r,int start_angle,int
end_angle,uint color)

พาราม ิเตอร 

x คื อตํ าแหน งจุ ดกึ่ งกลางในแนวแกน x

y คื อตํ าแหน งจุ ดกึ่ งกลางในแนวแกน y

r คื อรั ศมี ของเส นโค ง

start_angle ค ือต ําแหน งม ุมของจุ ดเริ ่มต นของวงกลม

end_angle ค ือต ําแหน งม ุมจ ุดส้ิ นสุ ดของวงกลม

color ค ือสี ของเส นวงกลม

ตั วอย างที่  6-24
#include <ipst.h>
void setup()
{

glcdArc(48,80,16,30,150,GLCD_RED);
glcdCircle(48,75,5,GLCD_YELLOW);
glcdCircle(80,75,5,GLCD_YELLOW);
glcdArc(80,80,16,30,150,GLCD_RED);
glcdFillCircle(64,90,7,GLCD_GREEN);
glcdArc(64,100,30,220,320,GLCD_RED);

}
void loop()
{}
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7.1  LED คื ออะไร

LED (Light Emiting Diode) หรื อไดโอดเปล งแสงเป นอุ ปกรณ เอาต พุ ตสํ าหรั บการแสดงผล
ซึ่ งสามารถติ ดสว างได เมื่ อได รั บแรงดั นกระตุ นอย างเหมาะสม โดย LED มี ให เลื อกใช งานได หลายสี 
อาทิ  สี แดง, เหลื อง, เขี ยว, นํ้ าเงิ น, ขาว, ส ม, ม วง เป นต น

LED สามารถกํ าเนิ ดแสงออกมาได เมื่ อได รั บจ ายไฟอย างถู กต อง การจ ายไฟให  LED ทํ างาน
เรี ยกว า การไบแอส (bias) และการไบแอสที่ ทํ าให  LED ทํ างาน เรี ยกว า การไบแอสตรง (forward
bias) โดยปกติ แรงดั นที่ ใช ในการขั บหรื อไบแอสให  LED ทํ างานจะมี ค าอยู ระหว าง 1-4.5 V ขึ้ นอยู กั บ
สารที ่น ํามาใช ท ํา LED และขึ ้นอยู ก ับปร ิมาณกระแสที ่ไหลผ าน กล าวค ือ ถ ากระแสไหลผ าน LED มาก
มี ผลทํ าให แรงดั นที่ ตกคร อม LED มี ค ามากและแสงที่  LED กํ าเนิ ดออกมาก็ จะสว างมากขึ้ นด วย  โดย
ปกติ มั กจะกํ าหนดให แรงดั นไบแอสตรงของ LED เท ากั บ 2V ในรู ปที่  7-1 เป นสั ญลั กษณ , โครงสร าง
และการจั ดขาของ LED

LED สามารถเปล งแสงออกได หลายสี ขึ้ นอยู กั บว า นํ าสารกึ่ งตั วนํ าชนิ ดใดมาสร างเป น LED
ถ าหากเป นสี แดงและเหลื องทํ ามาจากแกลเลี่ ยมอาร เซไนด ฟอสไฟด  (GaAsP) ส วนสี เขี ยวทํ ามาจาก
แกลเลี่ ยมฟอสไฟด  (GaP) และ LED ที่ ให แสงอิ นฟาเรดซึ่ งทํ ามาจากแกลเลี่ ยมอาร เซไนด  (GaAs)

รู ปที่  7-1 แสดงสั ญลั กษณ , โครงสร างและการจั ดขาของไดโอด
เปล งแสงหรื อ LED

R1

LED1Vs

I1

+

รู ปที่  7-2 การต อตั วต านทานเพื่ อ
จํ ากั ดกระแสให แก  LED

A K

(ก) สัญลักษณของ LED

ขาแอโนดขาแคโทด

(ข) โครงสรางภายในของ LED
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7.2 การใช งาน LED
LED ต องการแรงด ันไบแอสตรงประมาณ 2V และยอมให กระแสไฟฟ าไหลผ านได ไม เก ิน 40mA

แต ปร ิมาณกระแสไฟฟ าที ่เหมาะสมค ือ 10 ถ ึง 20mA ด ังนั ้นการใช งาน LED จ ึงต องม ีต ัวต านทานจ ําก ัด
กระแสไฟฟ าต ออนุ กรมร วมอยู ด วย ดั งในรู ปที่  7-2

การหาค าของตั วต านทานที่ ใช ในการจํ ากั ดกระแสไฟฟ าให  LED ทํ าได โดยใช สู ตร

R
Vcc V

I
S

F

F




โดยที่ VCC คื อไฟเลี้ ยง

VF คื อแรงดั นไบแอสตรงที่ ตกคร อม LED

IF คื อกระแสไฟฟ าท่ี ไหลผ าน LED เม่ื อได รั บไบแอสตรง

ในทางตรงก ันข าม หากจ ายแรงด ันไบแอสกล ับแก  LED  นอกจาก LED จะไม ท ํางานแล ว อาจ
ท ําให  LED เส ียหายเนื ่องจาก LED ม ีอ ัตราการทนแรงด ันย อนกล ับได ไม ส ูงน ัก เพ ียง 3 ถึ ง 10V เท านั ้น

7.3 การควบคุ ม LED ด วยไมโครคอนโทรลเลอร และโปรแกรมภาษา C

การควบค ุมการต ิด/ด ับของ LED นั ้นผู พ ัฒนาสามารถใช สั ญญาณจากจุ ดต อพอร ตใดๆ ของแผง
วงจร IPST-SE ก ็ได  โดยในการเข ียนโปรแกรมควบค ุมการต ิด/ด ับของ LED นั ้นใช กลุ มค ําสั ่งเอาต พ ุตเพื ่อ
ควบค ุมสถานะของจุ ดต อพอร ตที ่เชื ่อมต อก ับ LED

ฟ งก ชั ่นหร ือค ําสั ่งหล ักของโปรแกรมภาษา C/C++ ส ําหร ับช ุดกล องสมองกล IPST-MicroBOX
(SE) ที่ นํ ามาใช ควบคุ มการทํ างานของ LED คื อ out  ซึ่ งบรรจุ อยู ในไลบรารี  ipst_in_out.h ในการใช 
งานจึ งต องผนวกไฟล ไบรารี  ipst_in_out.h หรื อ ipst.h ด วยคํ าสั่ ง #include ที่ ส วนหั วของโปรแกรม
ก อนเสมอ ฟ งก ชั่ น out มี รู ปแบบและการเรี ยกใช ดั งนี้ 

out  เป นฟ งก ชั่ นกํ าหนดระดั บสั ญญาณหรื อข อมู ลดิ จิ ตอลไปยั งขาพอร ตท่ี กํ าหนด
รู ปแบบ

out(char _bit,char _dat)
พารามิ เตอร 

_bit - กํ าหนดขาพอร ตที่ ต องการ มี ค า 0 ถึ ง 50 สํ าหรั บ IPST-SE ใช ได ถึ ง 30
_dat - กํ าหนดข อมู ลที่ ต องการส งออก  มี ค าเป น 0 หรื อ 1

ตั วอย างที่  7-1
out(17,1); // กํ าหนดให ขาพอร ต 17 เป น “1”
out(18,0); // กํ าหนดให ขาพอร ต 18 เป น “0”
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เพื่ อให เครื่ องมื อและอุ ปกรณ อยู ในสภาพที่ พร อมทํ างานตลอดเวลา สิ่ งที่ ควรกระทํ าทุ กครั้ ง
ที่ ใช งานชุ ดกล องสมองกล IPST-MicroBOX  คื อ

1. ป ดสวิ ตช ไฟเลี้ ยงทุ กครั้ งที่ มี การถอดหรื อต อสายเข ากั บคอมพิ วเตอร และชุ ดโปรแกรม

2. ป ดสวิ ตช ไฟเลี้ ยงทุ กครั้ งที่ มี การต อหรื อปลดสายของแผงวงจรตรวจจั บสั ญญาณหรื อ
อุ ปกรณ ใดๆ เข ากั บแผงวงจรควบคุ ม  IPST-SE

3. หล ังจากที ่ทดลองเสร ็จในแต ละการทดลอง ควรป ดสว ิตช ไฟเลี ้ยงก อนที ่จะท ําการปลดสาย
สั ญญาณเพื่ อต อแผงวงจรใหม เข าไปเพื่ อทํ าการทดลองในหั วข อใหม 

4. ไม ควรปลดหรื อต อสายสั ญญาณของแผงวงจรใดๆ เข ากั บแผงวงจร IPST-SE ในขณะที่ 
แผงวงจรก ําล ังท ํางาน เว นแต ม ีขั ้นตอนการปฏ ิบ ัต ิอื ่นใดที ่ระบ ุเจาะจงว าต องสายส ัญญาณในขณะ
ทํ างานของการทดลองนั้ นๆ

5. หากมี ความผิ ดพลาดใดๆ เกิ ดขึ้ น ต องป ดสวิ ตช ไฟเลี้ ยงทั นที 

6. ไม ใช อะแดปเตอร ไฟตรงที่ มี แรงดั นขาออกเกิ น +9V กั บแผงวงจร IPST-SE

7. หลั งจากเสร็ จสิ้ นการทดลอง ให ปลดสายเชื่ อมต อคอมพิ วเตอร และสายของอะแดปเตอร 
หรื อแหล งจ ายไฟออกจากแผงวงจร IPST-SE เสมอ



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#include <ipst.h>   // ผนวกไฟล ไลบรารี หลั ก
void setup()
{}
void loop()
{
  out(17,1);     // สั่ งให  LED ที่ จุ ดต อพอร ต 17 ติ ดสว าง
  delay(500);       // หน วงเวลา 0.5 วิ นาที 
  out(17,0);        // ส่ั งให  LED ที่ จุ ดต อพอร ต 17 ดั บ
  delay(500);       // หน วงเวลา 0.5 วิ นาที 
}

โปรแกรมที ่ L1-1 : ไฟล  microbox_LedTest01.ino โปรแกรมภาษา C ส ําหร ับทดลองข ับ LED เบื ้องต น


ปฏิ บั ติ การที่  1-1 สั่ งการให  LED ติ ดสว าง

การเชื่ อมต อทางฮาร ดแวร 
 เชื่ อมต อแผงวงจร ZX-LED เข ากั บจุ ดต อพอร ต 17 ของแผงวงจรหลั ก IPST-SE
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คํ าอธิ บายโปรแกรม

โปรแกรมจะสั่ งให ส งสั ญญาณ “1” ออกมา
ทางจุ ดต อพอร ต 17 สั ญญาณ “1” มี แรงดั น
ไฟฟ า +5V จึ งทํ าให  LED ติ ดสว างได  และ
กํ าหนดให ติ ดนาน 0.5 วิ นาที  จากนั้ นจึ งสั่ งให 
ด ับด วยการส งส ัญญาณ “0” ซึ ่งม ีแรงด ันไฟฟ า
0V ท ําให ไม ม ีแรงด ันและกระแสไฟฟ าส งไปข ับ
LED ได  LED ที่ แผงวงจร ZX-LED จึ งดั บลง
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ขั ้นตอนการทดลอง
1.1.1 เป ดซอฟต แวร  Wiring 1.0 สร างไฟล ใหม  พิ มพ โปรแกรมที่  L1-1 บั นทึ กในชื่ อ microbox_LEDtest01

1.1.2 เป ดสว ิตช จ ายไฟแก แผงวงจร IPST-SE แล ว เชื ่อมต อสาย USB เข าก ับคอมพ ิวเตอร 
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1.1.3 เล ือกชน ิดหร ือรุ นของฮาร ดแวร ให ถ ูกต อง โดยเล ือกที ่เมน ู Tools > Board > IPST-SE > ATmega644P ด ังร ูป
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1.1.4  เลื อกพอร ตติ ดต อกั บแผงวงจร IPST-SE โดยเลื อกที่ เมนู  Tools > Serial Port  ดั งรู ป (ตํ าแหน งของพอร ตที่ 
ใช เชื ่อมต ออาจแตกต างก ันในคอมพ ิวเตอร แต ละเครื ่อง)

1.1.5 คอมไพล และอ ัปโหลดโปรแกรมไปย ังแผงวงจร IPST-SE โดยคล ิกที ่ปุ ม  หร ือเล ือกที ่เมน ู File > Upload

to Wiring Hardware

1.1.6 รั นโปรแกรม สั งเกตการทํ างานของ LED

LED ที่ ต อกั บจุ ดต อพอร ต 17 ติ ด-ดั บทุ กๆ 0.5 วิ นาที 

เพิ ่มเติ ม ผู พ ัฒนาสามารถก ําหนดอ ัตราในการต ิด-ด ับหร ืออ ัตราการกะพร ิบของ LED ได  ด วยการ
ปรั บค าเวลาในฟ งก ชั่ น delay(); ภายในโปรแกรมที่  L1-1

1.1.7 ทดลองแก ไขโปรแกรมที่  L1-1 ให  LED มี ความเร็ วในการติ ด-ดั บช าลง

1.1.8  ทดลองแก ไขโปรแกรมที่  L1-1 ให  LED มี ความเร็ วในการติ ด-ดั บเร็ วขึ้ น

1.1.9 ทดลองแก ไขโปรแกรมที่  L1-1 เพื่ อเปลี ยนจุ ดต อพอร ตจากเดิ มพอร ตหมายเลข 17 เป นพอร ตอื่ นๆ  เช น 18,
19 และ 20
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#include <ipst.h> // ผนวกไฟล ไลบรารี หลั ก
void setup()
{}
void loop()
{

out(17,1); // ส่ั งให  LED ที่ จุ ดต อพอร ต 17 ติ ดสว าง
delay(4000); // หน วงเวลา 4 วิ นาที 
out(17,0); // ส่ั งให  LED ที่ จุ ดต อพอร ต 17 ดั บ
while(1); // วนทํ างานที่ คํ าส่ั งนี้ 

}
คํ าอธิ บายโปรแกรม

ในโปรแกรมจะก ําหนดให เข ียนข อม ูล “1” ไปย ังขาพอร ต 17 ซึ ่งต อก ับ ZX-LED ท ําให  LED ต ิดสว างนาน
ประมาณ 4 ว ินาท ีก อนที ่จะด ับลง เนื ่องจากเมื ่อสั ่งให  LED ต ิดสว างจากการสั ่งข ับส ัญญาณเอาต พ ุตเป น “1”แล ว
ต อด วยการหน วงเวลาด วยฟ งก ชั ่น delay หร ือ sleep โปรแกรมจะท ํางานอยู ที ่ค ําสั ่งนี ้นานเป นเวลาประมาณ 4000
ม ิลล ิว ินาท ี หรื อ 4 ว ินาท ี หล ังจากครบรอบเวลา จ ึงส งส ัญญาณ “0” เพื ่อควบค ุมให  LED ด ับ และวนอยู ที่ คํ าสั่ ง
while(); ทํ าให ไม มี การทํ างานใดๆ LED จึ งดั บจนกว าจะมี การกดสวิ ตช  RESET หรื อป ดเป ดไฟเลี้ ยงใหม 

โปรแกรมที ่ L1-2 : ไฟล  microbox_Ledtimer.c โปรแกรมภาษา C ส ําหร ับทดลอง
ควบค ุมการท ํางานของ LED ด วยเวลา

ปฏิ บั ติ การที่  1-2 ควบคุ ม LED ด วยเวลา

การเชื ่อมต อทางฮาร ดแวร 
 เชื ่อมต อแผงวงจร ZX-LED ก ับจ ุดต อพอร ต 17 ของแผงวงจรหล ัก IPST-SE

ขั ้นตอนการทดลอง
1.2.1 เป ดซอฟต แวร  Wiring 1.0 สร างไฟล ใหม  พิ มพ โปรแกรมที่  L1-2 บั นทึ กในชื่ อ microbox_LEDtimer

1.2.2  ¤Í Áä¾Åì áÅÐÍÑ »âËÅ´ â»Ãá¡ ÃÁä»ÂÑ §á¼§Ç§̈ Ã IPST-SE ấ Â¤ÅÔ ¡ ·Õè »Øè Á  หร ือเล ือกที ่เมน ู File > Upload

to Wiring Hardware

1.2.3 รั นโปรแกรม สั งเกตการทํ างานของ LED

LED จะติ ดนาน 4 วิ นาที  หลั งจากนั้ นจึ งดั บลง

1.2.4 แก ไขโปรแกรมที่  L1-2 ให  LED ติ ดสว างนานขึ้ น

1.2.5 แก ไขโปรแกรมที่  L1-2 ให  LED ดั บเร็ วขึ้ น
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ในบทที่ ผ านมาเป นการนํ าเสนอการควบคุ ม LED ด วยกระบวนการทางซอฟต แวร  แต  LED
ที่ ควบคุ มนั้ นมี เพี ยงช องเดี ยว ในบทนี้ นํ าเสนอการควบคุ ม LED ในจํ านวนมากช องขึ้ นถึ ง 8 ช องใน
เวลาเดี ยวกั น

อุ ปกรณ เอาต พุ ตที่ นํ ามาใช ในการเรี ยนรู คื อ แผงวงจร ZX-LED8 ซึ่ งมี  LED 8 ดวงพร อมวงจร
ประกอบ การควบคุ ม LED ทั้ ง 8 ดวงให ทํ างานพร อมกั น หรื อทํ างานแยกกั นต องใช ความรู เกี่ ยวกั บ
ระบบเลขฐานสองและโครงสร างของข อม ูลทั ้งแบบบ ิตและไบต ในการก ําหนดร ูปแบบของข อม ูลที ่น ํา
มาแสดงผล

8.1 เลขฐานสอง

ในระบบตั วเลขฐานสองนี้ มี ตั วเลขเพี ยง 2 ตั วคื อ “0” และ “1” ซึ่ งสามารถใช แทนสถานะตํ่ า
สู ง, เป ด-ป ด, ไม ต อ-ต อ, ดั บ-ติ ด เป นต น แต ถ าหากนํ าตั วเลขฐานสองมากกว า 1 หลั กมาพิ จารณา
เช น 2 หล ัก จะท ําให เก ิดจ ํานวนของการเปลี ่ยนแปลงเป น 4 สถานะ หากแทนด วยการต ิด-ด ับของหลอด
ไฟ จะได  ดั บ-ดั บ, ดั บ-ติ ด, ติ ด-ดั บ และติ ด-ติ ด ถ าหากมี  3 หลั กก็ จะเกิ ดการเปลี่ ยนแปลง 8 สถานะ
จ ึงสามารถสร ุปเป นสมการคณ ิตศาสตร และความส ัมพ ันธ ของจ ํานวนหล ักและสถานะของการเปลี ่ยน
แปลงได ดั งนี้ 

จํ านวนของการเปลี่ ยนแปลง = 2 จํ านวนหลั ก

ถ ามี  2 หลั กจะได จํ านวนของการเปลี่ ยนแปลง 22 = 4

ถ ามี  3 หลั กจะได จํ านวนของการเปลี่ ยนแปลง 23 = 8

ถ ามี  4 หลั กจะได จํ านวนของการเปลี่ ยนแปลง 24 = 16





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8.1.1 การนั บจํ านวนของระบบเลขฐานสอง
เนื ่องจากเลขฐานสองม ีต ัวเลขเพ ียง 2 ต ัวค ือ 0  และ 1 เมื ่อม ีการน ับจ ํานวนขึ ้น จ ึงต องม ีการเพิ ่ม

จ ํานวนหล ัก ด ังนั ้นเพื ่อให เห ็นการเปลี ่ยนแปลงอย างช ัดเจนจะใช เลขฐานส ิบเป นต ัวเปร ียบเท ียบด ังนี ้

เลขฐานสอง เลขฐานสิ บ

00 0

01 1

10 2

11 3

100 4

101 5

110 6

111 7

1000 8

1001 9

1010 10

1011 11

1100 12

1101 13

1110 14

1111 15

8.1.2 ตั วแปรของเลขฐานสอง (bit variables)
เมื ่อเลขฐานสองถ ูกน ํามาใช งานมากขึ ้นจาก 1 หล ักเป น 2, 3 จนถ ึง 8 หล ัก ท ําให เก ิดต ัวแปรใหม ๆ  ด ังนี ้

(1) บิ ต (bit) หมายถึ ง หนึ่ งหลั กของเลขฐานสอง (binary digit) มี เลข 0 กั บ 1 เท านั้ น

(2) ไบต  (byte) หมายถ ึง เลขฐานสองจ ํานวน 8 หล ักหร ือเท าก ับ 8 บ ิต ไบต ม ีความส ําค ัญ
มากเพราะในระบบคอมพ ิวเตอร จะประมวลข อม ูลเลขฐานสองครั ้งละ 8 บ ิตหร ือ 1 ไบต เป นอย างน อยเสมอ

(3) LSB : Least Significant Bit หร ือบ ิตน ัยส ําคั ญตํ ่าส ุด หมายถ ึง บ ิตที ่อยู ในต ําแหน ง
ขวาสุ ดของเลขฐานสอง มี ค านํ้ าหนั กประจํ าหลั กตํ่ าสุ ดคื อ 20 ถ าเป น “1” ค าของหลั กสุ ดท ายเท ากั บ 1
x 20 = 1 x 1 = 1 แต ถ าบิ ตสุ ดท ายนี้ เป น “0” ค าของหลั กสุ ดท ายจะเท ากั บ 0 x 20 = 0 x 1= 0
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(4) การกํ าหนดชื่ อหลั กของเลขฐานสอง บิ ตที่ อยู ขวามื อสุ ดจะถู กเรี ยกว า บิ ตศู นย  (bit
0 : b0) หรื อบิ ต LSB บิ ตถั ดมาเรี ยกว า บิ ตหนึ่ ง (bit 1 : b1) ไล ไปทางซ ายจนครบ สามารถสรุ ปชื่ อหลั ก
ของเลขฐานสองได คื อ  b7  b6  b5  b4  b3  b2  b1  b0 โดยตั วเลขแสดงตํ าแหน ง 0-7 ต องเขี ยนเป นตั วห อย
เสมอ แต เพื่ อความสะดวกจึ งขอเขี ยนในระดั บเดี ยวกั นเป น b7  b6  b5  b4  b3 b2  b1  b0

(5) MSB : Most Significant Bit หร ือบ ิตน ัยสํ าค ัญส ูงส ุด หมายถ ึงบ ิตที ่อยู ในตํ าแหน ง
ซ ายมื อสุ ดของเลขฐานสองจํ านวนนั้ นๆ หากเลขฐานสองมี จํ านวน 8 บิ ต บิ ต MSB คื อบิ ต 7 (bit 7 :
b7) มี ค านํ้ าหนั กประจํ าหลั กเท ากั บ 27 หรื อ 128 แต ถ าหากจํ านวนบิ ตมี น อยกว านั้ น เช น 6 บิ ต, 5 บิ ต
หรื อ 4 บิ ต บิ ต MSB จะมี ค านํ้ าหนั กประจํ าหลั กเปลี่ ยนเป น 25, 24 และ 23 ตามลํ าดั บ

8.1.3 ค านํ้ าหนั กประจํ าหลั ก
ในเลขฐานสิ บจะมี ค านํ้ าหนั กประจํ าหลั ก โดยคิ ดจากจํ านวนสิ บยกกํ าลั ง โดยในหลั กหน วยมี 

ค านํ้ าหนั กประจํ าหลั กเป น 100 หรื อ 1 หลั กสิ บมี ค านํ้ าหนั กประจํ าหลั กเป น 101 หรื อ 10 ในหลั กร อย
มี ค านํ้ าหนั กประจํ าหลั กเป น 102 หรื อ 100  เป นต น

ในเลขฐานสองก ็ม ีค านํ ้าหน ักประจ ําหล ักเช นก ัน แต จะค ิดจากจ ํานวนสองยกก ําล ัง โดยในหล ัก
ขวาสุ ดคื อ บิ ต 0 หรื อบิ ต  LSB มี ค านํ้ าหนั กประจํ าหลั กเป น 20 หรื อเท ากั บ 1 หลั กถั ดมาคื อบิ ต 1 มี ค า
นํ้ าหนั กเป น 21 หรื อ 2  ถั ดมาเป นบิ ต 2 มี ค านํ้ าหนั กเป น 22 หรื อ 4 เมื่ อพิ จารณาที่ เลขฐานสอง 8 บิ ต
ค านํ้ าหนั กประจํ าหลั กสามารถสรุ ปได ดั งนี้ 

บิ ต ค านํ้ าหนั กประจํ าหลั ก เลขฐานสิ บ

0 20 1

1 21 2

2 22 4

3 23 8

4 24 16

5 25 32

6 26 64

7 27 128

จากค านํ ้าหน ักประจ ําหล ักจ ึงสามารถแปลงเลขฐานสองเป นฐานส ิบ หร ือแปลงฐานส ิบเป นฐาน
สองได 
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8.2 การแปลงเลขฐานสองและฐานสิ บ

8.2.1 การแปลงเลขฐานสองเป นฐานสิ บ
เริ่ มต นด วยการกํ าหนดค านํ้ าหนั กประจํ าหลั กของเลขฐานสองแต ละหลั ก แล วคู ณด วยค าของ

เลขฐานสองในหลั กนั้ นๆ สุ ดท ายนํ าผลคู ณทั้ งหมดมารวมกั น ก็ จะได เป นเลขฐานสิ บที่ ต องการ

ตั วอย างที่  8-1
จงแปลงเลขฐานสอง 1011 เป นฐานสิ บ

(1) กํ าหนดค านํ้ าหนั กประจํ าหลั ก

หลั ก b3 b2 b1 b0
ค านํ้ าหนั กประจํ าหลั กคื อ 23 22 21 20

เลขฐานสอง 1 0 1 1

(2) จากนั ้นน ําค านํ ้าหน ักประจ ําหล ักค ูณก ับค าของเลขฐานสองประจ ําบ ิตนั ้นแล ว น ําผลค ูณของท ุกหล ัก
มารวมกั น

เลขฐานสิ บ = (1x23) + (0x22) + (1x21) + (1x20)
= (1x8) + (0x4) + (1x2) + (1x1)
= 8+0+2+1
= 11

8.2.2 การแปลงเลขฐานสิ บเป นเลขฐานสอง
จะใช ว ิธ ีการหารเลขฐานส ิบจ ํานวนนั ้นด วย 2 แล วเก ็บค าของเศษที ่ได จากการหารเป นเลขฐานสอง

ในแต ละหล ัก โดยเศษที ่ได จากการหารครั ้งแรกไม ว าจะเป น “0” หร ือ “1” จะเป นหล ักที ่ม ีน ัยส ําค ัญตํ ่าส ุด
หร ือบ ิต LSB หร ือบ ิต 0 (b0) และเศษต ัวส ุดท ายจะเป นเลขฐานสองหล ักที ่ม ีน ัยส ําค ัญส ูงส ุดหร ือบ ิต MSB

ตั วอย างที่  8-2
จงแปลงเลขฐานสิ บ 13 เป นเลขฐานสอง

(1) หาร 13 ด วย 2 ได  6 เศษ 1 เศษที่ ได จะเป นบิ ตศู นย  (bo) หรื อบิ ต LSB นั่ นคื อ บิ ต LSB = 1

(2) หาร 6 ด วย 2 ได  3 เศษ 0 เศษที่ ได จะเป นบิ ตหนึ่ ง (b1) ซึ่ งก็ คื อ 0

(3) หาร 3 ด วย 2 ได  1 เศษ 1 เศษที่ ได จะเป นบิ ตสอง (b2) ซึ่ งก็ คื อ 1

(4) หาร 1 ด วย 2 ได  0 เศษ 1 เศษที่ ได จะเป นบิ ตสาม (b3) และเป นบิ ต MSB ซึ่ งก็ คื อ 1

ดั งนั้ นจะได เลขฐานสองเท ากั บ 1101
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8.3 เคร่ื องหมายของเลขฐานสอง
ในเลขฐานสองสามารถที ่จะม ีทั ้งค าต ัวเลขที ่เป นบวกและลบเช นเด ียวก ับเลขฐานอื ่นๆ โดยจะ

ใช บิ ต MSB เป นตั วกํ าหนดเครื่ องหมายของเลขฐานสอง ถ ากํ าหนดบิ ต MSB เป น “0” เลขจํ านวน
นั้ นจะมี ค าเป นบวก และหากกํ าหนดบิ ต MSB เป น “1” เลขจํ านวนนั้ นจะมี ค าเป นลบ

ข อม ูลต อไปนี ้จะเป นการแสดงค าของจ ํานวนเลขฐานสอง เมื ่อค ิดเครื ่องหมายและไม ค ิดเครื ่อง
หมายโดยได ทํ าการแปลงเป นเลขฐานสิ บเปรี ยบเที ยบเพื่ อให เห็ นความแตกต างอย างชั ดเจน

เลขฐานสอง เลขฐานสิ บ

คิ ดเคร่ื องหมาย ไม คิ ดเคร่ื องหมาย
0000 0 0
0001 1 1
0010 2 2
0011 3 3
0100 4 4
0101 5 5
0110 6 6
0111 7 7
1000 -  8 8
1001 -  7 9
1010 -  6 10
1011 -  5 11
1100 -  4 12
1101 -  3 13
1110 -  2 14

1111 -  1 15

ในกรณี คิ ดเครื่ องหมาย เมื่ อนั บถอยหลั งจาก 0000 ก็ จะเป น 1111 นั่ นคื อเกิ ดการถอยหลั งหนึ่ ง
จํ านวนหรื อ -1 นั บถอยหลั งต อไปจะเป น 1110 ซึ่ งก็ คื อ -2 เมื่ อเป นเช นนี้ การแปลงเลขฐานสองที่ คิ ด
เครื ่องหมายเป นฐานส ิบจ ึงไม สามารถใช ว ิธ ีการแปลงแบบเด ิมได  แต ก ็พอม ีเทคน ิคในการพ ิจารณา โดย
ใช หลั กเกณฑ ค านํ้ าหนั กประจํ าหลั ก ยกตั วอย าง เลขฐานสอง 1000 เลข 1 ที่ อยู หน าสุ ด มี ค านํ้ าหนั ก
ประจํ าหลั กเท ากั บ 23 หรื อ 8 จากการกํ าหนดว า ถ าคิ ดเครื่ องหมาย เมื่ อบิ ต MSB เป น “1” จะต องเป น
ค าลบ ดั งนั้ นจึ งเป น -8 ส วนอี ก 3 หลั กที่ เหลื อจะเป นเลขบวกจึ งกลายเป น -8+0  = -8 มาพิ จารณาที่ เลข
ฐานสอง 1101 บิ ตแรกเป นลบเท ากั บ -8 ส วน 3 บิ ตหลั งเป นบวกมี ค า +5 จึ งได  -8+5= -3 เป นต น
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8.4 ส วนประกอบของข อมู ล

ข อม ูลที ่ใช ในการประมวลผลของไมโครคอนโทรลเลอร นั ้นสามารถกระท ําได ตั ้งแต  1 บ ิตขึ ้นไป
ส ําหร ับไมโครคอนโทรลเลอร  ATmega644 ในช ุด IPST-MicroBOX  จะท ํางานก ับข อม ูล 1 ถ ึง 16 บ ิต
โดยม ีการก ําหนดโครงสร างส วนประกอบของข อม ูลที ่เป นมาตรฐานเด ียวก ับไมโครคอนโทรลเลอร ต ัวอื ่น
ทั ่วโลกและเหม ือนก ับในคอมพ ิวเตอร ด วย ด ังนี ้

1 0 1 0 0 1 0 1

15

คาน้ําหนัก

ขอมูล *

* สามารถเปล่ียนแปลงได

ไบตสูง (8 บิตบน) ไบตตํ่า (8 บิตลาง)

เวิรด

บิต
0110111 1

14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

211 210 29 28 27 26 25 24 23 22 21 20212213214215

LSBMSB

บ ิต-น ิบเบ ิล-ไบต -เว ิร ด เป นชื ่อหน วยของข อม ูลที ่ใช ในการประมวลผลของไมโครคอนโทรลเลอร 

บิ ต (bit) เป นขนาดของข อมู ลเลขฐานสองที่ เล็ กที่ สุ ด เท ากั บ 1 หลั กของเลขฐานสอง

นิ บเบิ ล (nibble) มี ขนาดเท ากั บ 4 บิ ต

ไบต  (byte) มี ขนาดเท ากั บ 8 บิ ต

เวิ ร ด (word) มี ขนาดเท ากั บ 16 บิ ต หรื อ 2 ไบต 

8.5 แผงวงจรไฟแสดงผล 8 ดวง  : ZX-LED8
เป นแผงวงจรที ่ม ี LED ขนาด 3 ม ิลล ิเมตรส ําหร ับแสดงผล 8 ดวง พร อมจ ุดต อพ วงเอาต พ ุตเพื ่อ

น ําไปใช ในการข ับร ีเลย ได ด วย โดยแผงวงจร ZX-LED8 นี ้จะต อเข าก ับขาพอร ตใดของแผงวงจร IPST-
SE ก ็ได  โดยใช ขาพอร ตเพ ียงขาเด ียวในการควบค ุมและข ับ LED ให ต ิดด ับตามที ่ต องการได พร อมก ัน
ถึ ง 8 ดวง มี หน าตาและวงจรทางไฟฟ าของแผงวงจร ZX-LED8 แสดงในรู ปที่  8-1

ในแผงวงจร ZX-LED8 ใช การติ ดต อกั บแผงวงจรหลั ก IPST-SE ในแบบสื่ อสารข อมู ลอนุ กรม
ร วมกั บคํ าสั่ งทางซอฟต แวร  ผู พั ฒนาโปรแกรมสามารถเขี ยนโปรแกรมให  ZX-LED8 ติ ดดั บได ตั้ งแต 
1 ถึ ง 8 ตั ว หรื อจะเขี ยนโปรแกรมให ทํ างานเป นไฟวิ่ งได ตั้ งแต  1 ถึ ง 8 ดวงเช นกั น
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ร ูปที ่ 8-1 ล ักษณะและวงจรทางไฟฟ าของแผงวงจรไฟแสดงผล ZX-LED8 ที ่ใช ในช ุดกล องสมองกล IPST-
MicroBOX (SE)
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ที่ ด านบนของแผงวงจร ZX-LED8 มี จุ ดต อ JST ซึ่ งต อพ วงมาจาก LED ทํ างานที่ ลอจิ ก “1” มี 
ระดั บแรงดั นไฟตรงขาออกประมาณ +5V ดั งแสดงในรู ปที่  8-3 จึ งสามารถใช สั ญญาณเอาต พุ ตจากจุ ด
นี ้ไปต อก ับวงจรข ับโหลดกระแสไฟฟ าส ูง อาท ิ แผงวงจรข ับร ีเลย  ได ท ันท ี โดยไม ต องเข ียนโปรแกรม
ควบคุ มเพิ่ มเติ ม

8.6 กลุ มคํ าสั่ งโปรแกรมภาษา C/C++ ของไลบรารี  ipst.h ที่ ใช ควบคุ ม LED
8 ดวงบนแผงวงจร ZX-LED8

pinLED8(); ใช กํ าหนดจุ ดต อพอร ตของแผงวงจร IPST-SE ที่ ต อกั บแผงวงจร ZX-LED8
LED8 ใช กํ าหนดค าการแสดงผลของ LED 8 ดวงบนแผงวงจร ZX-LED8

รู ปที่  8-2 แนวทางการต อใช งานแผงวงจรไฟแสดงผล ZX-LED8 กั บแผงวงจรหลั ก IPST-SE ในชุ ดกล อง
สมองกล IPST-MicroBOX (SE)
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



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รู ปที่  8-3 แสดงความสั มพั นธ ของการติ ดดั บของ LED กั บระดั บแรงดั นไฟฟ าที่ จุ ดต อเอาต พุ ต 0 ถึ ง 7
ของแผงวงจรไฟแสดงผล ZX-LED8
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
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
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


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
ปฏิ บั ติ การที่  2-1 ควบคุ ม LED ด วยข อมู ลเลขฐานสอง

ในการทดลองนี ้เป นการเข ียนโปรแกรมภาษา C เพื ่อควบค ุมให  LED 8 ดวงบนแผงวงจร ZX-LED8 ต ิดหร ือ
ดั บด วยข อม ูลที่ กํ าหนดไว 

การเชื่ อมต อทางฮาร ดแวร 
 เชื่ อมต อสั ญญาณจากจุ ดต อ 20 ของแผงวงจรหลั ก IPST-SE เข ากั บจุ ดต อ RXD ของแผงวงจร ZX-LED8 ด วย
สายสั ญญาณ JST3AA-8

ขั ้นตอนการทดลอง
2.1.1 เป ดซอฟต แวร  Wiring 1.0 สร างไฟล ใหม  พิ มพ โปรแกรมที่  L2-1 บั นทึ กในชื่ อ microbox_LED8test.ino

2.1.2 คอมไพล และอ ัปโหลดโปรแกรมไปย ังแผงวงจร IPST-SE โดยคลิ กที ่ปุ ม  

รู ปที่  L2-1 การต อวงจรเพื่ อทํ าการทดลองสํ าหรั บปฏิ บั ติ การที่  2 และ 3
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2.1.3 สั งเกตผลการทํ างานที่ แผงวงจร ZX-LED8

LED ที่ หลั ก 0 และ 7 ของแผงวงจร ZX-LED8 ติ ดสว าง จากผลของข อมู ล 10000001 ที่ กํ าหนดใน
โปรแกรม

7 6 5 4 3 2 1 0

2.1.4 ทดลองแก ไขข อม ูลแสดงผลเป น LED8(0b11110000); ท ําการคอมไพล และอ ัปโหลดโปรแกรมไปย ังแผงวงจร
IPST-SE

ได ผลการทํ างานด ังนี้ 

7 6 5 4 3 2 1 0

2.1.5 ทดลองแก ไขข อมู ลแสดงผลเป น led8(0b00011000); ทํ าการคอมไพล ไฟล โปรเจ็ กต ใหม  แล วดาวน โหลด
โปรแกรมไปยั งแผงวงจร IPST-SE

ได ผลการทํ างานด ังนี้ 

7 6 5 4 3 2 1 0

#include <ipst.h> // ผนวกไลบรารี หลั ก
void setup()
{
  pinLED8(20);  // เชื่ อมต อ ZX-LED8 ผ านทางจุ ดต อพอร ต 20
}

void loop()
{
  LED8(0b10000001);  // LED บิ ต 7 และ 0 ติ ดสว าง ที่ เหลื อดั บหมด
}
คํ าอธิ บายโปรแกรม

การทํ างานของโปรแกรมนี้  ข อมู ลเลขฐานสอง 10000001 ถู กส งไปยั งแผงวงจร ZX-LED8 ผ านฟ งก ชั่ น
LED8 โดยใช จุ ดต อพอร ต 20 ซึ่ งประกาศไว ด วยฟ งก ชั่ น pinLED8 ที่ ส วนของ setup()

ข อมู ล 8 บิ ตที่ ส งไปในรู ปของเลขฐานสองสามารถเที ยบเคี ยงได กั บตํ าแหน งหลั กของ LED ทั้ ง 8 ดวง
นั่ นเอง โดยค าของหลั กข อมู ลใดเป น “1” LEDประจํ าหลั กนั้ นจะติ ดสว าง ในทางกลั บกั นถ ามี ค าเป น “0” LED
ก็ จะดั บ ดั งนั้ นถ าทํ าการแก ไขโปรแกรมเพื่ อส งค าใหม จะได ผลลั พธ ที่ แตกต างกั นไป

โปรแกรมที ่ L2-1 : ไฟล  microbox_LED8test.ino โปรแกรมภาษา C ส ําหร ับทดลองควบค ุม LED 8 ดวง
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2.1.6 เขี ยนโปรแกรมที่  L2-2 บั นทึ กไฟล เป น microbox_LED8binary.ino จากนั้ นทํ าการคอมไพล และอั ปโหลด

โปรแกรมไปย ังแผงวงจร IPST-SE โดยคล ิกที ่ปุ ม 

2.1.6 สั งเกตผลการทํ างานที่ แผงวงจร ZX-LED8

LED ทั้ ง 8 ดวงแสดงเป นรหั สเลขฐานสอง 8 บิ ต เริ่ มจาก 00000000 ถึ ง 11111111 แล วกลั บมาเริ่ มต น
ที่  00000000 ใหม อี กคร้ั ง โดยมี อั ตราการเปลี่ ยนข อมู ลทุ กๆ  0.3 วิ นาที 

#include <ipst.h>     // ผนวกไลบรารี หลั ก
void setup()
{}
void loop()
{

unsigned char i=0;
while(1)
{

LED8(20,i++);  // กํ าหนดให ใช จุ ดต อพอร ต 20 ในการควบคุ ม ZX-LED8
// โดยแสดงผลด วยค าของ i ที่ เปล่ี ยนแปลงจาก 00000000 ถึ ง 11111111

delay(300);
}

}

คํ าอธิ บายโปรแกรม

การท ํางานของโปรแกรมนี ้ ข อม ูลเลขฐานสองที ่ก ําหนดโดยต ัวแปร i ถ ูกส งออกไปย ังแผงวงจร ZX-LED8
ผ านฟ งก ชั่ น LED8 ที่ เขี ยนในแบบใหม  ให เหลื อเพี ยงบรรทั ดเดี ยว โดยกํ าหนดพอร ตที่ ใช ในการติ ดต อแล วต อ
ด วยข อมู ลที่ ต องการแสดงผล ทํ าให โปรแกรมกระชั บขึ้ น

โดยข อมู ล 8 บิ ตที่ ส งไปในรู ปของเลขฐานสองนั้ นมี ค า 00000000 ถึ ง 11111111 ตามชนิ ดของตั วแปร i
ที่ กํ าหนดให เป นแบบ char ซึ่ งมี ขนาด 8 บิ ต

โปรแกรมที ่ L2-2 : ไฟล  microbox_LED8binary.ino โปรแกรมภาษา C/C++ ส ําหร ับทดลองควบค ุม LED 8
ดวง ให แสดงผลตามค าของเลขฐานสองขนาด 8 บ ิต จาก 00000000 ถ ึง 11111111
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ปฏิ บั ติ การที่  2-2 ไฟกะพริ บ LED 8 ดวง
ในการทดลองนี ้เป นการเข ียนโปรแกรมแกรมควบค ุมให  LED 8 ดวงบนแผงวงจร ZX-LED8 ต ิดหร ือด ับด วย

ข อมู ลที่ กํ าหนด โดยในการทดลองนี้ จะส งข อมู ล 11111111 ไปแสดงผลในแบบไฟกะพริ บ

การเชื่ อมต อทางฮาร ดแวร 
 เชื่ อมต อสั ญญาณจากจุ ดต อ 20 ของแผงวงจรหลั ก IPST-SE เข ากั บจุ ดต อ RXD ของแผงวงจร ZX-LED8 ด วย
สายสั ญญาณ JST3AA-8

ขั้ นตอนการทดลอง
2.2.1 เป ดซอฟต แวร  Wiring 1.0 สร างไฟล ใหม  พิ มพ โปรแกรมที่  L2-3 บั นทึ กในชื่ อ microbox_LED8blink.ino

2.2.2 คอมไพล และอ ัปโหลดโปรแกรมไปย ังแผงวงจร IPST-SE โดยคลิ กที ่ปุ ม  

2.2.3 รั นโปรแกรม สั งเกตการทํ างานของ LED 8 ดวงบนแผงวงจร ZX-LED8

LED ทั้ ง 8 ดวงของแผงวงจร ZX-LED8 ติ ดกะพริ บในทุ กๆ 1 วิ นาที  โดยประมาณ

#include <ipst.h> // ผนวกไลบรารี หลั ก
void setup()
{}
void loop()
{

LED8(20,0b11111111); // กํ าหนดให  LED ทั้ ง 8 ดวงติ ดหมด
sleep(500); // หน วงเวลา 0.5 วิ นาที 
LED8(20,0b00000000); // กํ าหนดให  LED ทั้ ง 8 ดวงดั บหมด
sleep(500); // หน วงเวลา 0.5 วิ นาที 

}

คํ าอธิ บายโปรแกรม

การทํ างานของโปรแกรมนี้  มี ข อมู ลเลขฐานสอง 2 ชุ ดที่ ส งออกไปยั งแผงวงจร ZX-LED8 ด วยฟ งก ชั่ น
LED8 ที่ เขี ยนในแบบกํ าหนดพอร ตที่ ใช ในการติ ดต อแล วต อด วยข อมู ลที่ ต องการแสดงผล โดยชุ ดแรกคื อ
11111111 ทํ าให  LED 8 ดวงติ ดสว างทั้ งหมด ส วนชุ ดที่  2 คื อ 00000000 ทํ าให  LED ทั้ งหมดดั บ

อั ตราการติ ดดั บหรื อกะพริ บถู กกํ าหนดโดยฟ งก ชั่ น sleep() ซึ่ งมี การทํ างานเหมื อนกั บ delay() โดยใน
โปรแกรมนี้ กํ าหนดให เท ากั บ 500 มิ ลลิ วิ นาที หรื อ 0.5 วิ นาที 

โปรแกรมที่  L2-3 : ไฟล  microbox_LED8blink.ino โปรแกรมภาษา C/C++ สํ าหรั บควบคุ ม LED กะพริ บ
พร อมกั น 8 ดวง
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


ปฏิ บั ติ การที่  3-1 ไฟวิ่ ง LED 8 ดวง
ในการทดลองนี ้เป นการเข ียนโปรแกรมภาษา C เพื ่อควบค ุมให  LED 8 ดวงบนแผงวงจร ZX-LED8 ท ํางาน

ในลั กษณะไฟวิ่ งทางซ ายและขวา

การเชื่ อมต อทางฮาร ดแวร 
 เชื่ อมต อสั ญญาณจากจุ ดต อ 20 ของแผงวงจรหลั ก IPST-SE เข ากั บจุ ดต อ RXD ของแผงวงจร ZX-LED8 ด วย
สายสั ญญาณ JST3AA-8 (รู ปที่  L2-1 ในปฏิ บั ติ การที่  2 ของบทที่  8)

ขั ้นตอนการทดลอง
3.1.1 เป ดซอฟต แวร  Wiring 1.0 สร างไฟล ใหม  พิ มพ โปรแกรมที่  L3-1 บั นทึ กในชื่ อ microbox_LED8running.ino

3.1.2 คอมไพล และอั ปโหลดโปรแกรมไปยั งแผงวงจร IPST-SE โดยคลิ กที่ ปุ ม  

3.1.3 รั นโปรแกรม สั งเกตการทํ างานของ LED 8 ดวงบนแผงวงจร DSP-4

LED จะติ ดครั้ งละ 1 ดวงจากตํ าแหน งที่ อยู ทางขวาสุ ด (บิ ต 0) ไล มาตามลํ าดั บในลั กษณะไฟวิ่ งจาก
ขวาไปซ ายจนสุ ดทางขวา (บิ ต 7) จากนั้ นจะไล กลั บทิ ศทางเป นติ ดจากดวงซ ายสุ ด (บิ ต 7) กลั บมายั งดวงขวา
สุ ด (บิ ต 0) ในลั กษณะไฟวิ่ งจากซ ายมาขวา วนทํ างานเช นนี้ ไปตลอด

7 6 5 4 3 2 1 0

7 6 5 4 3 2 1 0

7 6 5 4 3 2 1 0

7 6 5 4 3 2 1 0

7 6 5 4 3 2 1 0


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โปรแกรมที ่ L3-1 : ไฟล  microbox_LED8running.ino โปรแกรมภาษา C/C++ ส ําหร ับทดลองควบค ุมไฟวิ ่ง
LED 8 ดวง

#include <ipst.h> // ผนวกไฟล ไลบรารี หลั ก
void setup()
{

 // แสดงข อความของการทดลอง
glcdClear();
glcd(0,0,"Example: LED8_02");
glcd(2,0,"connect LED8 to (20)");
glcd(4,0,"LED running LEFT");
glcd(5,0,"           and RIGHT");

pinLED8(20); // ใช จุ ดต อพอร ต 20 ในการเชื่ อมต อ
}

void loop()
{

int i;
for (i=0;i<8;i++) // กํ าหนดให เลื่ อนข อมู ลไปทางซ าย
{

LED8(0x01<<i); // เลื่ อนบิ ตไปทางซ ายแล วส งไปแสดงที่  ZX-LED8 โดยมี ค าตั้ งต นที่  00000001
delay(300); // หน วงเวลา 0.3 วิ นาที 

  }
  for (i=6;i>0;i--) // กํ าหนดให เลื่ อนข อมู ลไปทางขวา
  {
    LED8(0x01<<i); // เลื่ อนบิ ตไปทางขวาแล วส งไปแสดงที่  ZX-LED8
    delay(300); // หน วงเวลา 0.3 วิ นาที 
  }
}
คํ าอธิ บายโปรแกรม

โปรแกรมนี ้ท ํางานโดยอาศ ัยการส งข อม ูลผ านฟ งก ชั ่น LED8 เพื ่อให  LED ต ิดครั ้งละ 1 ดวงนานประมาณ
0.3 วิ นาที  โดยไล ลํ าดั บจากบิ ต 0 ไปยั งบิ ต 7 และวนกลั บจากบิ ต 7 กลั บมายั งบิ ต 0 เป นเช นนี้ อย างต อเนื่ อง

การทํ างานของ LED ในลั กษณะไฟวิ่ งนี้ ของโปรแกรมนี้ เกิ ดจากการเลื่ อนบิ ตข อมู ลทั้ งทางซ ายและขวา
โดยหลั งจากเลื่ อนข อมู ล 1 คร้ั งก็ จะส งไปแสดงผลนาน 0.3 วิ นาที  จากนั้ นจึ งเลื่ อนข อมู ลในครั้ งต อไป

ด านอ ัตราเร ็วในการแสดงผลของ LED จะข้ึ นอยู ก ับค าหน วงเวลาของฟ งก ชั ่น delay (หร ืออาจใช  sleep
ก็ ได ) ถ ากํ าหนดให มี ค าน อยกว า 300 ก็ จะทํ าให  LED แสดงผลการเปลี่ ยนแปลงได เร็ วมากข้ึ น นั่ นคื อ ได เห็ น
ไฟวิ ่งเร ็วขึ ้นนั ่นเอง
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ปฏิ บั ติ การที่  3-2 ขั บ LED 8 ดวง ด วยรู ปแบบข อมู ลที่ กํ าหนดล วงหน า
ในการทดลองนี ้เป นการเข ียนโปรแกรมภาษา C เพื ่อควบค ุมให  LED 8 ดวงบนแผงวงจร ZX-LED8 ท ํางาน

ในลั กษณะไฟวิ ่งตามรู ปแบบข อม ูลที ่กํ าหนดไว ล วงหน า โดยใช ตั วแปรแบบอะเรย ในการเก็ บตารางรู ปแบบข อม ูล

การเชื่ อมต อทางฮาร ดแวร 
 เชื่ อมต อสั ญญาณจากจุ ดต อ 20 ของแผงวงจรหลั ก IPST-SE เข ากั บจุ ดต อ RXD ของแผงวงจร ZX-LED8 ด วย
สายสั ญญาณ JST3AA-8 (รู ปที่  L2-1 ในปฏิ บั ติ การที่  2 ของบทที่  8)

ขั้ นตอนการทดลอง
3.2.1 เป ดซอฟต แวร  Wiring 1.0 สร างไฟล ใหม  พิ มพ โปรแกรมที่  L3-2 บั นทึ กในชื่ อ microbox_LED8pattern.ino

3.2.2 คอมไพล และอ ัปโหลดโปรแกรมไปย ังแผงวงจร IPST-SE โดยคลิ กที ่ปุ ม  

3.2.3 รั นโปรแกรม สั งเกตการทํ างานของ LED 8 ดวงบนแผงวงจร ZX-LED8

LED จะติ ดตามข อมู ลที่ กํ าหนด ซึ่ งมี ด วยกั น 4 แบบ โดยเร่ิ มจากแบบที่  1 ไปถึ ง 4 แล วทํ างานย อนกลั บ
จากแบบที่  4 มายั งแบบที่  1 วนทํ างานเช นนี้ ไปตลอด

7 6 5 4 3 2 1 0

7 6 5 4 3 2 1 0


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7 6 5 4 3 2 1 0

















7 6 5 4 3 2 1 0

7 6 5 4 3 2 1 0

7 6 5 4 3 2 1 0

7 6 5 4 3 2 1 0
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โปรแกรมที ่ L3-2 : ไฟล  microbox_LED8pattern.ino โปรแกรมภาษา C/C++ ส ําหร ับควบค ุมไฟวิ ่ง LED 8
ดวง ในแบบก ําหนดร ูปแบบการแสดงผลด วยต ัวแปรชน ิดอะเรย 

#include <ipst.h> // ผนวกไลบรารี หลั ก

int pattern[]={ // กํ าหนดรู ปแบบข อมู ลแสดงผล
  0b00011000, // รู ปแบบข อมู ล #1
  0b00111100, // รู ปแบบข อมู ล #2
  0b01111110, // รู ปแบบข อมู ล #3
  0b11111111}; // รู ปแบบข อมู ล #4

void setup()
{

// แสดงข อความของการทดลอง
glcdClear();
glcd(0,0,"Example: LED8_pattern");
glcd(2,0,"connect LED8 to (20)");
glcd(4,0,"Pattern LED demo");

pinLED8(20); // ใช จุ ดต อพอร ต 20 ในการเชื่ อมต อ
}

void loop()
{

int i;
for (i=0;i<4;i++) // เปล่ี ยนรู ปแบบข อมู ลแสดงผล
{

LED8(pattern[i]); // แสดงผลตามรู ปแบบข อมู ลจาก 1 ถึ ง 4
delay(300);

}
for (i=2;i>0;i--) // เปล่ี ยนรู ปแบบข อมู ลแสดงผล
{

LED8(pattern[i]); // แสดงผลตามรู ปแบบข อมู ลจาก 4 ถึ ง 1
delay(300);

}
}
คํ าอธิ บายโปรแกรม

ข อม ูลส ําหร ับการแสดงผลของโปรแกรมจะแตกต างไปจากต ัวอย างที ่ผ านๆ มา ในโปรแกรมม ีการก ําหนด
ตารางรู ปแบบข อมู ลไว ล วงหน าเก็ บไว ในตั วแปร pattern ที่ เป นตั วแปรแบบอะเรย  4 ชุ ด จากนั้ นโปรแกรมจะ
ใช ตั วแปร i เป นตั วชี้ ข อมู ลของ pattern ออกมาแสดงผลโดยผ านฟ งก ชั่ น LED8 ข อมู ลแต ละชุ ดจะได รั บการ
แสดงผลนานประมาณ 0.3 วิ นาที 
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ปฏิ บั ติ การที่  3-3 ขั บ LED 8 ดวง แสดงผลในแบบกราฟแท ง
ในการทดลองนี ้เป นการเข ียนโปรแกรมภาษา C เพื ่อควบค ุมให  LED 8 ดวงบนแผงวงจร ZX-LED8 ท ํางาน

ในลั กษณะไฟวิ ่งตามรู ปแบบข อม ูลที ่กํ าหนดไว ล วงหน า โดยใช ตั วแปรแบบอะเรย ในการเก็ บตารางรู ปแบบข อม ูล

การเชื่ อมต อทางฮาร ดแวร 
 เชื่ อมต อสั ญญาณจากจุ ดต อ 20 ของแผงวงจรหลั ก IPST-SE เข ากั บจุ ดต อ RXD ของแผงวงจร ZX-LED8 ด วย
สายสั ญญาณ JST3AA-8 (รู ปที่  L2-1 ในปฏิ บั ติ การที่  2 ของบทที่  8)

ขั้ นตอนการทดลอง
3.3.1 เป ดซอฟต แวร  Wiring 1.0 สร างไฟล ใหม  พ ิมพ โปรแกรมที ่ L3-3 บ ันท ึกในชื ่อ microbox_LED8bargraph.ino

3.3.2 คอมไพล และอ ัปโหลดโปรแกรมไปย ังแผงวงจร IPST-SE โดยคลิ กที ่ปุ ม  

3.3.3 รั นโปรแกรม สั งเกตการทํ างานของ LED 8 ดวงบนแผงวงจร ZX-LED8

LED จะเริ่ มติ ดจากดวงซ ายสุ ด (บิ ต 0) ตามด วยบิ ต 1 โดยที่  LED ของบิ ต 0 ยั งติ ดอยู  จากนั้ นจะทยอย
คิ ดสว างเพิ่ มข้ึ นที ละดวง จนครบ 8 ดวง จากนั้ นจะเริ่ มดั บลงที ละดวงจาก LED บิ ต 7 ไล ตามลํ าดั บจนถึ งบิ ต 1
จากนั้ นวนกลั บ LED บิ ต 1 ติ ดสว าง ตามด วยบิ ต 2 วนทํ างานเช นนี้ ไปตลอด ทํ าให ดู แล วคล ายกราฟแท งที่ มี การ
เพิ่ มค าและลดค าตลอดเวลา
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
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ต อยอด
ผู พั ฒนาโปรแกรมสามารถนํ าเทคนิ คนี้ ไปใช ในการเขี ยนโปรแกรมเพื่ อแสดงค าของสั ญญาณไฟฟ าที่ ได 

จากตั วตรวจจั บแบบอะนาลอก โดยเมื่ อค าของสั ญญาณไฟฟ ามี ค าตํ้ า LED จะติ ดดวงเดี ยว และคิ ดเพิ่ มข้ึ นเมื่ อ
ระดั บส ัญญาณไฟฟ ามี ค าสู งขึ้ น
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โปรแกรมที ่ L3-3 : ไฟล  microbox_LED8bargraph.ino โปรแกรมภาษา C/C++ ส ําหร ับทดลองควบค ุมไฟวิ ่ง
LED 8 ดวง ในแบบกราฟแท ง

#include <ipst.h> // ผนวกไลบรารี หลั ก
void setup()
{
  // แสดงข อความของการทดลอง
  glcdClear();
  glcd(0,0,"Example: LED8_bar");
  glcd(2,0,"connect LED8 to (20)");
  glcd(4,0,"Solid bargraph demo");

  pinLED8(20); // ใช จุ ดต อพอร ต 20 ในการเชื่ อมต อ
}

void loop()
{

int i,n;
n=0;
for (i=0;i<8;i++)
{

n|=(0x01<<i); // สร างข อมู ลแสดงผลด วยการออร บิ ต
LED8(n);
delay(300);

}

for (i=7;i>0;i--)
{

n&=0xff^(0x01<<i); // สร างข อมู ลแสดงผลด วยการแอนด บิ ต
LED8(n);
delay(300);

}
}
คํ าอธิ บายโปรแกรม

ข อม ูลส ําหร ับการแสดงผลของโปรแกรมนี ้จะใช ต ัวด ําเน ินการตรรกะหร ือลอจ ิกในระด ับบ ิตทั ้งการออร  (|)
และการแอนด  (&) โดยการออร บ ิตในโปรแกรมท ําให บ ิตข อม ูลที ่เป น “1” อยู แต เด ิมไม เปลี ่ยน จ ึงน ํามาใช ในการ
เพิ่ มจํ านวนบิ ตที่ ทํ าให  LED ติ ดสว าง ส วนการแอนด บิ ตในโปรแกรมนี้ จะทํ าให บิ ตที่ มี นั ยสํ าคั ญสู งเปลี่ ยนเป น
“0” ที ละบิ ต ทํ าให จํ านวนของ LED ที่ ติ ดสว างลดลง
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ในบทนี้ เป นการนํ าแผงวงจรสวิ ตช เข ามาต อทํ างานร วมกั บไมโครคอนโทรลเลอร ของแผง
วงจร  IPST-SE อั นเป นการเรี ยนรู การอ านค าจากอิ นพุ ตมาประมวลผลเพื่ อส งสั ญญาณออกไปควบคุ ม
อุ ปกรณ ทางเอาต พุ ตอย างง ายนั่ นเอง

ปฏ ิบ ัต ิการทั ้งหมดที ่น ําเสนอในบทนี ้ ผู พ ัฒนาสามารถน ําความรู ไปใช สร างระบบควบค ุมอย างง าย
ที ่ม ีการตรวจจ ับอ ินพ ุตจากการกดสว ิตช  แล วก ําหนดให โปรแกรมที ่ออกแบบนั ้นม ีการตอบสนองอะไร
บางอย างออกมา  เช น เมื ่อม ีการกดสว ิตช  ระบบตอบสนองด วยการเป ด/ป ดไฟ, ควบค ุมมอเตอร  หร ือส ง
ข อม ูลอ ุณหภ ูม ิไปแสดงผลย ังคอมพ ิวเตอร ที ่เชื ่อมต ออยู  เป นต น

9.1 ความรู เบื้ องต นเก่ี ยวกั บการทํ างานของสวิ ตช 

สวิ ตช เป นอุ ปกรณ พื้ นฐานที่ มี บทบาทและใช ประโยชน อย างมากในวงจรอิ เล็ กทรอนิ กส  โดย
เฉพาะอย างยิ่ งในการใช งานเป นอุ ปกรณ ตั ดต อหรื ออุ ปกรณ สํ าหรั บสร างสั ญญาณอิ นพุ ตให แก วงจร
โดยเฉพาะอย างยิ ่งกั บวงจรดิ จิ ตอล

9.1.1 สวิ ตช กดติ ดปล อยดั บ (Push-button switch/Tact switch)
เป นอ ุปกรณ ส ําหร ับต ัดต อวงจรไฟฟ าที ่น ิยมใช อย างมากในระบบไมโครคอนโทรลเลอร  โดย

สว ิตช แบบนี ้ปกต ิเมื ่อไม ม ีการกด หน าส ัมผ ัสของสว ิตช จะแยกออกจากก ันหร ือเร ียกว า เป ดวงจร เมื ่อม ีการ
กดลงบนปุ มด านบนซึ ่งท ํามาจากยางส ังเคราะห หร ือพลาสต ิก ท ําให หน าส ัมผ ัสต ัวน ําภายในสว ิตช ต อถ ึง
ก ัน กระแสไฟฟ าก ็จะสามารถไหลผ านไปได 

รู ปร างของสวิ ตช กดติ ดปล อยดั บมี ด วยกั นหลายแบบ ทั้ งแบบบั ดกรี ต อสาย แบบลงแผ นวงจร
พิ มพ  แบบติ ดหน าป ด และในบางแบบมี ไฟแสดงในตั ว ส วนขาต อใช งานมี ตั้ งแต  2 ขาขึ้ นไป ในการ
ใช งานกั บไมโครคอนโทรลเลอร นั้ นมั กใช สวิ ตช เป นอุ ปกรณ สร างสั ญญาณอิ นพุ ตแบบหนึ่ ง โดยต อ
ปลายข างหนึ ่งก ับต ัวต านทาน และปลายของต ัวต านทานนั ้นต อก ับไฟเลี ้ยงหร ือที ่เร ียกว า “พ ูลอ ัป” ที ่จ ุด





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ต อวงจรระหว างสวิ ตช กั บตั วต านทานจะเป นจุ ดที่ ต อเข ากั บไมโครคอนโทรลเลอร เพื่ ออ านค าลอจิ ก
ของการกดสว ิตช ด ังแสดงในร ูปที ่ 2-1 (ง) ถ าหากไม ม ีการกดสว ิตช  สถานะลอจ ิกขอสว ิตช ต ัวนั ้นจะเป น
“1” อั นเนื่ องจากการต อตั วต านทานพู ลอั ป และเมื่ อมี การกดสวิ ตช  จะเกิ ดสถานะลอจิ กเป น “0” เนื่ อง
จากจุ ดต อสั ญญาณนั้ นถู กต อลงกราวด 

9.1.2 การต อสวิ ตช เพื่ อกํ าหนดลอจิ กทางอิ นพุ ต
ในรู ปที่  9-2 เป นการต อสวิ ตช กดติ ดปล อยดั บเพื่ อสร างสั ญญาณอิ นพุ ตลอจิ ก “0” ให แก วงจร

โดยเมื่ อกดสวิ ตช   S1 จะเป นการต อขาอิ นพุ ตลงกราวด  อย างไรก็ ตาม การต อสวิ ตช เพี ยงตั วเดี ยวอาจ
ท ําให สถานะลอจ ิกทางอ ินพ ุตในขณะที ่ไม ม ีการกดสว ิตช ม ีความไม แน นอน จ ึงควรต อต ัวต านทานเข า
กั บไฟเลี้ ยงหรื อลงกราวด เพื่ อกํ าหนดสถานะทางลอจิ กในขณะที่ ไม มี การกดสวิ ตช ให แก วงจร

ปุมยางสําหรับกด

(ค) สั ญลั กษณ ที่ ใช ในวงจร

  (ก) รู ปร างของสวิ ตช กดติ ดปล อยดั บ

รู ปที่  9-1 แสดงรู ปร างและสั ญลั กษณ ของสวิ ตช แบบกดติ ดปล อยดั บที่ ใช ในการทดลอง

R1
4k7

+5V

S1

R1
4k7

+5V

S1

กดสวิตช
เกิดการตอวงจร ทิศทางการไหลของ

กระแสไฟฟา

ไมมีกระแสไฟฟาไหล
เน่ืองจากเปดวงจร

เอาตพุต = +5V เปนลอจิก "1"

เอาตพุต = 0V เกิดลอจิก "0"

(ง) แสดงวงจรการน ําสว ิตช กดต ิดปล อยด ับไปใช ใน
การสร างส ัญญาณลอจ ิกให แก ไมโครคอนโทรลเลอร 

  (ข) วงจรสมมู ลของสวิ ตช กดติ ดปล อยดั บ

เอาตพุตตอกับ
ขาพอรตอินพุตของ
ไมโครคอนโทรลเลอร

S1

ร ูปที ่ 9-2 การเชื ่อมต อสว ิตช กดต ิดปล อยด ับเข า
ก ับอ ินพ ุตของไมโครคอนโทรลเลอร อย างง าย
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S1

+5V

R1
10k

เอาตพุตตอกับ
ขาพอรตอินพุตของ
ไมโครคอนโทรลเลอร

S1

R1
100k

+5V
เอาตพุตตอกับ
ขาพอรตอินพุตของ
ไมโครคอนโทรลเลอร

รู ปที่  9-3 การเชื่ อมต อสวิ ตช กดติ ดปล อยดั บเข า
ก ับอ ินพ ุตของไมโครคอนโทรลเลอร แบบม ีต ัวต านทาน
ต อพ ูลอ ัป ท ําให สถานะลอจ ิกเมื ่อไม ม ีการกดสว ิตช 
เป นลอจิ ก "1"

รู ปที่  9-4 การเชื่ อมต อสวิ ตช กดติ ดปล อยดั บเข า
ก ับอ ินพ ุตของไมโครคอนโทรลเลอร แบบม ีต ัวต านทาน
ต อพ ูลดาวน  ท ําให สถานะลอจ ิกเมื ่อไม กดสว ิตช เป น
ลอจ ิก "0"

ในร ูปที ่ 9-3 เป นการต อสว ิตช เข าก ับอ ินพ ุตของไมโครคอนโทรลเลอร  โดยม ีการต อต ัวต านทาน
เข าที ่ขาอ ินพ ุตของวงจรและไฟเลี ้ยง +5V เร ียกการต อต ัวต านทานแบบนี ้ว า การต อต ัวต านทานพ ูลอ ัป
(pull-up) ด วยการต อต ัวต านทานในล ักษณะนี ้ท ําให เมื ่อย ังไม ม ีการกดสว ิตช  สถานะลอจ ิกที ่อ ินพ ุตต อง
เป นลอจิ ก “1” อย างแน นอน

ส วนในร ูปที ่ 9-4 เป นการต อสว ิตช เข าก ับอ ินพ ุตในอ ีกล ักษณะหนึ ่งที ่ม ีการต อต ัวต านทานเข าที ่
ขาอิ นพ ุตของวงจรและกราวด  จะเรี ยกการต อตั วต านทานแบบนี ้ว า การต อต ัวต านทานพ ูลดาวน  (pull-
down) ด วยการต อต ัวต านทานในล ักษณะนี ้ท ําให เมื ่อย ังไม ม ีการกดสว ิตช สถานะลอจ ิกที ่ขาอ ินพ ุตเป น
ลอจิ ก “0”

9.1.3 สั ญญาณรบกวนของการกดสวิ ตช 
ในทางทฤษฎ ี เมื ่อสว ิตช ม ีการเป ดป ดวงจร ส ัญญาณไฟฟ าจะถ ูกปลดหร ือต อเข าไปในวงจรและ

สามารถว ิเคราะห ผลการท ํางานได  แต ในความเป นจร ิง เมื ่อม ีการกดและปล อยสว ิตช  หน าส ัมผ ัสของสว ิตช 
จะเก ิดการสั ่นและกว าที ่จะต อหร ือเป ดวงจรอย างสมบ ูรณ นั ้นจะต องใช เวลาชั ่วขณะหนึ ่ง ซึ ่งมน ุษย ไม สามารถ
มองเห ็นภาวะนั ้นได  แต วงจรอ ิเล ็กทรอน ิกส จะตรวจจ ับความไม คงที ่นั ้นได  และมองเป นส ัญญาณรบกวน

สั ญญาณรบกวนที่ เกิ ดขึ้ นนั้ นเรี ยกว า สั ญญาณรบกวนจากการสั่ นของหน าสั มผั สสวิ ตช  หรื อ
การเบาซ  (bounce)  ถ าหากน ําสว ิตช นั ้นไปใช เป นอ ุปกรณ เพื ่อป อนส ัญญาณอ ินพ ุตให แก วงจรน ับ ใน
ทางอุ ดมคติ เมื่ อกดสวิ ตช  1 ครั้ ง จะได สั ญญาณพั ลส เพี ยง 1 ลู กเพื่ อส งไปยั งวงจรเพื่ อเปลี่ ยนค าหนึ่ งค า
แต ทางปฏิ บั ติ  จะมี สั ญญาณพั ลส ส งออกไปอาจจะมี เพี ยง 1 ลู กตามต องการหรื อมากกว านั้ นก็ ได  ซึ่ ง
ไม อาจคาดเดาได  โดยสั ญญาณพั ลส ที่ เกิ ดขึ้ นนั้ นจะเกิ ดขึ้ นเมื่ อสวิ ตช เริ่ มต อวงจร และเมื่ อสวิ ตช กํ าลั ง
เป ดวงจรเนื่ องจากการปล อยสวิ ตช  ในรู ปที่  9-5 แสดงปรากฏการณ ดั งกล าว
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9.1.4 การแก ไขส ัญญาณรบกวนของการกดสว ิตช เมื ่อใช งานก ับไมโครคอนโทรลเลอร 

หล ักการแก ไขส ัญญาณรบกวนแบบนี ้ค ือ หน วงเวลาการเก ิดขึ ้นของส ัญญาณพ ัลส เล ็กน อย เพื ่อให 
วงจรไม สนใจส ัญญาณที ่เก ิดขึ ้นในช วงเริ ่มต นกดสว ิตช  เร ียกการแก ไขส ัญญาณรบกวนนี ้ว า ด ีเบาซ  (debounce)

ว ิธ ีการแรก ท ําได โดยใช อ ุปกรณ อ ิเล ็กทรอน ิกส พื ้นฐานอย างต ัวต านทานและต ัวเก ็บประจ ุ โดยต อ
ก ันในล ักษณะวงจร RC อ ินต ิเกรเตอร  ด ังในร ูปที ่ 9-6  ด วยว ิธ ีการนี ้จะช วยลดผลของส ัญญาณรบกวนที ่
เก ิดขึ ้นจากการกดสว ิตช ได ในระด ับหนึ ่ง โดยประส ิทธ ิภาพของวงจรจะขึ ้นก ับการเล ือกค าของต ัวต านทาน
และต ัวเก ็บประจ ุ หากเล ือกค าของต ัวเก ็บประจ ุน อยเก ินไป อาจไม สามารถลดส ัญญาณรบกวนได  แต ถ า
เล ือกค ามากเก ินไป จะท ําให ความไวในการตรวจจ ับการกดสว ิตช ลดลง นั ่นค ือ อาจต องกดสว ิตช มากกว า
1 ครั ้งเพื ่อให ได สั ญญาณที่ ต องการ

S1

+5V

OUTPUT

R1
10k

+5V

0V

S1

+5V

OUTPUT

R1
10k

+5V

0V

S1

+5V

R1
10k

+5V

0V

สัญญาณรบกวนทีเ่กิดข้ึน
จากการกดสวติช

สัญญาณรบกวนทีเ่กิดข้ึน
จากการปลอยสวติช

รู ปที่  9-5 แสดงการเกิ ดสั ญญาณรบกวนเมื่ อมี การกดและปล อยสวิ ตช ในวงจรดิ จิ ตอล

S1

+5V

OUTPUT

R1
10k

R2 R3

C1

วงจร RC อนิติเกรเตอร

รู ปที่  9-6 การต อวงจร RC อิ นติ เกรเตอร เพื่ อแก ไขป ญหาสั ญญาณรบกวนจากการกดสวิ ตช 



  Arduino IDE151

วิ ธี การที่ สองคื อ ใช กระบวนการทางซอฟต แวร เข ามาช วย ซึ่ งมี ขั้ นตอนโดยสรุ ปดั งนี้ 

(1) อ านค าการกดสวิ ตช ครั้ งแรกเข ามาก อน

(2) หน วงเวลาประมาณ 0.1 ถึ ง 1 วิ นาที 

(3) อ านค าของการกดสวิ ตช อี กครั้ ง

ถ าหากค าที่ อ านได เหมื อนกั บการอ านครั้ งแรก

แสดงว า มี การกดสวิ ตช เกิ ดขึ้ นจริ ง

ถ าค าที่ อ านได ไม เหมื อนกั บการอ านครั้ งแรก

แสดงว า สั ญญาณที่ เกิ ดขึ้ นอาจเป นเพี ยงพั ลส แคบๆ อาจตี ความได ว า
เป นสั ญญาณรบกวน จึ งยั งไม มี การกดสวิ ตช เกิ ดขึ้ นจริ ง

9.2 ฟ งก ชั่ นโปรแกรมภาษา C/C++ ในไลบรารี  ipst.h ที่ ใช ในการทดลอง

สํ าหรั บคํ าสั่ งหรื อฟ งก ชั่ นของโปรแกรมภาษา C/C++ ที่ ใช ในการทดลองทั้ งหมดในบทนี้  ได 
รั บการบรรจุ ไว ในไฟล ไลบรารี  ipst.h  คื อ คํ าสั่ ง in, sw_OK และ sw1

9.2.1 in
เป นฟ งก ชั่ นอ านค าสถานะลอจิ กของพอร ตที่ กํ าหนด

รู ปแบบ

char in(x)

พารามิ เตอร 

x - กํ าหนดขาพอร ตที่ ต องการอ านค า มี ค าตั้ งแต  0 ถึ ง 50  สํ าหรั บ IPST-SE ใช ได ถึ ง 30

หมายเหตุ  : ไม แนะนํ าให ใช ฟ งก ชั่ นนี้ กั บจุ ดต อ 19 และ 20 บนแผงวงจร IPST-SE

การค ืนค า

เป น 0 หรื อ 1

ตั วอย างที่  9-1
char x; // ประกาศตั วแปร x เพื่ อเก็ บค าผลลั พธ จาการอ านค าระดั บสั ญญาณ
x = in(16); // อ านค าดิ จิ ตอลจากพอร ตหมายเลข 16 แล วเก็ บค าไว ที่ ตั วแปร x
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9.2.2 sw_OK()
เป นฟ งก ชั ่นตรวจสอบสถานะสว ิตช  OK บนแผงวงจร IPST-SE โดยให สถานะ “เป นจร ิง” เมื ่อ

มี การกดสวิ ตช และ “เป นเท็ จ” เมื่ อไม มี การกดสวิ ตช 

รู ปแบบ
unsigned char sw_ok()

การค ืนค า
1 (เป นจริ ง) เมื่ อมี การกดสวิ ตช 
0 (เป นเท็ จ) เมื่ อไม มี การกดสวิ ตช 

ตั วอย างที่  9-2
#include <ipst.h> // ผนวกไฟล ไลบรารี หลั ก
void setup()
{

glcdClear();
}
void loop()
{

if (sw_OK()) // ตรวจสอบการกดสวิ ตช  OK
{

glcdFillScreen(GLCD_YELLOW); // เปล่ี ยนสี พื้ นเป นสี เหลื อง
delay(3000); // แสดงสี พื้ นใหม นาน 3 วิ นาที 

}
glcdClear(); // เคลี ยร หน าจอแสดงผล กํ าหนดพื้ นหลั งเป นสี ดํ า

}

9.2.3 sw_OK_press()
เป นฟ งก ชั่ นวนตรวจสอบการกดสวิ ตช  OK บนแผงวงจร IPST-SE ต องรอจนกระทั่ งสวิ ตช ถู ก

ปล อยหลั งจากการกดสวิ ตช จึ งจะผ านฟ งก ชั่ นนี้ ไปกระทํ าคํ าสั่ งอื่ นๆ

ตั วอย างที่  9-3
............
sw_OK_press(); // รอจนกระทั่ งเกิ ดกดสวิ ตช  OK

............
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9.2.4 sw1_press
เป นฟ งก ชั่ นวนตรวจสอบการกดสวิ ตช  SW1 บนแผงวงจร IPST-SE ต องรอจนกระทั่ ง SW1

ถู กปล อยหลั งจากมี การกดสวิ ตช  จึ งจะผ านพ นการทํ างานของฟ งก ชั่ นนี้ ไป

รู ปแบบ

void sw1_press()

ตั วอย างที่  9-4
............

sw1_press(); // รอจนกระทั่ งสวิ ตช  SW1 ถู กกดและปล อย

................

9.2.5 sw1
เป นฟ งก ชั่ นตรวจสอบการกดสวิ ตช  SW1 ในขณะใดๆ

รู ปแบบ

char sw1()

การค ืนค า

เป น “0” เมื่ อสวิ ตช  SW1 ถู กกด และ เป น “1” เมื่ อไม มี การกดสวิ ตช  SW1

ตั วอย างที่  9-5
char x; // ประกาศตั วแปร x เพื่ อเก็ บค าผลลั พธ จากการอ านค าดิ จิ ตอล
x = sw1(); // อ านค าสถานะของสวิ ตช  SW1 มาเก็ บไว ที่ ตั วแปร x
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
ปฏิ บั ติ การที่  4-1 ควบคุ ม LED ด วยการกดสวิ ตช  OK

การเชื ่อมต อทางฮาร ดแวร 
 ต อแผงวงจร ZX-LED กั บจุ ดต อพอร ต 17 ของแผงวงจรหลั ก IPST-SE

ขั้ นตอนการทดลอง
4.1.1 เป ดซอฟต แวร  Wiring 1.0 สร างไฟล ใหม  พิ มพ โปรแกรมที่  L1-1 บั นทึ กในชื่ อ microbox_OKtest.ino

4.1.2 เป ดสวิ ตช จ ายไฟแก แผงวงจร IPST-SE แล ว เชื่ อมต อสาย USB เข ากั บคอมพิ วเตอร 

4.1.3  คอมไพล และอั ปโหลดโปรแกรมไปยั งแผงวงจร IPST-SE โดยคลิ กที่ ปุ ม 

รู ปที่  L4-1 การต อวงจรเพื่ อทํ าการทดลองสํ าหรั บปฏิ บั ติ การที่  4
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#include <ipst.h> // ผนวกไฟล ไลบรารี หลั ก
void setup()
{

setTextSize(2); // กํ าหนดขนาดตั วอั กษร 2 เท า
glcd(1,1,"Press OK"); // แสดงข อความออกหน าจอแสดงผล
sw_OK_press(); // วนรอจนกระทั่ งกดสวิ ตช  OK
glcdClear(); // เคลี ยร หน าจอแสดงผล กํ าหนดพื้ นหลั งเป นสี ดํ า

}
void loop()
{

if (sw_OK()) // ตรวจสอบการกดสวิ ตช  OK
{

out(17,0); // ดั บ LED ที่ จุ ดต อพอร ต 17
delay(2000); // นาน 2 วิ นาที 

}
out(17,1); // ขั บ LED ที่ จุ ดต อพอร ต 17 ให ติ ดสว าง

}
คํ าอธิ บายโปรแกรม

การทํ างานของโปรแกรมเริ่ มต นด วยการแสดงข อความแจ งให กดสวิ ตช  OK บนแผงวงจร IPST-SE เมื่ อ
กดแล ว จะเข าสู ลู ปการทํ างานหลั กในฟ งก ชั่ น loop() เพื่ อตรวจสอบต อไปว า มี การกดสวิ ตช  OK หรื อไม  ถ าไม 
มี  จะส งข อมู ล “1” ออกไปยั งจุ ดต อพอร ต 17 ทํ าให  LED ที่ ต ออยู ติ ดสว าง และยั งคงสว างอยู เช นนั้ นจนกว าจะ
มี การกดสวิ ตช  OK

เมื่ อสวิ ตช  OK ถู กกด จะทํ าให เงื่ อนไขการตรวจสอบเป นจริ ง เกิ ดการตอบสนองด วยการส งข อมู ล “0”
ไปที่ จุ ดต อพอร ต 17 ทํ าให  LED ที่ ต ออยู ดั บลงเป นเวลา 2 วิ นาที  ตามการทํ างานของฟ งก ชั่ น delay จากนั้ นก็ 
จะหลุ ดออกจากการตรวจสอบ มาพบฟ งก ชั่ น out เพื่ อขั บให  LED กลั บมาติ ดอี กคร้ั ง แล ววนรอการกดสวิ ตช 
OK ในรอบใหม 

โปรแกรมที ่ L4-1 : ไฟล  microbox_OKtest.ino โปรแกรมภาษา C/C++ ส ําหร ับทดลองควบค ุม LED ด วยสว ิตช 

4.1.4 ร ันโปรแกรม

ที่ จอแสดงผลกราฟ ก LCD จะแจ งให กดสวิ ตช  OK ทั นที ที่ กดสวิ ตช  OK บนแผงวงจร IPST-SE จะทํ าให 
LED ของแผงวงจร ZX-LED ที่ ต อกั บจุ ดต อพอร ต 17 ติ ดสว าง

4.15 กดสวิ ตช  OK อี ก 1 คร้ั ง แล วปล อย สั งเกตการทํ างานของ LED

LED ของแผงวงจร ZX-LED จะดั บลงนาน 2 วิ นาที  จากนั้ นจะกลั บมาติ ดสว างใหม อี กครั้ ง และจะทํ า
งานในลั กษณะนี้ ไปตลอด จนกว าจะมี การรี เซตระบบ หรื อป ดเป ดจ ายไฟเลี้ ยงใหม 
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ปฏิ บั ติ การที่  4-2 ควบคุ ม LED ด วยการกดสวิ ตช  SW1
ในการทดลองนี ้จะเพิ ่มเต ิมสว ิตช เข ามาอ ีก 1 ต ัวค ือ SW1 โดยสว ิตช  SW1 ถ ูกต ิดตั ้งไว พร อมใช งานบนแผง

วงจร IPST-SE  อยู แล ว โดยในปฏิ บั ติ การนี้ ต องการนํ าสวิ ตช  SW1 มาควบคุ มการเป ดป ด LED ในแบบท็ อกเกิ ล
(toggle) นั่ นคื อ เมื่ อกดสวิ ตช หนึ่ งคร้ั ง LED ติ ด และเมื่ อกดซํ้ า LED จะดั บ สลั บกั นเช นนี้ 

การเชื่ อมต อทางฮาร ดแวร 
 ต อแผงวงจร ZX-LED กั บจุ ดต อพอร ต 17 ของแผงวงจรหลั ก IPST-SE

ขั้ นตอนการทดลอง
4.2.1 เป ดซอฟต แวร  Wiring 1.0 สร างไฟล ใหม  พิ มพ โปรแกรมที่  L1-1 บั นทึ กในชื่ อ microbox_SW1test.ino

4.2.2  คอมไพล และอั ปโหลดโปรแกรมไปย ังแผงวงจร IPST-SE โดยคลิ กที ่ปุ ม 

4.2.3 ร ันโปรแกรม

ที่ จอแสดงผลกราฟ ก LCD จะแจ งให กดสวิ ตช  OK

4.2.4 กดสวิ ตช  OK อี ก 1 คร้ั ง แล วปล อย

4.2.5 ทดลองกดสวิ ตช  SW1 แล วปล อย 3 ครั้ ง สั งเกตการทํ างานของ ZX-LED

LED ของแผงวงจร ZX-LED จะต ิดและด ับ กล ับสถานะก ันในท ุกครั ้งที ่ม ีการกดสว ิตช  SW1 นั ่นค ือ จากเด ิม
ดั บจะกลายเป นติ ดสว าง และจากติ ดสว างจะกลายเป นดั บ

4.2.6 กดสวิ ตช  SW1 ค างไว ครู หนึ่ ง แล วจึ งปล อย สั งเกตการทํ างานของ LED

เมื่ อสวิ ตช ยั งถู กกดค าง สถานะของ LED จะไม มี การเปลี่ ยนแปลง จนกว าสวิ ตช จะถู กปล อย
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#include <ipst.h> // ผนวกไฟล ไลบรารี หลั ก
int i=0;
void setup()
{

setTextSize(2); // กํ าหนดขนาดตั วอั กษร 2 เท า
glcd(1,1,"Press OK"); // แสดงข อความออกหน าจอแสดงผล
sw_OK_press(); // วนรอจนกระทั่ งกดสวิ ตช  OK
glcdClear(); // เคลี ยร หน าจอแสดงผล กํ าหนดพื้ นหลั งเป นสี ดํ า

}
void loop()
{
  if (sw1()) // ตรวจสอบการกดสวิ ตช  OK
  {

out(17,i^=1); // ดั บ LED ที่ จุ ดต อพอร ต 17
while(sw1())

delay(5);
  }
}
คํ าอธิ บายโปรแกรม

โปรแกรมจะม ีต ัวอย างการร ับค าสว ิตช  2 ต ัวค ือ สว ิตช  OK (ใช ฟ งก ชั ่น sw_OK_press()) และสว ิตช  SW1
(ใช ฟ งก ชั่ น sw1()) โดยตั วแรกจะอยู ในฟ งก ชั่ น setup เพื่ อวนรอการกดสวิ ตช  OK เพื่ อเริ่ มต นการทํ างาน

หลั งจากมี การกดสวิ ตช  OK จะเข าสู ลู ปการทํ างานของฟ งก ชั่ น loop เพื่ อวนรอการกดสวิ ตช  SW1 เมื่ อ
สวิ ตช  SW1 ถู กกด จะทํ าการส งสั ญญาณออกมายั งพอร ต 17 โดยค าที่ ส งออกมาจะได มาจากการเอ็ กคลู ซี ฟ
ออร ค าของตั วแปร i กั บ 1 จากคํ าสั่ ง i^=1 ทํ าให ค าที่ ได มี การกลั บสถานะทุ กคร้ั งที่ มี การเรี ยกให ทํ างาน ซึ่ งการ
ทํ างานในลั กษณะนี้ สามารถใช คํ าสั่ ง i=~i ก็ ได  แต เนื่ องจากในคอมพิ วเตอร บางเครื่ อง (โดยเฉพาะเครื่ อง
คอมพิ วเตอร  Macintosh) ไม มี คี ย  ~ ให ใช  จึ งต องเขี ยนคํ าสั่ งด วยการทํ าเอ็ กคลู ซี ฟ-ออร แทน

ดั งนั้ นเมื่ อมี การกดสวิ ตช  SW1 ทุ กคร้ั ง ก็ จะมี การกลั บสถานะลอจิ กเดิ มที่ จุ ดต อพอร ต 17 ทํ าให  LED
ของแผงวงจร ZX-LED ที่ ต ออยู เกิ ดการติ ดและดั บสลั บกั นในทุ กครั้ งที่ กดสวิ ตช 

ส ําหร ับค ําสั ่ง while(sw1()) และ dealy(5); ท ําหน าที ่ลดส ัญญาณรบกวนที ่เก ิดจากการกดสว ิตช  ท ําให ก
ารกดสวิ ตช  SW1 ในแต ละคร้ั งมี ความแน นอนมากข้ึ น

โปรแกรมที่  L4-2 : ไฟล  microbox_SW1test.ino โปรแกรมภาษา C/C++ สํ าหรั บทดลองควบคุ ม LED
ด วยสว ิตช  SW1 ในล ักษณะกล ับสถานะการท ํางานในท ุกครั ้งที ่ม ีการกดสว ิตช  SW1
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
การเชื่ อมต อทางฮาร ดแวร 
 ต อแผงวงจร ZX-SWITCH01 กั บจุ ดต อพอร ต 16 ของแผงวงจรหลั ก IPST-SE

ขั ้นตอนการทดลอง
5.1 เป ดซอฟต แวร  Wiring 1.0 สร างไฟล ใหม  พิ มพ โปรแกรมที่  L1-1 บั นทึ กในชื่ อ microbox_CounterSwitch.ino

5.2 เป ดสว ิตช จ ายไฟแก แผงวงจร IPST-SE แล ว เชื ่อมต อสาย USB เข าก ับคอมพ ิวเตอร 

5.3  คอมไพล และอ ัปโหลดโปรแกรมไปย ังแผงวงจร IPST-SE โดยคล ิกที ่ปุ ม 

5.4 ร ันโปรแกรม

ที่ จอแสดงผลกราฟ ก LCD แสดงข อความ Start ให กดสวิ ตช  OK

5.5 กดสวิ ตช  OK 1 คร้ั ง แล วปล อย

ที ่จอแสดงผลกราฟ ก LCD แสดงข อความ COUNTER ให เริ ่มการน ับด วยการกดสว ิตช ที ่ต อก ับพอร ต 16

5.6 กดสวิ ตช ที่ แผงวงจร ZX-SWITCH01 ที่ ต อกั บพอร ต 16 สั งเกตการทํ างานที่ จอแสดงผลของแผงวงจร IPST-SE

ที่ จอแสดงผลจะเริ่ มต นแสดงค าการนั บจํ านวนการกดสวิ ตช  โดยเร่ิ มจาก 0 ค าจะเปลี่ ยนทั นที่ ที่ มี การกด
สวิ ตช ที่ พอร ต 16 และจะทํ าการั บค าต อไปได  ก็ ต อเมื่ อมี การปล อยสวิ ตช  แล วกดใหม  หากสวิ ตช ยั งถู กกดค าง
ค าการนั บจะไม มี การเปลี่ ยนแปลง จนกว าสวิ ตช จะถู กปล อย และกดเข ามาใหม 
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รู ปที่  L5-1 การต อวงจรเพื่ อทํ าการทดลองสํ าหรั บปฏิ บั ติ การที่  5
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โปรแกรมที ่ L5-1 : ไฟล  microbox_CounterSwitch.ino โปรแกรมภาษา C/C++ ส ําหร ับทดลองใช งานสว ิตช 
ในการสร างเครื ่องน ับจ ํานวนอย างง าย

#include <ipst.h> // ผนวกไฟล ไลบรารี หลั ก
int i=0; // ประกาศตั วแปรเก็ บค าการนั บ
void setup()
{

setTextSize(2); // กํ าหนดขนาดตั วอั กษร 2 เท า
glcd(1,3,"Start"); // แสดงข อความ Start ออกหน าจอแสดงผล
sw_OK_press(); // วนรอจนกระทั่ งกดสวิ ตช  OK
glcdClear(); // เคลี ยร หน าจอแสดงผล กํ าหนดพื้ นหลั งเป นสี ดํ า
glcd(1,2,"COUNTER"); // แสดงข อความ COUNTER เพื่ อแจ งชื่ อการทดลอง
setTextSize(3); // กํ าหนดขนาดตั วอั กษร 3 เท า
glcd(3,3,"0"); // กํ าหนดค าเริ่ มต นเป น 0

}
void loop()
{

if (in(16)==0) // ตรวจสอบการกดสวิ ตช ที่ พอร ต 16
{

i=i++; // เพิ่ มค าตั วนั บ
glcd(3,3,"%d",i); // แสดงค าการนั บ
while(in(16)==0) // ตรวจสอบการปล อยสวิ ตช 

delay(5);
}

}
คํ าอธิ บายโปรแกรม

โปรแกรมนี ้ใช ฟ งก ชั ่น in ในการตรวจจ ับและอ านค าจากการกดสว ิตช ที ่พอร ต 16 โดยตรงสอบว าที ่พอร ต
16 เป นลอจ ิก “0” หรื อไม  ถ าใช แสดงว า มี การกดสวิ ตช เป ดขึ ้น จากนั ้นจะทํ าการเพิ ่มค าต ัวน ับ แล วนํ ามาแสดง
ผลที่ จอแสดงผลกราฟ ก LCD ของแผงวงจร IPST-SE

คํ าสั่ ง while(in(16)==0) และ dealy(5); ทํ าหน าที่ ลดสั ญญาณรบกวนที่ เกิ ดจากการกดสวิ ตช  โดยจะ
ตรวจสอบว า มี การปล อยสวิ ตช แล วหรื อไม  ถ าไม  ก็ จะวนทํ างานอยู ที่ คํ าสั่ งนั้ น ช วยให ไม เกิ ดการนั บค าโดยไม 
ตั้ งใจขึ้ น ดั งนั้ นการกดสวิ ตช ที่ พอร ต 16 ในแต ละคร้ั งจึ งมี ความแน นอนสู ง

จากทั ้งสองปฏิ บั ต ิการผู พั ฒนาสามารถนํ าไปประยุ กต ใช งานสวิ ตช หลายๆ ต ัวพร อมกั นและมี 
ความสามารถที่ แตกต างกั นไปแล วแต จุ ดประสงค  เช น สวิ ตช บางตั วสามารถกํ าหนดให เมื่ อกดสวิ ตช 
ค างแล วสามารถเพิ ่มค าหร ือลดค าข อม ูลที ่ก ําหนดได  ในขณะที ่สว ิตช บางต ัวอาจก ําหนดให ไม สามารถ
กดค างได  เป นต น
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สั ญญาณทางไฟฟ าแบ งออก 2 แบบหลั กค ือ ส ัญญาณอะนาลอก (analog) และด ิจิ ตอล (digital)
สั ญญาณอะนาลอกก็ คื อ สั ญญาณไฟฟ าที่ มี การเปลี่ ยนแปลงสั มพั นธ กั บค าเวลา โดยการเปลี่ ยนแปลง
นั ้นจะเพิ ่มขึ ้นหร ือลดลงก ็ได  และม ีระด ับแรงด ันเท าใดก ็ได  ส วนส ัญญาณด ิจ ิตอลเป นส ัญญาณที ่ม ีการ
เปลี่ ยนแปลงเพี ยง 2 ระดั บที่ แตกต างกั น กล าวคื อ มี ระดั บสั ญญาณสู ง และตํ่ า (เกื อบหรื อเท ากั บ 0V)
โดยปกต ิจะม ีระด ับแรงด ันเท าก ับ +5V ส ําหร ับระด ับแรงด ันส ูง หร ือเร ียกว า ลอจ ิก “1” และ 0V ส ําหร ับ
ระดั บแรงดั นตํ่ า หรื อเรี ยกว า ลอจิ ก “0” แต ในป จจุ บั นระดั บแรงดั นของลอจิ ก “1” อาจเท ากั บ +3.3V
หรื อ 1.8V ขึ้ นอยู กั บเทคโนโลยี ของอุ ปกรณ ดิ จิ ตอล อย างไรก็ ตาม สํ าหรั บการเรี ยนรู โดยพื้ นฐานนี้ จะ
อธ ิบายระด ับลอจ ิก “1” ด วยค าแรงด ัน +5V เป นหล ัก ในร ูปที ่ 10-1 แสดงความแตกต างระหว างส ัญญาณ
อะนาลอกกั บดิ จิ ตอล

V
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t
1 0 1 0 1 0

1

Vp Data

(ก) ตัวอยางสัญญาณอะนาลอก
ระดับของสัญญาณเปลี่ยนแปลง
สัมพันธกับคาเวลา

(ข) ตัวอยางสัญญาณดิจิตอล จะเห็นวา
มีเพียง 2 ระดับสัญญาณเทานั้นคือ
ระดับสูง ("1") และระดับต่ํา ("0")
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รู ปที่  10-1 ตั วอย างของสั ญญาณอะนาลอกและดิ จิ ตอล



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10.1 สั ญญาณอะนาลอก
แบ งได  3 แบบ ค ือ แบบส ัญญาณไฟตรง (analog DC signals), แบบเปลี ่ยนค าตามเวลา (time-

domain) และ แบบเปลี ่ยนค าตามความถี ่ (frequency-domain)

สั ญญาณอะนาลอกไฟตรง มั กเป นค าที่ ได จากการวั ดขนาดหรื อระดั บของสั ญญาณ ซึ่ งมี การ
เปลี ่ยนแปลงค าส ัญญาณในเวลาที ่ไม เร ็วมากน ัก อาท ิ ค าอ ุณหภ ูม ิ, ระด ับของไหล, ความด ัน, อ ัตราการ
ไหล, นํ ้าหน ัก เป นต น สามารถใช วงจรแปลงส ัญญาณอะนาลอกเป นด ิจ ิตอล (ADC : Analog to Digital
Converter) ที่ มี อั ตราการสุ มสั ญญาณไม เร็ วมากได 

ส ัญญาณอะนาลอกแบบเปลี ่ยนค าตามเวลา เป นส ัญญาณที ่ว ัดเพื ่อพ ิจารณาล ักษณะร ูปส ัญญาณ
เป นหล ัก อาท ิ ส ัญญาณคลื ่นห ัวใจมน ุษย  (ECG) ซึ ่งม ีความจ ําเป นต องใช วงจรแปลงส ัญญาณอะนาลอก
เป นดิ จิ ตอลที่ มี ความเร็ วในการสุ มสั ญญาณสู ง

สั ญญาณอะนาลอกแบบเปลี่ ยนค าตามความถี่  ได แก  สั ญญาณความถี่ วิ ทยุ  (radio frequency :
RF) และส ัญญาณคลื ่นเส ียง เป นต น ในการว ิเคราะห จ ําเป นต องม ีฮาร ดแวร พ ิเศษเพื ่อช วยว ิเคราะห อย าง
DSP (digital signal processing) ทํ างานร วมกั บวงจรแปลงสั ญญาณอะนาลอกเป นดิ จิ ตอลด วย

10.2 ทํ าไมไมโครคอนโทรลเลอร ต องอ านค าสั ญญาณอะนาลอก
สาเหตุ หลั กที่ ไมโครคอนโทรลเลอร ต องติ ดต อกั บสั ญญาณอะนาลอกคื อ ต องการอ านค า

ปริ มาณทางฟ สิ กส ในรู ปของสั ญญาณไฟฟ า เพ่ื อนํ าไปประมวลผลและควบคุ มระบบต อไป

ในรู ปที่  10-2 แสดงไดอะแกรมการทํ างานเบื้ องต นของการอ านค าสั ญญาณอะนาลอกของ
ไมโครคอนโทรลเลอร   มี ส วนประกอบสํ าคั ญ 4 ส วนคื อ

1. ส วนตรวจจั บสั ญญาณกายภาพ (Transducer/Sensor/Detector)

2. วงจรปรั บสภาพสั ญญาณ (Signal conditioning)

3. วงจรแปลงสั ญญาณอะนาลอกเป นดิ จิ ตอล (Analog to Digital Converter : ADC)

4. ไมโครคอนโทรลเลอร 

10.2.1 ส วนชุ ดตรวจจั บสั ญญาณกายภาพ

ช ุดตรวจจ ับส ัญญาณกายภาพ หร ือ ทรานสด ิวเซอร  (transducer) ค ือต ัวแปลงส ัญญาณทางกายภาพ
เช น อ ุณหภ ูม ิ ความด ัน ระด ับของไหล ความยาว ต ําแหน งการเคลื ่อนที ่ ฯลฯ ให เป นในร ูปส ัญญาณทางไฟฟ า
นั ่นเอง หร ือบางครั ้งเร ียกอ ุปกรณ เหล านี ้ว า ต ัวตรวจจ ับ (sensor) ซึ ่งม ีด วยก ันหลากหลายร ูปแบบ อาท ิ เทอร โม
ค ัปเป ล (thermocouple) , เทอร ม ิสเตอร  (thermistor), ต ัวตรวจจ ับการไหล (flow sensor)  เป นต น
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10.1.2 ส วนปรั บสภาพสั ญญาณ
หน าที ่หล ักของส วนปร ับสภาพส ัญญาณนี ้ค ือ ปร ับปร ุงค ุณภาพของส ัญญาณไฟฟ าที ่ได จากช ุด

ตรวจจ ับก อนส งส ัญญาณต อไปย ังฮาร ดแวร ที ่เชื ่อมต อก ับไมโครคอนโทรลเลอร  ซึ ่งอาจม ีความจ ําเป น
ต องปรั บสเกลสั ญญาณ, ขยายขนาดสั ญญาณ, แปลงรู ปสั ญญาณให เป นเชิ งเส น (linearization), กรอง
คลื่ นสั ญญาณและแยกกราวด ของสั ญญาณ (common-mode rejection)

หน าที ่เด นของส วนปร ับสภาพส ัญญาณค ือ ขยายขนาดส ัญญาณ (amplifly) เพราะโดยส วนใหญ 
สั ญญาณที่ ได จากชุ ดตรวจจั บจะมี ขนาดสั ญญาณที่ ตํ่ ามาก มี ขนาดแรงดั นไฟฟ าในหน วยมิ ลลิ โวลต 
(millivolt : mV) หรื อ 1/1000V และมั กมี สั ญญาณรบกวนจากแหล งจ ายไฟปะปนมา ซึ่ งอาจรบกวน
สั ญญาณด านอิ นพุ ตในขณะที่ สั ญญาณเข าสู ระบบ  ทํ าให ค าสั ญญาณที่ วั ดไม ถู กต องและไม เที่ ยงตรง

นอกจากนั้ นวงจรปรั บสภาพสั ญญาณยั งใช ในการแปลงสั ญญาณไฟฟ าที่ ไม ได อยู ในรู ปของ
แรงด ันไฟฟ า เช น กระแสไฟฟ าหร ือความต านไฟฟ ามาอยู ในร ูปของแรงด ันไฟฟ าให เหมาะสมก ับวงจร
แปลงสั ญญาณอะนาลอกเป นดิ จิ ตอล  อาทิ  แปลงค ากระแสไฟฟ า 4 ถึ ง 20mA จากตั วตรวจจั บที่ ให 
ผลแบบกระแสไฟฟ าเป นแรงดั นไฟตรง 0 ถึ ง +5V  เป นต น

รู ปที่  10-2 แสดงกระบวนการอ านค าสั ญญาณอะนาลอกของไมโครคอนโทรลเลอร 
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10.1.3 วงจรแปลงสั ญญาณอะนาลอกเป นดิ จิ ตอล
วงจรนี้ ทํ าหน ารั บสั ญญาณอะนาลอกที่ ผ านมาจากวงจรปรั บสภาพสั ญญาณ เพื่ อทํ าการแปลง

เป นข อม ูลทางด ิจ ิตอลเพื ่อส งไปย ังประมวลผลย ังไมโครคอนโทรลเลอร ต อไป จ ุดที ่ต องให ความสนใจ
ในส วนนี้ คื อ ความละเอี ยดในการแปลงสั ญญาณ วงจรแปลงสั ญญาณอะนาลอกเป นดิ จิ ตอลที่ เหมาะ
สมในการน ํามาใช ในการทดลองว ิทยาศาสตร ควรม ีความละเอ ียดไม น อยกว า 8 บ ิต ซึ ่งให ความแตกต าง
ของข อมู ล 256 ค า และถ ายิ่ งมี ความละเอี ยดสู งเท าใดยิ่ งดี  เพราะจะให ผลการแปลงที่ แม นยํ ามากขึ้ น
แต นั่ นจะทํ าให ต นทุ นของระบบสู งขึ้ นตามไปด วย

10.1.4 ไมโครคอนโทรลเลอร 
ไมโครคอนโทรลเลอร เป นหนึ ่งในอ ุปกรณ ของระบบด ิจ ิตอล ด ังนั ้นการอ านค าส ัญญาณอะนา

ลอกโดยตรงจ ึงต องใช อ ุปกรณ ช วยเพิ ่มเต ิม นั ่นค ือ วงจรแปลงส ัญญาณอะนาลอกเป นด ิจ ิตอล (analog
to digital converter) ไมโครคอนโทรลเลอร ในอดี ตจะไม มี วงจรแปลงสั ญญาณอะนาลอกเป นดิ จิ ตอล
บรรจุ อยู ภายในตั วชิ ป จึ งต องใช ไอซี แปลงสั ญญาณอะนาลอกเป นดิ จิ ตอลเข ามาช วย โดยไอซี แปลง
ส ัญญาณนี้ จะให ผลล ัพธ ออกมาเป นข อมู ลด ิจิ ตอลที ่มี ความละเอ ียดของข อมู ลต างกั นไป แล วแต ความ
สามารถของไอซี  โดยจะเริ่ มตั้ งแต  8, 10, 12, 16 บิ ตหรื อสู งกว า

ในป จจ ุบ ัน ไมโครคอนโทรลเลอร ได รวมเอาวงจรแปลงส ัญญาณอะนาลอกเป นด ิจ ิตอลเข ามา
ไว ภายในช ิป ทั ้งนี ้เพื ่อลดขนาดของระบบโดยรวมลง ท ําให การประมวลผลส ัญญาณท ําได เร ็วขึ ้น และ
ต นทุ นรวมของระบบลดลงตามไปด วย

ข อมู ลดิ จิ ตอลที่ ได มาจากวงจรแปลงสั ญญาณอะนาลอกเป นดิ จิ ตอล ไม ว าจะเป นแบบไอซี 
แปลงสั ญญาณภายนอก หร ือจากโมด ูลที ่อยู ภายในไมโครคอนโทรลเลอร จะถู กส งเข ามาในระบบบ ัส
ข อมู ลเพื่ อทํ าการประมวลผลและนํ าไปใช ในการตั ดสิ นใจเพื่ อควบคุ มการทํ างานของระบบต อไป

ส ําหร ับในช ุด IPST-MicroBOX (SE) ได เล ือกใช ไมโครคอนโทรลเลอร  ATmega644P อ ันเป น
ไมโครคอนโทรลเลอร ที ่ม ีวงจรแปลงส ัญญาณอะนาอลกเป นด ิจ ิตอล 8 ช องอยู ภายในช ิปแล ว จ ึงท ําให 
การนํ าแผงวงจรควบคุ มไปใช ในการเชื่ อมต อกั บตั วตรวจจั บแบบต างๆ เพื่ ออ านค ากระทํ าได ง ายและ
สะดวกขึ้ น
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10.2 การแปลงสั ญญาณอะนาลอกเป นดิ จิ ตอล (ADC)

การแปลงสั ญญาณอะนาลอกเป นดิ จิ ตอล สั ญญาณจะได รั บการแปลงเป นจํ านวนทางดิ จิ ตอล
โดยการสุ มหร ือแซมปลิ ้ง (sampling) ด ังในร ูปที ่ 10-3  ถ าหากวงจรแปลงส ัญญาณอะนาลอกเป นด ิจ ิตอล
มี ความละเอี ยด 8 บิ ต จะมี ความแตกต างทางผลลั พธ เลขฐานสองทั้ งหมด 28 หรื อ 256 ค า และถ าหาก
มี ความละเอี ยด 10 บิ ต ก็ จะให ผลลั พธ ของข อมู ลเลขฐานสองสู งถึ ง 210 หรื อ 1,024 ค า

ค าความละเอี ยดของตั วแปลงสั ญญาณอะนาลอกเป นดิ จิ ตอลถู กอธิ บายเป นระยะห างที่ น อย
ที่ สุ ดของค าแรงดั นทางอิ นพุ ตที่ เพิ่ มขึ้ น ซึ่ งถู กกํ าหนดโดยตั วแปลงสั ญญาณนั้ น ระยะห างยิ่ งน อย
เท าไหร  ค าความละเอี ยดยิ่ งสู งขึ้ น โดยค าความละเอี ยดแปรผั นตรงกั บจํ านวนของบิ ตเอาต พุ ต ยกตั ว
อย างเช น ถ าวงจรแปลงสั ญญาณมี ความละเอี ยด 10 บิ ต ทํ าให เกิ ดผลลั พธ ที่ แทนค าสั ญญาณมากถึ ง
1,024 ระดั บสั ญญาณอิ นพุ ตถู กแทนเป นรหั สเลขฐานสองจาก  0000000000 ถึ ง 1111111111 ถ าย าน
อิ นพุ ตเริ่ มต นจาก 0 ถึ ง +5 V  ดั งนั้ นความละเอี ยดเท ากั บ (ค าโดยประมาณ)

 V0050
1024

5
.

ถ าเอาต พ ุตรหั สเลขฐานสองเป น 0000000001 แทนแรงด ัน 0.005 V  ดั งนั้ นข อมู ลของแรงดั น
3V จะมี ค าเท ากั บ

  600
0050

3


. 10

ทํ าการแปลงเป นเลขฐานสองจะได ค าเท ากั บ 10010110002

รู ปที่  10-3 การสุ มสั ญญาณอะนาลอกเพื่ อกํ าหนดข อมู ลดิ จิ ตอล

0101101111

1101100111

ขอมลูดิจติอล

สัญญาณ
อะนาลอกอินพุต

ระยะหางของการสุม
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10.3 ฟ งก ชั ่นของโปรแกรมภาษา C/C++ ที ่ใช อ านค าส ัญญาณอะนาลอกของ
IPST-MicroBOX (SE)

เพื่ ออํ านวยความสะดวกในการเขี ยนโปรแกรมภาษา C/C++ เพื่ อควบคุ มกล องสมองกล IPST-
MicroBOX (SE) เพื่ อให อ านค าสั ญญาณอะนาลอกจากตั วตรวจจั บต างๆ ในไฟล ไลบรารี  ipst.h จึ งได 
บรรจุ ฟ งก ชั่ นสํ าหรั บอ านค าสั ญญาณอะนาลอกโดยเฉพาะ 2 ฟ งก ชั่ นคื อ  analog() และ knob();

การอ านค าผ านฟ งก ชั่ น analog() และ knob() จะได ผลลั พธ คื นค ากลั บมาในช วง 0 ถึ ง 1,023
ของเลขฐานสิ บ หรื อ 0x0000 ถึ ง 0x03FF ของเลขฐานสิ บหก เนื่ องจากความละเอี ยดในการแปลง
สั ญญาณอะนาลอกเป นดิ จิ ตอลเท ากั บ 10 บิ ต (เกิ ดค าได  1,024 ค า)

10.3.1 analog
เป นฟ งก ชั ่นอ านค าจากการแปลงส ัญญาณอะนาลอกของแผงวงจร IPST-SE ที ่จ ุดต อ A0 ถ ึง A6

รู ปแบบ

unsigned int analog(unsigned char channel)

พารามิ เตอร 

channel - กํ าหนดช องอิ นพุ ตที่ ต องการ มี ค า 0 ถึ ง 6 ซึ่ งตรงกั บขาพอร ต A0 ถึ ง A6

การค ืนค า

เป นข อม ูลที ่ได จากการแปลงส ัญญาณไฟฟ า 0 ถ ึง +5V จากช องอ ินพ ุตที ่ก ําหนด ม ีค า 0 ถ ึง 1,023

10.3.2 knob( )
เป นฟ งก ชั ่นอ านค าข อม ูลที ่ได จากการแปลงส ัญญาณไฟฟ าที ่ขาพอร ต A7 ซึ ่งต อก ับต ัวต านทาน

ปรั บค าได ที่ ตํ าแหน ง KNOB

รู ปแบบ
unsigned int knob()

การค ืนค า

เป นข อม ูลที ่ได จากการแปลงส ัญญาณไฟฟ าที ่มาจากการปร ับค าที ่ปุ ม KNOB บนแผงวงจร IPST-
SE มี ค า 95 ถึ ง 1,023
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
ในปฏิ บั ติ การนี้ เป นการแนะนํ าการเชื่ อมต อชุ ดกล องสมองกล IPST-MicroBOX (SE) กั บอุ ปกรณ ที่ ให ผล

การท ํางานเป นแรงด ันไฟตรง เพื ่อทดสอบการอ านค าส ัญญาณอะนาลอกหร ือส ัญญาณไฟตรงมาแสดงผลเป นต ัว
เลขที ่เข าใจได ง ายขึ ้น ซึ ่งการท ํางานของอ ุปกรณ แบบนี ้จะแตกต างก ันไปตามล ักษณะและจ ุดประสงค  เช น ต ัวตรวจ
จั บอุ ณหภู มิ ที่ ให ผลการเปลี่ ยนแปลงอุ ณหภู มิ สั มพั นธ กั บแรงดั นทางเอาต พุ ต, ตั วต านทานแปรค าตามแสงที่ 
สามารถให แรงดั นไฟตรงเอาต พุ ตเปลี่ ยนแปลงตามความเข มของแสงที่ มาตกกระทบตั วมั น เป นต น  ตั วแทนของ
อุ ปกรณ ในลั กษณะนี้ ในขั้ นพื้ นฐานที่ สุ ดคื อ ZX-POTV แผงวงจรตั วต านทานปรั บค าได  (Potentiometer) โดยใน
ปฏิ บั ติ การนี้ จะแสดงให เห็ นถึ งการอ านค าและนํ าผลลั พธ มาประยุ กต ใช งานร วมกั บแผงวงจรหลั ก IPST-SE

ปฏิ บั ติ การที่  6-1  อ านค าตั วตรวจจั บมาแสดงผล
ในปฏิ บ ัต ิการนี ้น ําเสนอการเข ียนโปรแกรมภาษา C/C++ เพื ่ออ านค าส ัญญาณไฟฟ าแบบอะนาลอกจาก

แผงวงจรต ัวต านทานปร ับค าได ที ่ต อก ับจ ุดต อพอร ต A1 มาแสดงผลที ่จอแสดงผลกราฟ ก LCD ส ีบนแผงวงจรหล ัก
IPST-SE

การเชื่ อมต อทางฮาร ดแวร 
 ต อเอาต พ ุต หร ือเอาต พ ุตปร ับแรงด ันเพิ ่มเมื ่อหม ุนตามตามเข ็มนาฬ ิกาของแผงวงจร ZX-POTV ก ับจ ุดต อ A1
ของแผงวงจรหลั ก IPST-SE

รู ปที่  L6-1 การต อวงจรเพื่ อทํ าการทดลองสํ าหรั บปฏิ บั ติ การที่  6

27A3 30A6

29A526A2

28A425A1

2
4

A
0

USB

D

9SDA 8SCL

1
2

1
3

1
4

1
5

S
V
0

S
V
1

S
V
2

S
V
3

12
6V
G

13
6V
G

14
6V
G

15
6V
G

21

D
C
 M

O
T
O

R

3 TxD1

LOW+5

2 RxD1

UART1

SERVO

00000000

000000000000000000000

000000000000000000000

000000000000000000000

000000000000000000000

000000000000000000000

000000000000000000000

000000000000000000000

000000000000000000000

000000000000000000000

000000000000000000000

000000000000000000000

000000000000000000000

000000000000000000000

000000000000000000000

000000000000000000000

RESET2019

18

17

16

KNOB

OK

SW1

ON

0 00

Analog

583

Z
X
-P
O
T
V

A

2.847

Volts



168   Arduino IDE

ขั้ นตอนการทดลอง
6.1.1 เป ดซอฟต แวร  Wiring 1.0 สร างไฟล ใหม  พิ มพ โปรแกรมที่  L6-1 บั นทึ กในชื่ อ microbox_AnalogTest.ino

6.1.2 คอมไพล และอ ัปโหลดโปรแกรมไปย ังแผงวงจร IPST-SE โดยคล ิกที ่ปุ ม 

#include <ipst.h> // ผนวกไฟล ไลบรารี หลั ก
int val = 0;
float volts = 0.0;
void setup()
{

glcdClear();
setTextSize(2); // เลื อกขนาดตั วอั กษรใหญ เป น 2 เท าจากขนาดปกติ 

}
void loop()
{

glcd(0,2,"Analog"); // แสดงข อความที่ จอแสดงผล
val  = analog(1); // อ านค าของสั ญญาณช อง A1 มาเก็ บไว ที่ ตั วแปร val
setTextSize(3); // เลื อกขนาดตั วอั กษรใหญ เป น 3 เท าจากขนาดปกติ 
glcd(1,2,"%d   ",val); // แสดงค าที่ อ านได จากจุ ดต อ A1 ที่ หน าจอแสดงผล
setTextSize(2); // เลื อกขนาดตั วอั กษรใหญ เป น 2 เท าจากขนาดปกติ 
glcd(5,3,"Volts"); // แสดงข อความ Volts
volts = (float(val)*5)/1024; // แปลงข อมู ลเป นหน วยแรงดั น
setTextSize(3); // เลื อกขนาดตั วอั กษรใหญ เป น 3 เท าจากขนาดปกติ 
glcd(4,1,"%f",volts); // แสดงค าแรงดั นความละเอี ยดทศนิ ยม 3 ตํ าแหน ง
setTextSize(2); // เลื อกขนาดตั วอั กษรใหญ เป น 2 เท าจากขนาดปกติ 

}

คํ าอธิ บายโปรแกรม

ค าของแรงดั นไฟตรงที่ ได จากตั วตรวจจั บหรื อตั วต านทานปรั บค าได ที่ จุ ดต อ A1 ของแผงวงจร IPST-SE
จะถ ูกแปลงเป นข อม ูลด ิจ ิตอลและจ ัดร ูปแบบเป นเลขฐานส ิบได ค าในช วง 0 ถ ึง 1023 จากการท ํางานของฟ งก ชั ่น
analog() จากนั ้นข อม ูลนั ้นได ร ับการส งต อไปแสดงที ่จอแสดงผลกราฟ ก LCD ส ีด วยฟ งก ชั ่น glcd อย างต อเนื ่อง

นอกจากนั ้นในโปรแกรมย ังน ําข อม ูลที ่ได จากการแปลงส ัญญาณมาค ํานวณกล ับ เพื ่อให ได เป นค าแรงด ัน
ไฟตรง โดยใช สมการ volts = (val x 5) / 1024 แล วใช ต ัวแปร volts ที่ เป นตั วแปรแบบทศนิ ยมมารั บค าที่ ได จาก
ค ํานวณเพื ่อน ําไปแสดงผลที ่จอกราฟ ก LCD ส ี โดยแสดงเป นค าแรงด ันในหน วยโวลต  ด วยความละเอ ียดทศน ิยม
3 ตํ าแหน ง

ในโปรแกรมม ีการก ําหนดขนาดของต ัวอ ักษรที ่ใช แสดงผลต างก ัน เนื ่องจากต องการแยกข อความและข อม ูล
ออกจากก ันให ช ัดเจน

โปรแกรมที ่ L6-1 : ไฟล  microbox_AnalogTest.ino โปรแกรมภาษา C/C++ ส ําหร ับอ านค าส ัญญาณอะนาลอกของ
แผงวงจร IPST-SE
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6.1.3 รั นโปรแกรม ทดลองหม ุนแกนของต ัวต านทานบนแผงวงจรต ัวต านทานปร ับค าได  ZX-POTV ส ังเกตผลการ
ทํ างานผ านทางจอแสดงผลของแผงวงจร IPST-SE

ที่ จอแสดงผลกราฟ ก LCD ช วงบนแสดงค าข อมู ลที่ ได จากการแปลงสั ญญาณที่ จุ ดต อ A1 ซึ่ งต อกั บแผง
วงจรตั วต านทานปรั บค าได  ZX-POTV โดยมี ค าระหว าง 0 ถึ ง 1023 (เที ยบกั บแรงดั น 0 ถึ ง +5V)

ที ่ช วงล างของจอแสดงผลกราฟ ก LCD ส ีแสดงค าแรงด ันไฟตรงในหน วย โวลต  (Volts) ที ่ได จากการปร ับ
ค าของตั วต านทานบนแผงวงจรตั วต านทานปรั บค าได  ZX-POTV โดยมี ค าระหว าง 0.000 ถึ ง 4.995 (เที ยบกั บ
ข อมู ล 0 ถึ ง 1023)
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ปฏิ บั ติ การที่  6.2  ควบคุ มการเป ด/ป ด LED ด วยแผงวงจรตั วต านทานปรั บค าได 
ในปฏิ บั ติ การนี้ เป นการนํ าข อมู ลที่ ได จากการแปลงสั ญญาณไฟฟ าซึ่ งมาจากการปรั บค าของ ZX-POTV

แผงวงจรตั วต านทานปร ับค าได มากํ าหนดเงื ่อนไขในการเป ด/ป ด LED เพื่ อให เห็ นแนวทางในการประยุ กต ใช งาน
เบื ้องต น

การเชื่ อมต อทางฮาร ดแวร 
 เชื ่อมต อแผงวงจร ZX-LED เข าก ับจ ุดต อพอร ต 17 ของแผงวงจรหล ัก IPST-SE

 ต อเอาต พุ ต หรื อเอาต พุ ตปรั บแรงดั นเพิ่ มเมื่ อหมุ นตามตามเข็ มนาฬิ กาของแผงวงจร ZX-POTV กั บจุ ดต อ
พอร ต A1 ของแผงวงจรหลั ก IPST-SE

ขั้ นตอนการทดลอง
6.2.1 เป ดซอฟต แวร  Wiring 1.0 สร างไฟล ใหม  พ ิมพ โปรแกรมที ่ L6-1 บ ันท ึกในชื ่อ microbox_AnalogSwitch.ino

6.2.2 คอมไพล และอ ัปโหลดโปรแกรมไปย ังแผงวงจร IPST-SE โดยคล ิกที ่ปุ ม 

รู ปที่  L6-2 การต อวงจรเพื่ อทํ าการทดลองสํ าหรั บปฏิ บั ติ การที่  6-2
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#include <ipst.h> // ผนวกไฟล ไลบรารี หลั ก
int val=0; // กํ าหนดตั วแปรเก็ บค าที่ ได จากการแปลงสั ญญาณแล ว
void setup()
{

glcdClear();
setTextSize(2); // เลื อกขนาดตั วอั กษรใหญ เป น 2 เท าจากขนาดปกติ 
glcd(1,2,"Analog"); // แสดงข อความที่ จอแสดงผล
glcd(2,2,"control");
glcd(3,2,"Switch");

}
void loop()
{

val  = analog(1); // อ านค าของสั ญญาณช อง A1 มาเก็ บไว ที่ ตั วแปร val
if(val>512) // ตรวจสอบว าค าที่ อ านได มากกว า 512 หรื อไม 
{

setTextSize(4); // เลื อกขนาดตั วอั กษรใหญ เป น 4 เท าจากขนาดปกติ 
setTextColor(GLCD_RED); // เปลี ยนเป นสี แดง
glcd(3,1,"%d   ",val); // แสดงค าที่ อ านได จากจุ ดต อ A1 ที่ หน าจอแสดงผล
out(17,1); // ถ าค า val มากกว า 512 ทํ าการขั บ LED ที่ พอร ต 17

}
else
{

setTextSize(4); // เลื อกขนาดตั วอั กษรใหญ เป น 4 เท าจากขนาดปกติ 
setTextColor(GLCD_WHITE); // แสดงตั วอั กษรสี ขาว
glcd(3,1,"%d   ",val); // แสดงค าที่ อ านได จากจุ ดต อ A2 ที่ หน าจอแสดงผล
out(17,0); // ถ าค า val น อยกว า 512 ทํ าการป ด LED ที่ พอร ต 17

}
setTextSize(2); // เลื อกขนาดตั วอั กษรใหญ เป น 2 เท าจากขนาดปกติ 

}

คํ าอธิ บายโปรแกรม

สั ญญาณไฟฟ าจากแผงวงจรตั วต านทานปรั บค าได จะถู กอ านด วยคํ าสั่ ง analog() เก็ บไว ที่ ตั วแปร val
เพื่ อนํ าไปตรวจสอบและส งไปแสดงผลยั งจอแสดงผลกราฟ ก LCD สี  หากค าที่ ได  น อยกว า 512 ตั วเลขที่ แสดง
ผลยั งเป นสี ขาว และส งข อมู ล “0” ไปยั งพอร ต 17 ทํ าให  LED ที่ ต ออยู ไม ทํ างาน

เมื่ อค าของ val มากกว า 512 ตั วเลขแสดงผลจะเปลี่ ยนเป นสี แดง และมี การส งข อมู ล “1” ไปยั งพอร ต
17 ทํ าให  LED ที่ ต ออยู ติ ดสว าง

โปรแกรมที ่ L6-2 : ไฟล  microbox_AnalogSwitch.ino โปรแกรมภาษา C/C++ ส ําหร ับอ านค าส ัญญาณไฟฟ า
เพื ่อน ํามาควบค ุมอ ุปกรณ เอาต พ ุต
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6.2.3  ร ันโปรแกรม ทดลองปร ับค าที ่แกนหม ุนของต ัวต านทานปร ับค าได บนแผงวงจร ZX-POTV ส ังเกตการท ํางาน
ของจอแสดงผลบนแผงวงจร IPST-SE และ LED บนแผงวงจร ZX-LED

เมื ่อปร ับค าที ่แกนของต ัวต านทาน ส ังเกตผลล ัพธ ที ่จอแสดงผล มั นจะแสดงค า 0 ถ ึง 1023 เมื ่อปร ับค าที่ 
แผงวงจร ZX-POTV ถ าม ีค าน อยกว า 512 ตั วเลขจะเป นสี ขาว และ LED ด ับ เมื่ อใดปรั บค าจนได มากกว า 512
ค าตั วเลขที่ จอแสดงผลจะเปลี่ ยนเป นสี แดง และ LED ที ่ต อก ับพอร ต 17 ติ ดสว าง
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ปฏิ บ ัติ การที่  6.3  ควบคุ มการเป ด/ป ด LED ด วยแผงวงจรตรวจจั บแสง
ในปฏิ บ ัต ิการนี ้เป นการต อยอดจากปฏิ บ ัต ิการที ่ 6.2 โดยเปลี ่ยนจากการปร ับค าของ ZX-POTV แผงวงจรต ัว

ต านทานปรั บค าได เป นการตรวจจั บแสงโดยใช แผงวงจรตั วต านทานแปรค าตามแสดงหรื อ ZX-LDR โดยยั งคงใช 
เงื ่อนไขในการเป ด/ป ด LED ในแบบเด ียวก ัน

การเชื่ อมต อทางฮาร ดแวร 
 เชื ่อมต อแผงวงจร ZX-LED เข าก ับจ ุดต อพอร ต 17 ของแผงวงจรหล ัก IPST-SE

 ต อเอาต พุ ต +  หรื อเอาต พุ ตแรงดั นแปรค าตามแสงของแผงวงจร ZX-LDR กั บจุ ดต อพอร ต A1 ของแผง
วงจรหลั ก IPST-SE

ขั้ นตอนการทดลอง
6.3.1 เขี ยนโปรแกรมที ่ L6-3 บั นทึ กในชื่ อ microbox_NightSwitch.ino

6.3.2 คอมไพล และอ ัปโหลดโปรแกรมไปย ังแผงวงจร IPST-SE โดยคล ิกที ่ปุ ม 
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ร ูปที ่ L6-3 การต อวงจรเพื ่อทดสอบการท ํางานของแผงวงจรตรวจจ ับแสงเพื ่อใช ก ําหนดเงื ่อนไขในการ
เป ด-ป ดอุ ปกรณ เอาต พุ ต
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โปรแกรมที ่ L6-3 : ไฟล  microbox_NightSwitch.ino โปรแกรมภาษา C/C++ ส ําหร ับควบค ุมการเป ดป ดอ ุปกรณ 
เอาต พ ุตด วยแสง

#include <ipst.h> // ผนวกไฟล ไลบรารี หลั ก
int val=0; // กํ าหนดตั วแปรสํ าหรั บเก็ บค าที่ ได จากการแปลงสั ญญาณ
void setup()
{

glcdClear();
setTextSize(2); // เลื อกขนาดตั วอั กษรใหญ เป น 2 เท าจากขนาดปกติ 
setTextColor(GLCD_YELLOW);
glcd(1,2,"Night"); // แสดงข อความที่ จอแสดงผล
glcd(2,2,"Switch");

}
void loop()
{

val  = analog(1); // อ านค าของสั ญญาณช อง A1 มาเก็ บไว ที่ ตั วแปร val
if(val<100) // ตรวจสอบว าค าที่ อ านได มากกว า 512 หรื อไม 
{

setTextSize(4); // เลื อกขนาดตั วอั กษรใหญ เป น 4 เท าจากขนาดปกติ 
setTextColor(GLCD_WHITE); // เปลี ยนเป นสี ขาว
glcd(3,1,"%d   ",val); // แสดงค าที่ อ านได จากจุ ดต อ A1 ที่ หน าจอแสดงผล
out(17,1); // ถ าค า val น อยกว า 100 ทํ าการขั บ LED ที่ พอร ต 17

}
else
{

setTextSize(4); // เลื อกขนาดตั วอั กษรใหญ เป น 4 เท าจากขนาดปกติ 
setTextColor(GLCD_BLUE); // แสดงตั วอั กษรสี นํ้ าเงิ น
glcd(3,1,"%d   ",val); // แสดงค าที่ อ านได จากจุ ดต อ A1 ที่ หน าจอแสดงผล
out(17,0); // ถ าค า val มากกว า 100 ทํ าการป ด LED ที่ พอร ต 17

}
setTextSize(2); // เลื อกขนาดตั วอั กษรใหญ เป น 2 เท าจากขนาดปกติ 

}

คํ าอธิ บายโปรแกรม

ในโปรแกรมนี ้จะตรวจสอบค าจากแผงวงจรตรวจจ ับแสงที ่อ านด วยค ําสั ่ง analog(1); เก ็บไว ที ่ต ัวแปร val
หากค าที่ ได มากกว า 100 ตั วเลขที่ แสดงผลเป นสี นํ้ าเงิ น และส งข อมู ล “0” ไปยั งพอร ต 17 ทํ าให  LED ที่ ต ออยู 
ไม ทํ างาน

เมื่ อค าของ val น อยกว า 100 ตั วเลขแสดงผลจะเปลี่ ยนเป นสี ขาว และมี การส งข อมู ล “1” ไปยั งพอร ต
17 ทํ าให  LED ที่ ต ออยู ติ ดสว าง
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6.3.3  ร ันโปรแกรม ทดลองใช ม ือหร ือแป นกระดาษโปร งแสงบ ังแสงที ่ส องมาย ังต ัวต านทานแปรค าตามแสงหร ือ LDR
บนแผงวงจร ZX-LDR  สั งเกตการทํ างานของจอแสดงผลบนแผงวงจร IPST-SE และ LED บนแผงวงจร ZX-LED

หาก ZX-LDR ได รั บแสงมาก สั งเกตได จากค าที่ แสดงบนจอแสดงผล นั่ นคื อ มี ค ามากกว า 100 (ตั วเลข
เป นสี นํ้ าเงิ น) จะสมมติ สถานการณ ว า เป นตอนกลางวั น จึ งไม มี เป ดไฟส องสว าง ซึ่ งในที่ นี้ ใช  LED บนแผงวงจร
ZX-LED ทํ าหน าที่ แทน

แต ถั าหาก ZX-LDR ได รั บแสงลดลงจนตํ่ ากว า 100 จะถื อว า เป นตอนกลางคื น ระบบจะทํ างานสั่ งให 
LED ที่ พอร ต 17 ติ ดสว าง จนกว า ZX-LDR จะได รั บแสงมากเพี ยงพอ ซึ่ งอาจตี ความว า เป นตอนเช าแล ว วงจร
ขั บ LED หยุ ดทํ างาน ทํ าให  LED ที่ พอร ต 17 ดั บ

ดั งนั้ น จึ งอาจเรี ยกการทํ างานของปฏิ บั ติ การนี้ ว า สวิ ตช สนธยา (Twilight Switch) หรื อสวิ ตช กลางคื น
(Night Switch) ก็ ได 
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
ในปฏิ บั ติ การนี้ เป นการนํ าไอซี วั ดอุ ณหภู มิ ที่ ให ผลการทํ างานเป นแรงดั นไฟฟ ามาเชื่ อมต อกั บชุ ดกล อง

สมองกล IPST-MicroBOX (SE) เพื่ อสร างเป นเครื่ องวั ดอุ ณหภู มิ ระบบตั วเลขอย างง าย

รู จั กกั บ MCP9701 ไอซี วั ดอุ ณหภู มิ 
เป นอ ุปกรณ ตรวจจ ับและว ัดอ ุณหภู ม ิที ่ให ผลการท ํางานเป นแรงด ันไฟฟ าแบบเช ิงเส น ร ับรู การเปลี ่ยนแปลง

ของอุ ณหภู มิ ภายในเวลาไม ถึ ง 2 วิ นาที  เชื่ อมต อกั บอิ นพุ ตอะนาลอก A0 ถึ ง A6 ของแผงวงจรหลั ก IPST-SE ได 

คุ ณสมบั ติ ทางเทคนิ คของ MCP9701 ที่ ควรทราบ

  เป นไอซี วั ดอุ ณหภู มิ ในกลุ มเทอร มิ สเตอร แบบแอกตี ฟที่ ให ผลการทํ างานแบบเชิ งเส น

  ย านวั ด -40 ถึ ง +125 องศาเซลเซี ยส

  ผลการวั ดอ างอิ งกั บหน วยขององศาเซลเซี ยสโดยตรง

  ความผิ ดพลาดเฉลี่ ย 2 องศาเซลเซี ยส

  ย านไฟเลี้ ยง +3.1 ถึ ง +5.5V กิ นกระแสไฟฟ าเพี ยง 6uA ใช แบตเตอร่ี เป นแหล งจ ายไฟได 

  ค าแรงดั นเอาต พุ ต  500mV (ที่  0๐C) ถึ ง 2.9375V (ที่  125๐)

  ค าแรงด ันเอาต พ ุตต อการเปลี ่ยนแปลงอ ุณหภู ม ิ 19.5mV/๐C ใช งานก ับวงจรแปลงส ัญญาณอะนาลอก
เป นดิ จิ ตอลความละเอี ยดต้ั งแต  8 บิ ตได  โดยมี ความคลาดเคลื่ อนตํ่ า

รู ปที่  L7-1 การจั ดขาของ MCP9701, หน าตาเมื่ อต อสายสั ญญาณพร อมใช งานและกราฟคุ ณสมบั ติ 
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การเชื่ อมต อทางฮาร ดแวร 
 ต อสายวั ดอุ ณหภู มิ ที่ เชื่ อมต อกั บไอซี  MCP9701 เข ากั บจุ ดต อ A3 ของแผงวงจรหลั ก IPST-SE

ขั้ นตอนการทดลอง
7.1  เขี ยนโปรแกรมที่  L7-1 บั นทึ กในชื่ อ microbox_Thermometer.ino

7..2 คอมไพล และอ ัปโหลดโปรแกรมไปย ังแผงวงจร IPST-SE โดยคล ิกที ่ปุ ม 

7.3  รั นโปรแกรม ทดลองใช มื อจั บที่ ตั วไอซี วั ดอุ ณหภู มิ  หรื อนํ าหั ววั ดอุ ณหภู มิ ไปแช ในนํ้ าแข็ ง สั งเกตการทํ างานที่ 
จอแสดงผลบนแผงวงจร IPST-SE

แผงวงจร IPST-SE แสดงข อความแจ งหน าที่ การทํ างาน และแสดงค าอุ ณหภู มิ ในหน วยองศาเซลเซี ยส
(Celsius) ด วยความละเอี ยดทศนิ ยม 3 ตํ าแหน ง โดยที่ ค าของอุ ณหภู มิ จะแสดงด วยตั วเลขสี เหลื องขนาดใหญ 
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ร ูปที ่ L7-2 การต อวงจรเพื ่อใช งานช ุดกล องสมองกล IPST-MicroBOX (SE) ก ับไอซ ีว ัดอ ุณหภ ูม ิ MCP9701
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โปรแกรมที ่ L7-1 : ไฟล  microbox_Thermometer.ino โปรแกรมภาษา C/C++ ส ําหร ับพ ัฒนากล องสมองกล
IPST-MicroBOX (SE) เป นเครื ่องว ัดอ ุณหภ ูม ิระบบต ัวเลขอย างง าย

#include <ipst.h> // ผนวกไฟล ไลบรารี หลั ก
int val,i; // กํ าหนดตั วแปรเก็ บค าที่ อ านได จาก MCP9701
float Temp; // ประกาศตั วแปรค าอ ุณหภู ม ืในแบบทศน ิยม
void setup()
{

glcdClear(); // เคลี ยร จอแสดงผล
setTextSize(2); // เลื อกขนาดตั วอั กษร 2 เท า

}

void loop()
{

glcd(1,2,"Digital"); // แสดงข อความเริ่ มต น
glcd(2,2,"THERMO");
glcd(3,3,"METER");
val=0;
for (i=0;i<20;i++) // กํ าหนดรอบการอ านค าจาก MCP9701 รวม 20 ครั้ ง
{

val = val+analog(3); // อ านค าจากอิ นพุ ต A3
}
val = val/20; // หาค าเฉลี่ ยจากการอ านค า 20 ครั้ ง

Temp = (float(val)*0.25) - 20.51 ; // แปลงค าเป นอุ ณหภู มิ ในหน วยองศาเซลเซี ยส
setTextSize(3); // เปล่ี ยนขนาดตั วอั กษรเป น 3 เท า
setTextColor(GLCD_YELLOW); // เปลี ยนสี ตั วอั กษรเป นสี เหลื อง
glcd(3,1,"%f",Temp); // แสดงค าอุ ณหภู มิ ด วยความละเอี ยดทศนิ ยม 3 ตํ าแหน ง
setTextColor(GLCD_WHITE); // เปลี ยนสี ตั วอั กษรเป นสี ขาว
setTextSize(2); // เปล่ี ยนขนาดตั วอั กษรเป น 2 เท า
glcd(6,2,"Celsius"); // แสดงหน วยองศาเซลเซี ยส
delay(500); // หน วงเวลาก อนเริ่ มต นการอ านค าในรอบใหม 

}

ค ําอธ ิบายโปรแกรม

ในโปรแกรมนี้ หั วใจสํ าคั ญคื อ การคํ านวณเพื่ อเปลี่ ยนข อมู ลดิ จิ ตอลที่ ได จากการแปลงแรงดั นเอาต พุ ต
ของไอซ ี MCP9701 เป นค าอ ุณหภู ม ิในหน วยองศาเซลเซี ยส กระบวนการจะเริ่ มจากการอ านและแปลงค าของ
แรงด ันไฟตรงที ่จ ุดต อ A3 ซึ ่งได มาจากการท ํางานของไอซ ี MCP9701 มาเก ็บไว ในต ัวแปร val จากนั ้นน ําข อม ูล
ที่ ได มาคํ านวณด วยสู ตร Temp = (val x 0.25) - 20.51 จากนั้ นนํ าค าอุ ณหภู มิ ได มาแสดงผลด วยความละเอี ยด
ทศนิ ยม 3 ตํ าแหน ง


